
RFDS Setup and Calibration

Apr 2001 3-71SC�4812ET BTS Optimization/ATP — CDMA LMF
DRAFT

RFDS Description

The optional RFDS is a Field Replaceable Unit (FRU) used to perform
RF tests of the site from the CBSC or from the LMF. The RFDS
contains the following elements:

� Antenna Select Unit (ASU)

� FWT Interface Card (FWTIC)

� Subscriber Unit Assembly (SUA)

For complete information regarding the RFDS, refer to the CDMA
RFDS Hardware Installation manual (Motorola part no. 6864113A93)
CDMA RFDS User’s Guide (Motorola part no. 6864113A37), and the
CDMA LMF Operator’s Guide (Motorola part no. 6864113A21).

RFDS Parameter Settings

The bts-#.cdf  file includes RFDS parameter settings that must
match the installed RFDS equipment. The paragraphs below describe the
editable parameters and their defaults. Table 3-38 explains how to edit
the parameter settings.

� RfdsEquip – valid inputs are 0 through 2.
0 = (default) RFDS is not equipped
1 = Non-Cobra/Patzer box RFDS
2 = Cobra RFDS

� TsuEquip – valid inputs are 0 or 1
0 = (default) TSU not equipped
1 = TSU is equipped in the system

� MC1....4 – valid inputs are 0 or 1
0 = (default) Not equipped
1 = Multicouplers equipped in RFDS system 

(9600 system RFDS only)

� Asu1/2Equip – valid inputs are 0 or 1
0 = (default) Not equipped
1 = Equipped

� TestOrigDN – valid inputs are ’’’ (default) or a numerical string up to
15 characters. (This is the phone number the RFDS dials when
originating a call. A dummy number needs to be set up by the switch,
and is to be used in this field.)

Any text editor may be used to open the bts–#.cdf  file
to verify, view, or modify data.

NOTE
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Table 3-38: RFDS Parameter Settings

Step Action

* IMPORTANT
Log out of the BTS prior to performing this procedure.

1 Using a text editor, verify the following fields are set correctly in the bts–#.cdf  file (1 = GLI based
RFDS; 2 = Cobra RFDS).

EXAMPLE:
RfdsEquip = 2
TsuEquip = 1
MC1Equip = 0
MC2Equip = 0
MC3Equip = 0
MC4Equip = 0
Asu1Equip = 1
Asu2Equip = 0 (1 if system is non-duplexed)
TestOrigDN = ’123456789’’

NOTE
The above is an example of the bts-#.cdf  file that should have been generated by the OMC and
copied to the LMF. These fields will have been set by the OMC if the RFDSPARM database is
modified for the RFDS.

2 Save and/or quit the editor. If any changes were made to these fields data will need to be downloaded
to the GLI2 (see Step 3, otherwise proceed to Step 4).

3 To download to the GLI2, click on the Device menu and select the Download Data menu item
(selected devices do not change color when data is downloaded). A status report window is displayed
showing status of the download. Click OK to close the status report window.

! CAUTION
After downloading data to the GLI2 the RFDS LED will slowly begin flashing red and green for
approximately 2–3 minutes. DO NOT attempt to perform any functions with the RFDS until the LED
remains green.

4 Status the RFDS TSU. A status report is displayed showing the software version number for the TSIC
and SUA.

* IMPORTANT
If the LMF yields an error message, check the following:

� Ensure AMR cable is correctly connected from the BTS to the RFDS.

� Verify RFDS has power.

� Verify RFDS status LED is green.

� Verify fields in the bts-#.cdf  file are correct (see Step 1).

� Status the GLI2 and ensure the device is communicating (via Ethernet) with the LMF, and the
device is in the proper state (INS).
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RFDS TSU NAM Programming

The NAM (number assignment module) information needs to be
programmed into the TSU before it can receive and process test calls, or
be used for any type of RFDS test. The RFDS TSU NAM must be
programmed with the appropriate system parameters and phone number
during hardware installation. The TSU phone and TSU MSI must be
recorded for each BTS used for OMC–R RFDS software configuration.

The user will only need to program the NAM for the initial
install of the RFDS.

NOTE

Explanation of Parameters
used when Programming the
TSU NAM

Table 3-39 defines the parameters used when editing the tsu.nam file.

Table 3-39: Definition of Parameters

Access Overload Code
Slot Index
System ID
Network ID

These parameters are obtained from the switch.

Primary Channel A
Primary Channel B
Secondary Channel A
Secondary Channel B

These parameters are the channels which are to be used in operation
of the system.

Lock Code
Security Code
Service Level
Station Class Mark

Do NOT change.

IMSI MCC
IMSI 11 12

These fields are obtained at the OMC using the following command:
OMC000>disp bts–# imsi
If the fields are blank, replace the IMSI fields in the NAM file to 0,
otherwise use the values displayed by the OMC.

MIN Phone Number These fields are the phone number assigned to the mobile. The ESN
and MIN must be entered into the switch as well.

NOTE:
This field is different from the TODN field in the bts-#.cdf file.
The MIN is the phone number of the RFDS subscriber, and the
TODN is the number the subscriber calls.
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Valid NAM Ranges
Table 3-40 provides the valid NAM field ranges. If any of the fields are
missing or out-of–range, the RFDS will error out.

Table 3-40: Valid NAM Field Ranges

Valid Range

NAM Field Name Minimum Maximum

Access Overload Code 0 15

Slot Index 0 7

System ID 0 32767

Network ID 0 32767

Primary Channel A 25 1175

Primary Channel B 25 1175

Secondary Channel A 25 1175

Secondary Channel B 25 1175

Lock Code 0 999

Security Code 0 999999

Service Level 0 7

Station Class Mark 0 255

IMSI 11 12 0 99

IMSI MCC 0 999

MIN Phone Number N/A N/A
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Measuring Directional Coupler
Loss

Uas the following procedure to calibrate directional couplers associated
with RFDS installation. The procedure involves measuring the forward
port loss and the antenna port loss to find the directional coupler loss.

Prerequisites

� RFDS installed

Table 3-41: Measuring Directional Coupler Loss

Step Action

1 Connect the test set or power meter to the BTS Coupled (forward) port of the directional coupler.

2 Login to the BTS.

3 Select the BBX.

4 Select Device>Key XCVR.

The BBX window appears.

5 In the XCVR Gain field, enter the following value: 20

Verify that the XCVR Carrier and Channel fields are correct and that the Use BLO box is checked.

Click OK.

6  The status report window appears. Click OK.

7 Observe the power reading and record the value measured at the BTS Coupled (forward) port.  The
value should be between –34 and –27 dBm.

If the reading is not within these values, adjust the value in the XCVR Gain field until the value is
approximately 30 dBm.

8 Select the BBX.

9 Select Device>Dekey XCVR. The status report window appears verifying the action has passed (the
XCVR is no longer keyed up). Click OK

10 Disconnect the antenna cable from the ANT  port.

11 Disconnect the test set cable from the BTS Coupled (forward) port and connect it to the ANT
(antenna)  port.

12 Select the BBX.

13 Select Device>Key XCVR.

The BBX window appears.

14 In the XCVR Gain field, ensure the value entered is the same as used for the recorded value in the
forward port portion of the procedure.  (Note that a value of 20 was used is step 5.)

Verify that the XCVR Carrier and Channel fields are correct and that the Use BLO box is checked.

Click OK.

15 The status report window appears. Click OK.

. . . continued on next page

3



RFDS Setup and Calibration – continued

DRAFT
SC�4812ET BTS Optimization/ATP — CDMA LMF Apr 20013-76

Table 3-41: Measuring Directional Coupler Loss

Step Action

16 Observe the power reading and record the value measured at the ANT (antenna) port.

17 Select the BBX.

18 Select Device>Dekey XCVR.  The status report window appears verifying the action has passed (the
XCVR is no longer keyed up). Click OK.

19 Take the value of the Forward test  and subtract the Antenna  port value
from it to get the directional coupler loss. For example:

     –28.7                            –31.6            
   –   1.9                         –  – 1.2

   –––––––––                      –––––––––––
     –30.6dBm                          –30.4dBm

20 Label the directional coupler results for in–service calibration reference.
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Set Antenna Map Data

The antenna map data must be entered manually if an RFDS is installed.
Antenna map data does not have to be entered if an RFDS is not
installed. The antenna map data is only used for RFDS tests and is
required if a RFDS is installed.

Prerequisite

� Logged into the BTS

Table 3-42: Set Antenna Map Data

Step Action

1 Click on the Util menu.

2 Select Edit >Antenna Map >TX or RX. A data entry pop–up window will appear.

3 Enter/edit values as required for each carrier.

NOTE
Refer to the Util >Edit–antenna map LMF help screen for antenna map examples.

4 Click on the Save button to save displayed values.

5 Click on the Dismiss button to exit the window. Values that were entered/changed after the Save
button was used will not be saved.

NOTE
Entered values will be used by the LMF as soon as they are saved. You do not have to logout and
login.
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Set RFDS Configuration Data

If an RFDS is installed the RFDS configuration data must be manually
entered.

Prerequisite

� Logged into the BTS

The entered antenna# index numbers must correspond to
the antenna# index numbers used in the antenna maps.

IMPORTANT

*

Table 3-43: Set RFDS Configuration Data

Step Action

1 Click on the Util menu.

2 Select Edit >RFDS Configuration >TX or RX. A data entry pop–up window will appear.

3 Click on the Add Row button to add a new antenna number. Then click in the other columns and enter
the desired data.

4 To edit existing values click in the data box to be changed and change the value.

NOTE
Refer to the Util >Edit–RFDS Configuration LMF help screen for RFDS configuration data
examples.

5 To delete a row, click on the row and then click on the Delete Row  button.

6 Click on the Save button to save displayed values.

7 Click on the Dismiss button to exit the window. Values that were entered/changed after the Save
button was used will not be saved.

NOTE
Entered values will be used by the LMF as soon as they are saved. You do not have to logout and
login.
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RFDS Calibration

The RFDS Calibration option is used to calibrate the RFDS TX and RX
paths. For a TX antenna path calibration the BTS XCVR is keyed at a
pre–determined power level and the BTS power output level is measured
by the RFDS. The power level is then measured at the TX antenna
directional coupler by the power measuring test equipment item being
used (power meter or analyzer). The difference (offset) between the
power level at the RFDS and the power level at the TX antenna
directional coupler is used as the TX RFDS calibration offset value.

For an RX antenna path calibration the RFDS is keyed at a
pre–determined power level and the power input level is measured by the
BTS XCVR. A CDMA signal at the same power level measured by the
BTS XCVR is then injected at the RX antenna directional coupler by the
CDMA communications analyzer. The difference (offset) between the
RFDS keyed power level and power level measured at the BTS XCVR is
the RFDS RX calibration offset value.

The TX and RX RFDS calibration offset values are written to the CAL
file.

Prerequisites

� BBX2s are is INS_TEST

� Cable calibration has been performed

� TX calibration has been performed and BLO has bee downloaded for
the BTS

� Test equipment has been connected correctly for a TX calibration

� Test equipment has been selected and calibrated
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Table 3-44: RFDS Calibration

Step Action

1 Select the RFDS tab.

2 Click on the RFDS menu.

3 Click on the RFDS Calibration menu item

4 Select the appropriate direction (TX/RX) in the Direction pick list

5 Enter the appropriate channel number(s) in the Channels box. Separate the channel numbers with a
comma or a dash if more than one channel number is entered (e.g., 247,585,742 or 385–395 for
through).

6  Select the appropriate carrier(s) in the Carriers pick list (use the Shift or Ctrl key to select multiple
carriers).

7 Select the appropriate RX branch (Both, Main, or Diversity) in the RX Branch pick list.

8 Select the appropriate baud rate (1=9600, 2=14400) in the Rate Set pick list.

9 Click on the OK button. A status report window is displayed, followed by a Directions pop–up
window.

10 Follow the cable connection directions as they are displayed. Test results are displayed in the status
report window.

11 Click on the OK button to close the status report window.

12 Click on the BTS tab.

13 Click on the MGLI.

14 Download the CAL file which has been updated with the RFDS offset data to the selected GLI device
by clicking on Device>Download Data from the tab menu bar and pulldown.

NOTE
The MGLI automatically transfers the RFDS offset data from the CAL file to the RFDS.
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Program TSU NAM

Follow the procedure in Table 3-45 to program the TSU NAM. The
NAM must be programmed before it can receive and process test calls,
or be used for any type of RFDS test.

Prerequisites

� MGLI is INS.

� TSU is powered up and has a code load.

Table 3-45: Program NAM Procedure

Step Action

1 Select the RFDS tab.

2 Select the TSU tab.

3 Click on the TSU menu.

4 Click on the Program TSU NAM menu item.

5 Enter the appropriate information in the boxes  (see Table 3-39 and Table 3-40) .

6 Click on the OK button to display the status report.

7 Click on the OK button to close the status report window.

3



Alarms Testing

DRAFT
SC�4812ET BTS Optimization/ATP — CDMA LMF Apr 20013-82

Alarm Verification

The alarms testing should be performed at a convenient point in the
optimization/ATP process, since the LMF is necessary to ensure that the
RF cabinet is receiving the appropriate alarms from the power cabinet.

The SC 4812ET is capable of concurrently monitoring 10 customer
defined input signals and four customer defined outputs, which interface
to the 50–pin punchblock. All alarms are defaulted to “Not Equipped”
during ATP testing. Testing of these inputs is achieved by triggering the
alarms and monitoring the LMF for state–transition messages from the
active MGLI2.

All customer alarms are routed through the 50 pair punchblock located
in the I/O compartment at the back of the frame. Testing is best
accomplished by using a specialized connector that interfaces to the
50–pair punchblock. This connector is wired so that customer return 1 (2
for the B side) is connected to every input, CDI 0 through CDI 17.

Alarm Reporting Display

The Alarm Monitor window can be displayed to list alarms that occur
after the window is displayed. To access the Alarm Monitor window,
select Util>Alarm Monitor.

The following buttons are included.

� The Options button allows for a severity level (Warning, Minor, and
Major) selection. The default is all levels. To change the level of
alarms reported click on the Options button and highlight the desired
alarm level(s). To select multiple levels press the Ctrl key (for
individual selections) or Shift key (for a range of selections) while
clicking on the desired levels.

� The Pause button can be used to pause/stop the display of alarms.
When the Pause button is clicked the name of the button changes to
Continue. When the Continue button is click the display of alarms
will continue. Alarms that occur between the time the Pause button is
clicked and the Continue button is clicked will not be displayed.

� The Clear button can be used to clear the Alarm Monitor display.
New alarms that occur after the Clear button is clicked will be
displayed.

� The Dismiss button is used to dismiss/close the Alarm Monitor
display.
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Heat Exchanger Alarm Test

Table 3-46 gives instructions on testing the Heat Exchanger alarm.

Table 3-46: Heat Exchanger Alarm

Step Action

1 Turn circuit breaker “B” of the Heat Exchanger circuit breakers OFF.  This will generate a Heat
Exchanger alarm, ensure that the LMF reports the correct alarm condition in the RF Cabinet.

2 Alarm condition will be reported as BTS Relay #25 – “Heat Exchanger Alarm” makes contact.

3 Turn the circuit breaker “B” ON. Ensure that the alarm condition is now removed.

NOTE
The Heat Exchanger will go through the Start Up sequence.

Door Alarm

Table 3-47 gives instructions on testing the door alarms.

Table 3-47: Door Alarm

Step Action

1 Close all doors on the power cabinet. Ensure that no alarms are reported on the LMF.

2 Individually open and then close each power supply cabinet door. Ensure that the LMF reports an
alarm when each door is opened.

3 Alarm condition will be reported as BTS Relay #27 “Door Alarm” makes contact.

AC Fail Alarm

Table 3-48 gives instructions on testing the AC Fail Alarm.

Table 3-48: AC Fail Alarm

Step Action

1 NOTE
The batteries should have a stable charge before performing this test.

Turn the Main AC breaker on the power cabinet OFF. The LMF should report an alarm on an AC Fail
(Rectifier Fail, Minor Alarm & Major Alarm) condition.

2 Alarm condition will be reported as BTS Relay #23, BTS # 21, BTS # 24 and BTS Relay # 29 “AC
Fail Alarm” makes contact  respectively.

3 Turn the Main AC breaker on the power cabinet ON. The AC Fail alarm should clear.
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Minor Alarm

  Table 3-49 gives instructions on testing minor alarm.

Table 3-49: Minor Alarm

Step Action

1 Turn the Temperature Compensation Panel (TCP) power switch OFF. This will generate a minor
alarm. Verify that the minor alarm LED (amber) is illuminated on the Meter Alarm Panel and the
LMF reports this minor alarm.

2 Alarm condition will be reported as BTS Relay #24 “Minor Alarm” makes contact.

3 Turn the TCP power switch ON. The alarm condition should clear.

Rectifier Alarms

The following series of tests are for single rectifier modules in a multiple
rectifier system. The systems include a three rectifier and a six rectifier
system.

Single Rectifier Failure (Three
Rectifier System)

Table 3-50 gives instructions on testing single rectifier failure or minor
alarm in a three (3) rectifier system.

Table 3-50: Single Rectifier Fail or Minor Alarm

Step Action

1 Remove a single rectifier module and place it into the unused rectifier shelf #2.

2 Turn the AC breaker OFF, for this 2nd shelf.

3 Verify that a rectifier fail alarm is generated. The single rectifier module will illuminate two (2) RED
fail LED (DC and Power), and the Meter Alarm Panel and LMF will also indicate a minor alarm and
rectifier fail status. The RECTIFIER FAIL LED will illuminate.

4 Check that the LMF reports both of these alarm conditions.

NOTE
Alarm conditions reported as BTS #24 and BTS #21, contacts respectively.

5 Turn the AC breaker for the 2nd shelf ON and verify that Rectifier Fail and minor alarm conditions
clear on the Meter Alarm Panel and LMF.

 

Multiple Rectifier Failure

Table 3-51 gives instructions on testing multiple rectifier failure or major
alarm in a three (3) rectifier system.
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Table 3-51: Multiple Rectifier Failure or Major Alarm

Step Action

1 With the rectifier module still in the unused shelf position fromTable 3-50 test procedures, turn the
AC breaker for the 1st shelf OFF.

2 Verify that a rectifier alarm is generated. Each of the two rectifier modules will illuminate two (2)
RED fail LED (DC and Power), and the Meter Alarm Panel and LMF  will indicate a major alarm
(Rectifier Fail and Major Alarm). The RECTIFIER FAIL LED will illuminate.

3 Verify that the LMF reports both alarm conditions. (BTS #29, BTS #21, and BTS #24)

4 Turn the AC breaker for the 1st shelf ON. Verify that all alarms have cleared.

5 Return the rectifier module to its original location. This completes the alarm test on the power cabinet.

 

Single Rectifier Failure 
(Six Rectifier System)

Table 3-52 gives instructions on testing single rectifier failure or minor
alarm in a six (6) rectifier system.

Table 3-52: Single Rectifier Fail or Minor Alarm

Step Action

1 Remove two(2) rectifier modules from shelf #2.

2 Turn the AC breaker OFF, for shelf #2.

3 Verify that a rectifier fail alarm is generated. The single rectifier module will illuminate two (2) RED
fail LED (DC and Power), and the Meter Alarm Panel and LMF will also indicate a minor alarm and
rectifier fail status. The RECTIFIER FAIL LED will illuminate.

4 Check that the LMF reports both of these alarm conditions. (BTS #24 and BTS #21)

5 Turn the AC breaker for this shelf ON and verify that Rectifier Fail and Minor Alarm conditions have
cleared.

 

Multiple Rectifier Failure (Six
Rectifier System)

Table 3-53 gives instructions on testing multiple rectifier failure or major
alarm in a six (6) rectifier system.

Table 3-53: Multiple Rectifier Failure or Major Alarm

Step Action

1 Replace one rectifier module previously removed and turn the AC breaker for  this shelf, OFF.

2 Verify that a rectifier alarm is generated. Each of the two rectifier modules will illuminate a RED fail
LED, and the Meter Alarm Panel will indicate a major alarm (Rectifier Fail, Major and Minor
Alarm).The RECTIFIER FAIL LED will illuminate.

. . . continued on next page
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Table 3-53: Multiple Rectifier Failure or Major Alarm

Step Action

3 Verify that the LMF reports both alarm conditions. (BTS #29)

4 Turn the AC breaker for this shelf ON. Verify that all alarms have cleared.

5 Return all rectifier module to their original location. This completes the rectifier alarm tests on the
power cabinet.

 

Battery Over Temperature
Alarm (Optional)

Use special care to avoid damaging insulation on cables, or
damaging battery cases when using a power heat gun.

CAUTION

Table 3-54 gives instructions on testing the battery over temperature
alarm system.

Table 3-54: Battery Over Temperature Alarm

Step Action

1 Use a low powered heat gun and gently heat the battery over temperature sensor (see location in
Figure 3-15). Do Not hold the hot air gun closer than three (3) inches to the sensor. This will avoid
burning the cable insulation.

2 When the sensor is heated to approximately 50° C, a battery Over Temperature alarm is generated.

NOTE
An audible click will sound as K1 contact engage and K2 contacts disengage.

3 Visually inspect the K1 and K2 relays to verify state changes. The LMF should be displaying correct
alarms. (BTS #22)

4 Verify that the CHARGE DISABLE LED (amber) on the Meter Alarm Panel and the BATTERY
MAIN LED (green) are both illuminated.

5 Switch the hot air gun to cool. Cool the sensor until the K1 and K2 contact return to normal position
(K1 open and K2 closed).  Use the LMF verify that all alarms have cleared.
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Figure 3-15: Battery Overtemperature Sensor
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Rectifier Over Temperature
Alarm

This is the J8 on the rear of the Meter Alarm Panel itself,
this is not connector J8 on the connector  bulkhead at the
rear of the cabinet.

NOTE

Table 3-55 gives instructions on testing the battery over temperature
alarm system.

Table 3-55: Rectifier Over Temperature Alarm

Step Action

1 Remove the J8 link on the rear of the Meter Alarm Panel (see Figure 3-16 for J8 location).

NOTE
This is the J8 on the rear of the Meter Alarm Panel itself, this is not connector J8 on the connector
bulkhead at the rear of the cabinet.

2 Verify that RECTIFIER OVERTEMP LED (red) is illuminated. Contacts on K1 and K2 change states
(K1 now closed and K2 open).

3 Verify that the LMF has reported an alarm condition. (BTS #26)

4 Reinstall J8 connector and verify that all alarm conditions have cleared. K1 and K2 should now be in
their normal states (K1 open and K2 closed).

5 This completes the system tests of the SC 4812ET power cabinet.
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Figure 3-16: Location of Connector J8 on the Meter Alarm Panel
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Before Leaving the site

Table 3-56 gives instructions on what to check before leaving the site.

Table 3-56: Check Before Leaving the Site

Step Action

1 Verify that ALL battery circuit breakers (for occupied shelves) are CLOSED (pushed in).

2 Verify that the Heat Exchanger is running.

3 Verify that the Meter Alarm Panel and TCP modules are switched ON.

4 Verify that the Battery Test Switch on the Meter Alarm Panel is in the OFF position.

5 Verify that no alarm conditions are being reported (with all doors closed).
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Notes
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Chapter 4: Automated Acceptance Test Procedure (ATP)
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Introduction

The Automated Acceptance Test Procedure (ATP) allows Motorola
Cellular Field Engineers (CFEs) to run automated acceptance tests on all
equipped BTS subsystem devices using the Local Maintenance Facility
(LMF) and supported test equipment per the current Cell Site Data File
(CDF) assignment.

The results of these tests (at the option of the operator) are written to a
file that can be printed. All tests are controlled via the LMF platform
using the GPIB interface, therefore, only recommended test equipment
supported by the LMF can be used.

This chapter describes the tests run from the GUI environment, which is
the recommended method. The GUI provides the advantages of
simplifying the LMF user interface, reducing the potential for miskeying
commmands and associated parameters, and speeding up the execution
of complex operations involving multiple command strings. If you feel
the command line interface (CLI) will provide additional insight into the
progress of ATPs and problems that could possibly be encountered, refer
to LMF CLI Commands, R15.X (68P09251A59).

Before using the LMF, use an editor to view the
”CAVEATS” section in the ”readme.txt” file in the c:\wlmf
folder for any applicable information.

The ATP test is to be performed on out-of-service sectors
only.

DO NOT substitute test equipment with other models not
supported by the LMF.

IMPORTANT

*

Refer to Chapter 3 for detailed information on test set
connections for calibrating equipment, cables and other test
set components, if  required.

NOTE

Customer requirements determine which ATP tests to are to be
performed and the field engineer selects the appropriate ATP tests to run.

The tests can be run individually or as one of the following groups:

� All TX: TX tests verify the performance of the BTS transmit line up.
These include the GLI2, MCC, BBX2, and CIO cards, the LPAs and
passive components including splitters, combiners, bandpass filter,
and RF cables.

 . . . continued on next page
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� All RX: RX tests verify the performance of the BTS receiver line up.
These includes the MPC (for starter frames), EMPC (for expansion
frames), CIO, BBX2, MCC, and GLI2 cards and the passive
components including RX filter (starter frame only), and RF cables.

� All TX/RX: Executes all the TX and RX tests.

� Full Optimization: Executes the TX calibration, download BLO, and
TX audit before running all of the TX and RX tests.

ATP Tests Prerequisites

Before attempting to run any ATP tests, ensure the following:

� BTS has been optimized and calibrated (see Chapter 3).

� LMF is logged into the BTS

� CSMs, GLI2s, BBX2s, MCCs and TSU (if the RFDS is installed)
have correct code load and data load

� Primary CSM and GLI2 are INS_ACT

� MCCs are INS_ACT

� BBX2s are OOS-RAM

� BBX2s are calibrated and BLOs are downloaded

� Test cables are calibrated

� Test equipment is selected

� Test equipment is connected for ATP tests

� Test equipment has been warmed up 60 minutes and calibrated

� GPIB is on

Before the FER is run, be sure that all LPAs are turned
OFF (circuit breakers pulled) or that all transmitter ports
are properly terminated.

All transmit ports must be properly terminated for all ATP
tests.

Failure to observe these warnings may result in bodily
injury or equipment damage.

WARNING

TX/RX OUT Connections

Many of the acceptance test procedures require taking
measurements at the TX OUT (BTS/RFDS) connector. At
sites with RFDS, all measurements are through the RFDS
directional coupler TX OUT connector.

IMPORTANT

*
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ATP Test Procedure

There are three different ATP testing options that can be performed to
completely test a BTS. Depending on your requirements, one of the
following ATP testing options should be run.

Table 4-1 provides the procedure to execute an ATP test. To completely
test a BTS, run the ATP tests according to one of the following ATP
testing options.

ATP Testing Option 1

� All TX/RX test

ATP Testing Option 2

� All TX test

� All RX test

ATP Testing Option 3

� TX Mask test

� Rho test

� Pilot Time Offset test

� Code Domain Power test

� FER test

The Full Optimization test can be run if you want the TX
path calibrated before all the TX and RX tests are run.

NOTE

If manual testing has been performed with the HP analyzer,
remove the manual control/system memory card from the
card slot and set the IO CONFIG to the Talk & Listen
mode before starting the automated testing.

IMPORTANT

*

Individual Acceptance Tests
The following individual ATP tests can be used to verify the results of
specific tests:

Spectral Purity TX Mask

This test verifies that the transmitted CDMA carrier waveform,
generated on each sector, meets the transmit spectral mask specification
with respect to the assigned CDF file values.
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Waveform Quality (rho)

This test verifies that the transmitted Pilot channel element digital
waveform quality (rho) exceeds the minimum specified value in
ANSI–J_STD–019. “Rho” represents the correlation between actual and
perfect CDMA modulation spectrum. A rho value of 1.0000 represents
100% (or perfect correlation).

Pilot Time Offset

The Pilot Time Offset is the difference between the CDMA analyzer
measurement interval (based on the BTS system time reference) and the
incoming block of transmitted data from the BTS (Pilot only, Pilot
Gain = 262, PN Offset = 0).

Code Domain Power

This test verifies code domain power levels, which have been set for all
ODD numbered Walsh channels, using the OCNS command. This is
done by verifying that the ratio of PILOT divided by OCNS is equal to
10.2 + 2 dB, and, that the noise floor of all EVEN numbered “OFF”
Walsh channels measures < –27 dB .

Frame Error Rate

The Frame Error Rate (FER) test verifies RX operation of the entire
CDMA Reverse Link using all equipped MCCs assigned to all
respective sector/antennas. The test verifies the BTS sensitivity on all
traffic channel elements currently configured on all equipped MCCs at
an RF input level of –119 dBm (or –116 dBm if using TMPC). Follow
the procedure in Table 4-1 to perform any ATP test.

The STOP button can be used to stop the testing process.

NOTE

Table 4-1:  ATP Test Procedure

Step Action

1 Select the BBX2(s) and MCC(s) to be tested.

2 From the Tests menu, select the desired test.

3 Select the appropriate carrier(s) (carrier – bts# – sector# – carrier#) displayed in the Channels/Carrier
pick list.

To select multiple items, hold down the <Shift> or <Ctrl> key while making the selections.

4 Type the appropriate channel number in the Carrier n Channels box.

The default channel number displayed is determined by the CdmaChans[n] number in the cbsc–n.cdf
file for the BTS.

5 Click OK.

6 Follow the cable connection directions as they are displayed.

7 Click Save Results or Dismiss to close the status report window. 

If Dismiss is used the test results will not be saved in the test report file.
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Background: Tx Mask Test

This test verifies the spectral purity of each BBX2 carrier keyed up at a
specific frequency, per the current CDF file assignment. All tests are
performed using the external calibrated test set, controlled by the same
command. All measurements are through the appropriate TX OUT
(BTS/RFDS) connector.

The Pilot Gain is set to 541 for each antenna and all channel elements
from the MCCs are forward-link disabled. The BBX2 is keyed up, using
both bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only). BBX2 power output is set to obtain +40 dBm as
measured at the TX OUT connector (on either the BTS or RFDS
directional coupler).

TX output power is set to +40 dBm by setting BTS power
level to +33.5 dBm to compensate for 6.5 dB increase from
pilot gain set to 541.

NOTE

The calibrated communications test set measures and returns the
attenuation level of all spurious and IM products in a 30 kHz resolution
bandwidth with respect to the mean power of the CDMA channel,
measured in a 1.23 MHz bandwidth, in dB, verifying that results meet
system tolerances at the following test points:

� 1.9 GHz

– at least –45 dB @ + 900 kHz from center frequency

– at least –45 dB @ – 900 kHz from center frequency

� 800 MHz:

– at least –45 dB @ + 750 kHz from center frequencY

– at least –45 dB @ – 750 kHz from center frequency

– at least –60 dB @ – 1980 kHz from center frequency

– at least –60 dB @ – 1980 kHz from center frequency

The BBX2 then de-keys, and, if selected, the MCC is re-configured to
assign the applicable redundant BBX2 to the current TX antenna path
under test. The test is then repeated.
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Figure 4-1: TX Mask Verification Spectrum Analyzer Display
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Background: Rho Test

This test verifies the transmitted Pilot channel element digital waveform
quality of each BBX2 carrier keyed up at a specific frequency per the
current CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
are via the appropriate TX OUT (BTS/RFDS) connector.

The Pilot Gain is set to 262 for each antenna, and all channel elements
from the MCCs will be forward link disabled. The BBX2 is keyed up
using both bbxlvl and bay level offsets, to generate a CDMA carrier
(with pilot channel element only, Walsh code 0). BBX2 power output is
set to 40 dBm as measured at the TX OUT connector (on either the BTS
or RFDS directional coupler).

The calibrated communications test set measures and returns the Pilot
channel element digital waveform quality (rho) in dB, verifying that
result meets system tolerances Waveform quality (rho) should be > 0.912
(–0.4 dB).

The BBX2 then de-keys and the applicable redundant BBX2 is assigned
to the current TX antenna path under test. The test is then repeated.

The LMF Tests menu list item, Rho, performs the waveform quality test
for a XCVR(s). All measurements are made through the appropriate TX
output connector using the calibrated TX cable setup.
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Background: Pilot Offset
Acceptance Test

This test verifies the transmitted Pilot channel element Pilot Time Offset
of each BBX2 carrier keyed up at a specific frequency per the current
CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
will be via the appropriate TX OUT (BTS/RFDS) connector.

The Pilot Gain is set to 262 for each antenna and all TCH elements from
the MCCs are forward link disabled. The BBX is keyed up using both
bbxlvl and bay level offsets to generate a CDMA carrier (with pilot
channel element only, Walsh code 0). BBX power output is set to
40 dBm as measured at the TX OUT connector (on either the BTS or
RFDS directional coupler).

The calibrated communications test set measures and returns the Pilot
Time Offset in uS, verifying results meet system tolerances: Pilot Time
Offset should be within < 3 µs of the target PT Offset (0 �S).

The BBX2 then de-keys, and the applicable redundant BBX2 is assigned
to the current TX antenna path under test. The test is then repeated.
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Background: Code Domain
Power Test

This test verifies the Code Domain Power/Noise of each BBX2 carrier
keyed up at a specific frequency per the current CDF file assignment.
All tests are performed using the external calibrated test set controlled by
the same command. All measurements are via the appropriate TX OUT
(BTS/RFDS) connector.

For each sector/antenna under test, the Pilot Gain is set to 262 and all
MCC channel elements under test are configured to generate Orthogonal
Channel Noise Source (OCNS) on different odd Walsh codes, and are
assigned a full–rate gain of 81. The maximum number of MCC/CEs to
be tested an any one time is 32 (32 odd Walsh codes). If more than 32
CEs exist, then multiple sets of measurements are made, so all channel
elements are verified on all sectors.

BBX2 power output is set to 40 dBm as measured at the TX OUT
connector (on either the BTS or RFDS directional coupler).

Code domain power levels, which have been set for all ODD numbered
Walsh channels, are verified using the OCNS command. This is done by
verifying that Pilot Power (dBm) minus OCNS Power (dBm) is equal to
10.2 + 2 dB and that the noise floor of all “OFF” Walsh channels
measures  < –27 dB (with respect to total CDMA channel power).

The BBX2 then de-keys and, the applicable redundant BBX2 is assigned
to the current TX antenna path under test. The test is then repeated.
Upon completion of the test, OCNS is disabled on the specified
MCC/CE.
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Figure 4-2: Code Domain Power and Noise Floor Levels
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Background: FER Test

This test verifies the BTS Frame Error Rate (FER) on all traffic channel
elements currently configured on all equipped MCCs (full rate at 1%
FER) at an RF input level of –119 dBm [or –116 dBm if using Tower
Top Amplifier (TMPC)]. All tests are performed using the external
calibrated test set as the signal source controlled by the same command.
All measurements will be via the LMF.

The pilot gain is set to 262 for each TX antenna and all channel elements
from the MCCs are forward-link disabled. The BBX2 is keyed up using
only bbxlvl level offsets, to generate a CDMA carrier (with pilot channel
element only). BBX2 power output is set to –20 dBm as measured at the
TX OUT connector (on either the BTS or RFDS directional coupler).
The BBX2 must be keyed in order to enable the RX receive circuitry.

The LMF prompts the MCC/CE under test to measure all zero longcode
and provide the FER report on the selected active MCC on the reverse
link for both the main and diversity RX antenna paths, verifying the
results meet the following specification: FER returned less than 1% and
total frames measured is 1500.

All MCC/CEs selected are tested on the specified RX antenna path. The
BBX then de-keys and, the applicable redundant BBX2 is assigned to
the current RX antenna paths under test. The test is then repeated.
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Background

Each time an ATP test is run, an ATP report is updated to include the
results of the most recent ATP tests if the Save Results button is used to
close the status report window. The ATP report will not be updated if the
status reports window is closed with use of the Dismiss button.

ATP Report

A separate report is created for each BTS and includes the following for
each test:

� Test name

� BBX number

� Channel number

� Carrier number

� Sector number

� Upper test limit

� Lower test limit

� Test result

� PASS or FAIL

� Description information (if applicable)

� Time stamp

� Details/Warning information (if applicable)

Follow the procedures in the Table 4-2 to view and create a printable file
for the ATP report of a BTS.

Table 4-2:  Generate an ATP  Report 

Step Action

1 Click on the Login tab if it is not in the forefront.

2 Select the desired BTS from the Available Base Stations pick list.

3 Click on the Report button.

4 Sort the report if desired by clicking on a column heading.

5 Click on the Dismiss button if you do not want to create a printable file copy.

6 To create a printable file, select the desired file type in the picklist and then click on the Save button.
 

4



Apr 2001 SC�4812ET BTS Optimization/ATP — CDMA LMF
DRAFT
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External Test Equipment
Removal

Perform the procedure outlined in Table 5-1 to disconnect the test
equipment and configure the BTS for active service.

Table 5-1: External Test Equipment Removal

Step Action

1 Disconnect all external test equipment from all TX and RX connectors at the rear of the frame.

2 Reconnect and visually inspect all TX and RX antenna feed lines at the rear of the frame.

Verify all sector antenna feed lines are connected to the
correct ports on the frame. Crossed antenna cables will
cause system degradation of call processing.

CAUTION

Reset All Devices

Reset all devices by cycling power before leaving the site. The CBSC
configuration data and code loads could be different from data and code
on the LMF. By resetting all devices, the CBSC can load the proper data
and code when the span is active again.

Updating BTS CAL LMF Files
in the CBSC

Updated CAL file information is moved from the LMF Windows
environment back to the CBSC which resides in a Unix environment.
The procedures that follow detail how to move files from the Windows
environment to the CBSC.

Copying CAL files from LMF to a Disk

Follow the procedures in Table 5-2 to copy CAL files from a LMF
computer to a 3.5 diskette.

Table 5-2: Copy Files from LMF to a Diskette

Step Action

1 Insert a disk into your Windows A drive.

NOTE
If your disk has not been formatted, format it using Windows.  The disk must be DOS formatted
before copying any files. Consult your Windows/DOS documentation or online helps on how to
format diskettes.

2 Click on the Start button and launch the Windows Explorer program from your Programs menu list.
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Table 5-2: Copy Files from LMF to a Diskette

Step Action

3 Click on your C: drive.

4 Double Click on the wlmf folder.

5 Double Click on the CDMA folder.

6 Click on the bts–# folder for the calibration file you want to copy.

7 Drag the BTS–#.cal file to the 3–1/2 floppy (A:) icon on the top left of the screen and release the
mouse button.

8 Continue step 6 and 7 until you have copied each file desired and close the Windows Explorer
program by selecting Close from the File menu option.

 

Copying CAL files from diskette to the CBSC

Follow the procedures in Table 5-3 to copy CAL files from a diskette to
the CBSC.

Table 5-3: Copy CAL Files From Diskette to the CBSC

Step Action

1 Log into the CBSC workstation.

2 Place your diskette containing CAL file(s) in the CBSC workstation diskette drive.

3 Enter eject –q and press the Enter key.

4 Enter mount and press the Enter key.  Verify that  floppy/no_name is displayed.

NOTE
If the eject command has been previously entered, floppy/no_name will be appended with a number.
Use the explicit floppy/no_name reference displayed.

5 Enter cd /floppy/no_name and press the Enter key.

6 Enter ls –lia and press the Enter key.  Verify that the bts–#.cal file is on the disk.

7 Enter cd and press the Enter key.

8 Enter pwd and press the Enter key.  Verify that you are in your  home directory (/home/<name>).

9 Enter dos2unix /floppy/no_name/bts–#.cal  bts–#.cal and press the Enter key (where # is the BTS
number).

10 Enter ls –l *.cal and press the Enter key.  Verify that the CAL file was successfully copied.

11 Enter eject and press the Enter key.

12 Remove the floppy disk from the workstation.
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BTS Site Span Configuration
Verification

Perform the procedure in Table 5-4 to verify the current Span Framing
Format and Line Build Out (LBO) parameters. ALL MGLI2/SGLI2
boards in all C–CCP shelves that terminate a T1/E1 span should be
verified.

Table 5-4: BTS Span Parameter Configuration

Step Action

1 Connect a serial cable from the LMF COM1 port (via null modem board) to the front panel of the
MGLI2 MMI port (see Figure 5-1).

2 Start an MMI communication session with CSM–1 by using the Windows desktop shortcut icon.

NOTE
The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

3 Enter the following MMI command to display the current MGLI2/SGLI2 framing format and line
code configuration (in bold type):

span view <cr>

Observe a display similar to the options shown below:

COMMAND ACCEPTED: span view

The parameter in NVM is set to T1_2.

The frame format in flash is set to use T1_2.
Equalization:
  Span A – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span B – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span C – Default (0–131 feet for T1/J1, 120 Ohm for E1)

S D D f lt (0 131 f t f T1/J1 120 Oh f E1)  Span D – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span E – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span F – Default (0–131 feet for T1/J1, 120 Ohm for E1)

Linkspeed: Default (56K for T1 D4 AMI, 64K otherwise)
Currently, the link is running at the default rate 
The actual rate is 0

NOTE
Defaults for span equalization are 0–131 feet for T1/J1 spans and 120 Ohm for E1.

Default linkspeed is 56K for T1 D4 AMI spans and 64K for all other types.

There is no need to change from defaults unless the OMC–R/CBSC span configuration requires it.

If the current MGLI2/SGLI2 framing format and line code configuration does not display the correct
choice, proceed to Table 5-5.

4 Repeat steps 1 through 3 for all remaining GLIs.

5 Exit the GLI MMI session and HyperTerminal connection by selecting File from the connection
window menu bar, and then Exit from the dropdown menu.
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REF– FW00344

9–PIN TO 9– PIN
RS–232 CABLE

NULL MODEM BOARD
(PART# 8484877P01)

RS–232 CABLE 
FROM LMF COM1
PORT

MMI SERIAL PORT

GLI BOARD

Figure 5-1: MGLI2/SGLI2 MMI Port Connection

Set BTS Site Span
Configuration

Perform the procedure in Table 5-5 to configure the Span Framing
Format and Line Build Out (LBO) parameters. ALL MGLI2/SGLI2
boards in all C–CCP shelves that terminate a T1/E1 span must be
configured.

Perform the following procedure ONLY if span
configurations loaded in the MGLI2/GLI2s do not match
those in the OMCR/CBSC data base, AND ONLY when the
exact configuration data is available. Loading incorrect
span configuration data will render the site inoperable.

IMPORTANT

*

Table 5-5: Set BTS Span Parameter Configuration

Step Action

1 If not already done, connect a serial cable from the LMF COM1 port (via null modem board) to the
front panel of the MGLI2 MMI port (see Figure 5-1).

2 Start an MMI communication session with CSM–1 by using the Windows desktop shortcut icon (see
Table 3-5 on page 3-14).

NOTE
The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

. . . continued on next page
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Table 5-5: Set BTS Span Parameter Configuration

Step Action

3 If required only, enter the following MMI command for each span line to set the BTS span parameters
to match that of the physical spans a – f run to the site:

span_config <option#1> <option#2> <option#3> <option#4> <option#5>
option#1   =  the span to change (a – f)
option#2   =  the span type (0 – 8):

0 – E1_1 (HDB3, CCS, CRC–4)
1 – E1_2 (HDB3, CCS)
2 – E1_3 (HDB3, CAS, CRC–4, TS16)
3 – E1_4 (HDB3, CAS, TS16)
4 – T1_1 (AMI, DS1 AT&T D4, without ZCS, 3 to 1 packing, Group 0 unusable)
5 – T1_2 (B8ZS, DS1 AT&T ESF, 4 to 1 packing, 64K link)
6 – J1_1 (B8ZS, J1 AT&T ESF, Japan CRC6, 4 to 1 packing)
7 – J1_2 (B8ZS, J1 AT&T ESF, US CRC6, 4 to 1 packing)
8 – T1_3 (AMI, DS1 AT&T D4, with ZCS, 3 to 1 packing, Group 0 unusable)

option#3   =  the link speed (56 or 64) Kbps

option#4   =  the span equalization (0 – 7):
0 – T1_6 (T1,J1:long haul)
1 – T1_4 (T1,J1:393–524 feet)
2 – T1_4 (T1,J1:131–262 feet)
3 – E1_75 (E1:75 Ohm)
4 – T1_4 (T1,J1:0–131 feet)
5 – T1_4 (T1,J1:524–655 feet)
6 – T1_4 (T1,J1:262–393 feet)
7 – E1_120 (E1:120 Ohm)

option#5   =  the slot that has LAPD channel (0 – 31)

Example for setting span configuration to E1_2, 64 Kbps, E1_120–Ohm, LAPD channel 1:

span_config a 1 64 7 1
.
.

span_config f 1 64 7 1

Example for setting span configuration to T1_2, 64 Kbps, T1_4 (0–131 feet), LAPD channel 0:

span_config a 5 64 4 0
.
.

span_config f 5 64 4 0

* IMPORTANT
Make sure that spans a – f are set to the same span type and link speed. The equalization may be
different for each individual span.

After executing the span_config command, the affected MGLI2/SGLI2 board MUST be reset and
re–loaded for changes to take effect.

Although defaults are shown, always consult site specific documentation for span type and rate used at
the site.

4 Press the RESET button on the GLI2 for changes to take effect.
. . . continued on next page
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Table 5-5: Set BTS Span Parameter Configuration

Step Action

5 This completes the site specific BTS Span setup for this GLI. Move the MMI cable to the next SGLI2
and repeat steps 1 and 4 for ALL MGLI2/SGLI2 boards.

6 Terminate the Hyperterm session and disconnect the LMF from the MGLI/SGLI.
 

Re–connect BTS T1 Spans
and Integrated Frame Modem

Before leaving the site, connect any T1 span TELCO connectors which
were removed to allow the LMF to control the BTS. Refer to Table 5-6.

Table 5-6: T1/E1 Span/IFM Connections

Step Action

1 Connect the surge protectors on the 50–pin punch block for the spans.

2 Ensure that the CSU is powered ON.

3 Verify the span status.

LMF Removal

DO NOT power down the CDMA LMF without
performing the procedure indicated below. Corrupted/lost
data files may result, and in some cases, the CDMA LMF
may lock up.

CAUTION

Follow the procedures in Table 5-7 to terminate the LMF session and
remove the terminal.

Table 5-7: Terminate the LMF Session and Remove the LMF

Step Action

1 From the CDMA window select File>Exit.

2 From the Windows Task Bar click Start>Shutdown. Click Yes when the Shut Down Windows
message appears.

3 Disconnect the LMF terminal Ethernet connector from the BTS cabinet.

4 Disconnect the LMF serial port, the RS-232 to GPIB interface box, and the GPIB cables as required
for equipment transport.
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Reestablish OMC-R Control/
Verifying T1/E1

After all activities at the site have been completed,
including disconnecting the LMF, place a phone call to the
OMC-R and request the BTS be placed under control of
the OMC-R.

IMPORTANT

*
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Notes
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Overview

The information in this chapter addresses some of the scenarios likely to
be encountered by Customer Field Engineering (CFE) team members.
This troubleshooting guide was created as an interim reference document
for use in the field. It provides basic “what to do if” basic
troubleshooting suggestions when the BTS equipment does not perform
per the procedure documented in the manual.

Comments are consolidated from inputs provided by CFEs in the field
and information gained form experience in Motorola labs and
classrooms.
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Cannot Log into Cell-Site

Table 6-1:  Login Failure Troubleshooting Procedure

� Step Action

1 If MGLI2 LED is solid RED, it implies a hardware failure. Reset MGLI2 by
re-seating it. If this persists, install RGLI2 card in MGLI2 slot and retry. A Red
LED may also indicate no Ethernet termination at top of frame.

2 Verify that T1 is disconnected at the Channel Signaling Unit (CSU). If T1 is still
connected, verify the CBSC has disabled the BTS.

3 Try ‘ping’ing the MGLI2.

4 Verify the LMF is connected to the Primary LMF port (LAN A) in front of the
BTS.

5 Verify the LMF was configured properly.

6 Verify the BTS-LMF cable is RG-58 (flexible black cable of less than 2.5 feet
length).

7 Verify the Ethernet ports are terminated properly.

8 Verify a T-adapter is not used on LMF side port if connected to the BTS front
LMF primary port.

9 Try connecting to the I/O panel (back of frame). Use Tri–Ax to BNC adapter at
the LMF port for this connection.

10 Re-boot the CDMA LMF and retry.

11 Re-seat the MGLI2 and retry.

12 Verify IP addresses are configured properly.

 

Cannot Communicate to
Power Meter

Table 6-2:  Troubleshooting a Power Meter Communication Failure

� Step Action

1 Verify Power Meter is connected to LMF with GPIB adapter.

2 Verify cable setup as specified in Chapter 3.

3 Verify the GP–IB address of the Power Meter is set to 13. Refer to Test
Equipment setup section of Chapter 3 for details.

4 Verify that Com1 port is not used by another application.

5 Verify that the communications analyzer is in Talk&Listen, not Control mode.
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Cannot Communicate to
Communications Analyzer

Table 6-3:  Troubleshooting a Communications Analyzer Communication Failure

� Step Action

1 Verify analyzer is connected to LMF with GPIB adapter.

2 Verify cable setup.

3 Verify the GPIB address is set to 18.

4 Verify the GPIB adapter DIP switch settings are correct. Refer to Test Equipment
setup section for details.

5 Verify the GPIB adapter is not locked up. Under normal conditions, only 2 green
LEDs must be ‘ON’ (Power and Ready). If any other LED is continuously ‘ON’,
then power-cycle the GPIB Box and retry.

6 If a Hyperterm window is open for MMI, close it.

7 Verify the LMF GPIB address is set to 18

8 Verify the analyzer is in Talk and Listen not Control mode.
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Table 6-4: Troubleshooting Code Download Failure

� Step Action

1 Verify T1 is disconnected from the BTS at CSU.

2 Verify LMF can communicate with the BTS device using the Status function.

3 Communication to MGLI2 must first be established before trying to talk to any
other BTS device. MGLI2 must be INS_ACT state (green).

4 Verify the card is physically present in the cage and powered-up.

5 If card LED is solid RED, it implies hardware failure. Reset card by re-seating it.
If this persists, replace card from another slot & retry.

NOTE
The card can only be replaced by a card of the same type.

6 Re-seat card and try again.

7 If BBX2 reports a failure message and is OOS_RAM, the code load was OK.
Status it.

8 If the download portion completes and the reset portion fails, reset the device by
selecting the device and reset.

 

Cannot Download DATA to
Any Device (Card)

Table 6-5: Troubleshooting Data Download Failure

� Step Action

1 Re-seat card and repeat code and data load procedure.

2 Verify the ROM and RAM code loads are of the same release by statusing the
card. Refer to Chapter 3, “Download the BTS” for more information.
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Cannot ENABLE Device

Before a device can be enabled (placed in-service), it must be in the
OOS_RAM state (yellow on the LMF) with data downloaded to the
device. The color of the device on the LMF changes to green, once it is
enabled.

The three states that devices can be displayed:

� Enabled (green, INS)

� Disabled (yellow, OOS_RAM)

� Reset (blue, OOS_ROM)

Table 6-6: Troubleshooting Device Enable (INS) Failure

� Step Action

1 Re-seat card and repeat code and data load procedure.

2 If CSM cannot be enabled, verify the CDF file has correct latitude and longitude
data for cell site location and GPS sync.

3 Ensure primary CSM is in INS_ACT state.

NOTE
MCCs will not go INS without the CSM being INS.

4 Verify 19.6608 MHz CSM clock; MCCs will not go INS otherwise.

5 The BBX should not be enabled for ATP tests.

6 If MCCs give “invalid or no system time,” verify the CSM is enabled.

 

LPA Errors

Table 6-7: LPA Errors

� Step Action

1 If LPAs continue to give alarms, even after cycling power at the circuit breakers,
then connect an MMI cable to the LPA and set up a Hyperterminal connection.
Enter ALARMS in the Hyperterminal window. The resulting LMF display may
provide an indication of the problem. (Call Field Support for further assistance.)
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Bay Level Offset Calibration
Failure

Table 6-8: Troubleshooting BLO Calibration Failure

� Step Action

1 Verify the Power Meter is configured correctly (see the test equipment setup
section) and connection is made to the proper TX port.

2 Verify the parameters in the bts–#.cdf file are set correctly for the following
bands:

For 1900 MHz:
BandClass=1; FreqBand=16

For 800 MHz:
BandClass=0; FreqBand=8

3 Verify that no LPA in the sector is in alarm state (flashing red LED). Reset the
LPA by pulling the circuit breaker, and after 5 seconds, pushing back in.

4 Re-calibrate the Power Meter and verify it is calibrated correctly with cal factors
from sensor head.

5 Verify GPIB adapter is not locked up. Under normal conditions, only 2 green
LEDs must be ‘ON’ (Power and Ready). If any other LED is continuously ‘ON’,
power-cycle (turn power off and on) the GPIB Box and retry.

6 Verify sensor head is functioning properly by checking it with the 1 mW (0 dBm)
Power Ref signal.

7 If communication between the LMF and Power Meter is operational, the Meter
display will show “RES :’’

8 Verify the combiner frequency is the same as the test freq/chan.
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Calibration Audit Failure

Table 6-9: Troubleshooting Calibration Audit Failure

� Step Action

1 Verify Power Meter is configured correctly (refer to the test equipment setup
section of chapter 3).

2 Re-calibrate the Power Meter and verify it is calibrated correctly with cal factors
from sensor head.

3 Verify that no LPA is in alarm state (rapidly flashing red LED). Reset the LPA by
pulling the circuit breaker, and, after 5 seconds, pushing back in.

4 Verify that no sensor head is functioning properly by checking it with the 1 mW
(0 dBm) Power Ref signal.

5 After calibration, the BLO data must be re-loaded to the BBX2s before auditing.
Click on the BBX(s) and select Device>Download BLO
Re-try the audit.

6 Verify GPIB adapter is not locked up. Under normal conditions, only 2 green
LEDs must be ‘ON’ (Power and Ready). If any other LED is continuously ‘ON’,
power-cycle (turn power off and on) the GP–IB Box and retry.
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Cannot Perform Txmask
Measurement

Table 6-10: Troubleshooting TX Mask Measurement Failure

� Step Action

1 Verify that TX audit passes for the BBX2(s).

2 If performing manual measurement, verify analyzer setup.

3 Verify that no LPA in the sector is in alarm state (flashing red LED). Re-set the
LPA by pulling the circuit breaker, and, after 5 seconds, pushing it back in.

Cannot Perform Rho or Pilot
Time Offset Measurement

Table 6-11: Troubleshooting Rho and Pilot Time Offset Measurement Failure

� Step Action

1 Verify presence of RF signal by switching to spectrum analyzer screen.

2 Verify PN offsets displayed on the analyzer is the same as the PN offset in the
CDF file.

3 Re–load MGLI2 data and repeat the test.

4 If performing manual measurement, verify analyzer setup.

5 Verify that no LPA in the sector is in alarm state (flashing red LED). Reset the
LPA by pulling the circuit breaker, and, after 5 seconds, pushing back in.

6 If Rho value is unstable and varies considerably (e.g. .95,.92,.93), this may
indicate that the GPS is still phasing (i.e. trying to reach and maintain 0 freq.
error). Go to the freq. bar in the upper right corner of the Rho meter and select Hz.
Press <Shift–avg> and enter 10, to obtain an average Rho value. This is an
indication the GPS has not stabilized before going INS and may need to be
re-initialized.
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Cannot Perform Code Domain
Power and Noise Floor
Measurement

Table 6-12: Troubleshooting Code Domain Power and Noise Floor Measurement Failure

� Step Action

1 Verify presence of RF signal by switching to spectrum analyzer screen.

2 Verify PN offset displayed on analyzer is same as PN offset being used in the
CDF file.

3 Disable and re-enable MCC (one or more MCCs based on extent of failure).

 

Cannot Perform Carrier
Measurement

Table 6-13: Troubleshooting Carrier Measurement Failure

� Step Action

1 Perform the test manually, using the spread CDMA signal. Verify High Stability
10 MHz Rubidium Standard is warmed up (60 minutes) and properly connected to
test set-up.
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Multi–FER Test Failure

Table 6-14: Troubleshooting Multi-FER Failure

� Step Action

1 Verify test equipment set up is correct for a FER test.

2 Verify test equipment is locked to 19.6608 and even second clocks. The yellow
LED (REF UNLOCK) must be OFF.

3 Verify MCCs have been loaded with data and are INS–ACT.

4 Disable and re-enable the MCC (1 or more based on extent of failure).

5 Disable, re-load code and data, and re-enable MCC (one or more MCCs based on
extent of failure).

6 Verify antenna connections to frame are correct based on the directions messages.
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Problem Description

Many of the Clock Synchronization Manager (CSM) boards may be
resolved in the field before sending the boards to the factory for repair.
This section describes known CSM problems identified in field returns,
some of which are field-repairable. Check these problems before
returning suspect CSM boards.

Intermittent 19.6608 MHz
Reference Clock/GPS
Receiver Operation

If having any problems with CSM board kit numbers, SGLN1145 or
SGLN4132, check the suffix with the kit number. If the kit has version
“AB,” then replace with version ‘‘BC’’ or higher, and return model AB
to the repair center.

No GPS Reference Source
Check the CSM boards for proper hardware configuration. CSM kit
SGLN1145, in Slot l, has an on-board GPS receiver; while kit
SGLN4132, in Slot 2, does not have a GPS receiver. Any incorrectly
configured board must be returned to the repair center. Do not attempt to
change hardware configuration in the field. Also, verify the GPS
antenna is not damaged and is installed per recommended guidelines.

Checksum Failure
The CSM could have corrupted data in its firmware resulting in a
non-executable code. The problem is usually caused by either electrical
disturbance, or interruption of data during a download. Attempt another
download with no interruptions in the data transfer. Return CSM board
back to repair center if the attempt to reload fails.

GPS Bad RX Message Type

This is believed to be caused by a later version of CSM software (3.5 or
higher) being downloaded, via LMF, followed by an earlier version of
CSM software (3.4 or lower), being downloaded from the CBSC.
Download again with CSM software code 3.5 or higher. Return CSM
board back to repair center if attempt to reload fails.

CSM Reference Source
Configuration Error

This is caused by incorrect reference source configuration performed in
the field by software download. CSM kit SGLN1145 and SGLN4132
must have proper reference sources configured (as shown below) to
function correctly.

CSM Kit No. Hardware Configuration CSM Slot No. Reference Source Configuration

SGLN1145 With GPS Receiver 1 Primary = Local GPS
Backup = Either LFR or HSO

SGLN4132 Without GPS Receiver 2 Primary = Remote GPS
Backup = Either LFR or HSO
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Takes Too Long for CSM to
Come INS

This may be caused by a delay in GPS acquisition. Check the accuracy
flag status and/or current position. Refer to the GSM system time/GPS
and LFR/HSO verification section in Chapter 3. At least 1 satellite
should be visible and tracked for the “surveyed” mode and 4 satellites
should be visible and tracked for the “estimated” mode. Also, verify
correct base site position data used in “surveyed” mode.
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Introduction

The C–CCP backplane is a multi–layer board that interconnects all the
C–CCP modules.  The complexity of this board lends itself to possible
improper diagnoses when problems occur.

Connector Functionality

The following connector overview describes the major types of
backplane connectors along with the functionality of each. This will
allow the Cellular Field Engineer (CFE) to:

� Determine which connector(s) is associated with a specific problem
type.

� Allow the isolation of problems to a specific cable or connector.

Primary “A” and Redundant “B” ISB (Inter Shelf Bus)
connectors

The 40 pin ISB connectors provide an interface bus from the master
GLI2 to all other GLI2s in the modem frame. Its basic function is to
provide clock synchronization from the master GLI2 to all other GLI2s
in the frame.

The ISB is also provides the following functions:

� span line grooming when a single span is used for multiple cages.

� provide MMI connection to/from the master GLI2 to cell site modem.

� provide interface between GLI2s and the AMR (for reporting BTS
alarms).

Span Line Connector

The span line input is an 8 pin RJ–45 connector that provides a primary
and secondary (if used) span line interface to each GLI2 in the C–CCP
shelf.  The span line is used for MM/EMX switch control of the Master
GLI2 and also all the BBX2 traffic.

Power Input (Return A, B, and C connectors)

Provides a +27 Volt input for use by the power supply modules.

Power Supply Module Interface

Each power supply module has a series of three different connectors to
provide the needed inputs/outputs to the C–CCP backplane. These
include a VCC/Ground input connector, a Harting style multiple pin
interface, and a +15 V/Analog Ground output connector. The Transceiver
Power Module converts 27/48 Volts to a regulated +15, +6.5, +5.0 Volts
to be used by the C–CCP shelf cards.

GLI2 Connector

This connector consists of a Harting 4SU digital connector and a
6–conductor  coaxial connector for RDM distribution. The connectors
provide inputs/outputs for the GLI2s in the C–CCP backplane.
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GLI2 Ethernet “A” and “B” Connections

These BNC connectors are located on the C–CCP backplane and routed
to the GLI2 board.  This interface provides all the control and data
communications between the master GLI2 and the other GLI2, between
gateways, and for the LMF on the LAN.

BBX2 Connector

Each BBX2 connector consists of a Harting 2SU/1SU digital connector
and two 6–conductor coaxial connectors.  These connectors provide DC,
digital, and RF inputs/outputs for the BBX2s in the C–CCP backplane.

CIO Connectors

� RX RF antenna path signal inputs are routed through RX Tri–Filters
(on the I/O plate), and via coaxial cables to the two MPC modules –
the six “A” (main) signals go to one MPC; the six “B” (diversity) to
the other.  The MPC outputs the low–noise–amplified signals via the
C–CCP backplane to the CIO where the signals are split and sent to
the appropriate BBX2.

� A digital bus then routes the baseband signal through the BBX2, to
the backplane, then on to the MCC24 slots.

� Digital TX antenna path signals originate at the MCC24s. Each
output is routed from the MCC24 slot via the backplane appropriate
BBX2.

� TX RF path signal originates from the BBX2, through the backplane
to the CIO, through the CIO, and via multi-conductor coaxial cabling
to the LPAs in the LPA shelf.

C–CCP Backplane
Troubleshooting Procedure

The following table provides a standard procedure for troubleshooting
problems that appear to be related to a defective C–CCP backplane. The
table is broken down into possible problems and steps which should be
taken in an attempt to find the root cause.

It is important to note that all steps be followed before
replacing ANY C–CCP backplane.

IMPORTANT

*
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Digital Control Problems

No GLI2 Control via LMF (all GLI2s)

Table 6-15: No GLI2 Control via LMF (all GLI2s)

Step Action

1 Check the ethernet for proper connection, damage, shorts, or
opens.

2 Verify C–CCP backplane Shelf ID DIP switch is set correctly.

3 Visually check the master GLI2 connector (both board and
backplane) for damage.

4 Replace the master GLI2 with a known good GLI2.

No GLI2 Control through Span Line Connection (All GLI2s)

Table 6-16: No GLI2 Control through Span Line Connection (Both
GLI2s)

Step Action

1 Verify C–CCP backplane Shelf ID DIP switch is set correctly.

2 Verify that the BTS and GLI2s are correctly configured in the
OMCR/CBSC data base.

3 Visually check the master GLI2 connector (both board and
backplane) for damage.

4 Replace the master GLI2 with a known good GLI2.

5 Check the span line inputs from the top of the frame to the
master GLI2 for proper connection and damage.

Table 6-17: MGLI2 Control Good – No Control over Co–located
GLI2

Step Action

1 Verify that the BTS and GLI2s are correctly configured in the
OMCR CBSC data base.

2 Check the ethernet for proper connection, damage, shorts, or
opens.

3 Visually check all GLI2 connectors (both board and
backplane) for damage.

4 Replace the remaining GLI2 with a known good GLI2.
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No AMR Control (MGLI2 good)

Table 6-18: MGLI2 Control Good – No Control over AMR

Step Action

1 Visually check the master GLI2 connector (both board and
backplane) for damage.

2 Replace the master GLI2 with a known good GLI2.

3 Replace the AMR with a known good AMR.

No BBX2 Control in the Shelf

Table 6-19: MGLI2 Control Good – No Control over Co–located
GLI2s

Step Action

1 Visually check all GLI2 connectors (both board and
backplane) for damage.

2 Replace the remaining GLI2 with a known good GLI2.

3 Visually check BBX2 connectors (both board and backplane)
for damage.

4 Replace the BBX2 with a known good BBX2.

No (or Missing) Span Line Traffic

Table 6-20: BBX2 Control Good – No (or Missing) Span Line Traffic

Step Action

1 Visually check all GLI2 connectors (both board and
backplane) for damage.

2 Replace the remaining GLI2 with a known good GLI2.

3 Visually check all span line distribution (both connectors and
cables) for damage.

4 If the problem seems to be limited to 1 BBX2, replace the
BBX2 with a known good BBX2.

No (or Missing) MCC24 Channel Elements

Table 6-21: No MCC24 Channel Elements

Step Action

1 Verify CEs on a co–located MCC24 (MccType=2)

2 If the problem seems to be limited to 1 MCC24, replace the
MCC24 with a known good MCC24.

– Check connectors (both board and backplane) for damage.

3 If no CEs on any MCC24:

– Verify clock reference to CIO.

6



CCP Backplane Troubleshooting – continued

Apr 2001 6-17SC�4812ET BTS Optimization/ATP — CDMA LMF
DRAFT

DC Power Problems

Potentially lethal voltage and current levels are routed to
the BTS equipment. This test must be carried out with a
second person present, acting in a safety role. Remove all
rings, jewelry, and wrist watches prior to beginning this
test.

WARNING

No DC Input Voltage to  Power Supply Module

Table 6-22: No DC Input Voltage to Power Supply Module

Step Action

1 Verify DC power is applied to the BTS frame. Verify there are
no breakers tripped.

* IMPORTANT
If a breaker has tripped, remove all modules from the
applicable shelf supplied by the breaker and attempt to reset it.

– If breaker trips again, there is probably a cable or breaker
problem within the frame.

– If breaker does not trip, there is probably a defective
module or sub–assembly within the shelf.

2 Verify that the C–CCP shelf breaker on the BTS frame
breaker panel is functional.

3 Use a voltmeter to determine if the input voltage is being
routed to the C–CCP backplane by measuring the DC voltage
level on the PWR_IN cable.

– If the voltage is not present, there is probably a cable or
breaker problem within the frame.

– If the voltage is present at the connector, reconnect and
measure the level at the “VCC” power feed clip on the
distribution backplane.  If the voltage is correct at the
power clip, inspect the clip for damage.

4 If everything appears to be correct, visually inspect the power
supply module connectors.

5 Replace the power supply module with a known good
module.

6 If steps 1 through 4 fail to indicate a problem, the C–CCP
backplane failure (possibly an open trace) has occurred.
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No DC Voltage (+5, +6.5, or +15 Volts) to a Specific GLI2,
BBX2, or Switchboard

Table 6-23: No DC Input Voltage to any C–CCP Shelf Module

Step Action

1 Verify steps outlined in Table 6-22 have been performed.

2 Inspect the defective board/module (both board and
backplane) connector for damage.

3 Replace suspect board/module with known good
board/module.

TX and RX Signal Routing
Problems

Table 6-24: No DC Input Voltage to any C–CCP Shelf Module

Step Action

1 Inspect all Harting Cable connectors and back–plane
connectors for damage in all the affected board slots.

2 Perform steps outlined in the RF path troubleshooting
flowchart in this manual.
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Introduction

The RFDS is used to perform Pre–Calibration Verification and
Post-Calibration Audits which  limit-check the RFDS-generate and
reported receive levels of every path from the RFDS through the
directional coupler coupled paths. In the event of test failure, refer to the
following tables.

All tests fail

Table 6-25: RFDS Fault Isolation – All tests fail

Step Action

1 Check the calibration equipment for proper operation by manually setting the signal generator output
attenuator to the lowest output power setting and connecting the output port to the spectrum analyzer
rf input port.

2 Set the signal generator output attenuator to –90 dBm, and switch on the rf output. Verify that the
spectrum analyzer can receive the signal, indicate the correct signal strength, (accounting for the cable
insertion loss), and the approximate frequency.

3 Visually inspect RF cabling. Make sure each directional coupler forward and reflected port connects to
the RFDS antenna select unit on the RFDS.

4 Check the wiring against the site documentation wiring diagram or the BTS Site Installation manual.

5 Verify RGLI and TSU have been downloaded.

6 Check to see that all RFDS boards show green on the front panel indicators. Visually check  (both
board and backplane) for damage.

7 Replace any boards that do not show green with known good boards one at a time in the following
order. Re–test after each is replaced.

– RFDS ASU board.

– RFDS Transceiver board.

 

All RX and TX paths fail

If every receive or transmit path fails, the problem most likely lies with
the rf converter board or the transceiver board. Refer to the following
table for  fault isolation procedures.

Table 6-26: RFDS Fault Isolation – All RX and TX paths fail

Step Action

1 Visually check the master RF converter board (both board and backplane) for damage.

2 Replace the RF converter board with a known good RF converter board.

3 Visually check RXCVR TSU (both board and backplane) for damage.

4 Replace the TSU with a known good TSU.
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All tests fail on a single
antenna

If all path failures are on one antenna port, forward and/or reflected,
make the following checks.

Table 6-27: RFDS Fault Isolation – All tests fail on single antenna path

Step Action

1 Visually inspect the site interface cabinet internal cabling to the suspect directional coupler antenna
port.

2 Verify the forward and reflected ports connect to the correct RFDS antenna select unit positions on the
RFDS backplane. Refer to the installation manual for details.

3 Visually check ASU connectors (both board and backplane) for damage.

4 Replace the ASU with a known good ASU.

5 Replace the RF cables between the affected directional coupler and RFDS.

NOTE
Externally route the cable to bypass suspect segment.
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Module Status Indicators

Each of the non-passive plug-in modules has a bi-color (green & red)
LED status indicator located on the module front panel. The indicator is
labeled PWR/ALM. If both colors are turned on, the indicator is yellow.

Each plug-in module, except for the fan module, has its own alarm
(fault) detection circuitry that controls the state of the PWR/ALM LED.

The fan TACH signal of each fan module is monitored by the AMR.
Based on the status of this signal the AMR controls the state of the
PWR/ALM LED on the fan module.

LED Status Combinations for
All Modules (except GLI2,
CSM, BBX2, MCC24E, MCC8E)

PWR/ALM LED

The following list describes the states of the module status indicator.

� Solid GREEN –  module operating in a normal (fault free) condition.

� Solid RED – module is operating in a fault (alarm) condition due to
electrical hardware failure.

Note that a fault (alarm) indication may or may not be due to a complete
module failure and normal service may or may not be reduced or
interrupted.

DC/DC Converter LED Status
Combinations

The PWR CNVTR has its own alarm (fault) detection circuitry that
controls the state of the PWR/ALM LED.

PWR/ALM LED

The following list describes the states of the bi-color LED.

� Solid GREEN –  module operating in a normal (fault free) condition.

� Solid RED –  module is operating in a fault (alarm) condition due to
electrical hardware problem.
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CSM LED Status
Combinations

PWR/ALM LED

The CSMs include on-board alarm detection. Hardware and
software/firmware alarms are indicated via the front panel indicators.

After the memory tests, the CSM loads OOS–RAM code from the Flash
EPROM, if available. If not available, the OOS–ROM code is loaded
from the Flash EPROM.

� Solid GREEN – module is INS_ACT or INS_STBY no alarm.

� Solid RED – Initial power up or module is operating in a fault (alarm)
condition.

� Slowly Flashing GREEN – OOS_ROM no alarm.

� Long RED/Short GREEN – OOS_ROM alarm.

� Rapidly Flashing GREEN – OOS_RAM no alarm or 
INS_ACT in DUMB mode.

� Short RED/Short GREEN – OOS_RAM alarm.

� Long GREEN/Short RED – INS_ACT  or INS_STBY alarm.

� Off – no DC power  or on-board fuse is open.

� Solid YELLOW – After a reset, the CSMs begin to boot. During
SRAM test and Flash EPROM code check, the LED is yellow. (If
SRAM or Flash EPROM fail, the LED changes to a solid RED and
the CSM attempts to reboot.)

PWR/ALM
Indicator

FREQ
MONITOR

SYNC
MONITOR

FW00303

Figure 6-1: CSM Front Panel Indicators & Monitor Ports

 . . . continued on next page

6



Module Front Panel LED Indicators and Connectors – continued

Apr 2001 6-23SC�4812ET BTS Optimization/ATP — CDMA LMF
DRAFT

FREQ Monitor Connector

A test port provided at the CSM front panel via a BNC receptacle allows
monitoring of the 19.6608 MHz clock generated by the CSM. When
both CSM 1 and CSM 2 are in an in-service (INS) condition, the CSM 2
clock signal frequency is the same as that output by CSM 1.

The clock is a sine wave signal with a minimum amplitude of +2 dBm
(800 mVpp) into a 50 Ω load connected to this port.

SYNC Monitor Connector

A test port provided at the CSM front panel via a BNC receptacle allows
monitoring of the “Even Second Tick” reference signal generated by the
CSMs.

At this port, the reference signal is a TTL active high signal with a pulse
width of 153 nanoseconds.

MMI Connector – Only accessible behind front panel. The RS–232
MMI port connector is intended to be used primarily in the development
or factory environment, but may be used in the field for
debug/maintenance purposes.
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GLI2 LED Status
Combinations

The GLI2 module has indicators, controls and connectors as described
below and shown in Figure 6-2.

The indicators and controls consist of:

� Four LEDs

� One pushbutton

ACTIVE LED
Solid GREEN – GLI2 is active. This means that the GLI2 has shelf
control and is providing control of the digital interfaces.

Off – GLI2 is not active (i.e., Standby). The mate GLI2 should be
active.

MASTER LED

� Solid GREEN – GLI2 is Master (sometimes referred to as MGLI2).

� Off – GLI2 is non-master (i.e., Slave).

ALARM LED

� Solid RED – GLI2 is in a fault condition or in reset.

� While in reset transition,  STATUS LED is OFF while GLI2 is
performing ROM boot (about 12 seconds for normal boot).

� While in reset transition,  STATUS LED is ON while GLI2 is
performing RAM boot (about 4 seconds for normal boot).

� Off – No Alarm.

STATUS LED

� Flashing GREEN– GLI2 is in service (INS), in a stable operating
condition.

� On – GLI2 is in OOS RAM state operating downloaded code.

� Off – GLI2 is in OOS ROM state operating boot code.

SPANS LED

� Solid GREEN – Span line is connected and operating.

� Solid RED – Span line is disconnected or a fault condition exists.
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GLI2 Pushbuttons and
Connectors

RESET Pushbutton – Depressing the RESET pushbutton causes a
partial reset of the CPU and a reset of all board devices. GLI2 will be
placed in the OOS_ROM state

MMI Connector – The RS–232MMI port connector is intended to be
used primarily in the development or factory environment but may be
used in the field for debug/maintenance purposes.

MMI PORT
CONNECTOR

ACTIVE LED

S
TAT

U
S

R
E

S
E

T
A

LA
R

M
S

P
A

N
S

M
A

S
T

E
R

M
M

I
A

C
T

IV
E

STATUS LED

RESET
PUSHBUTTON

ALARM LED

SPANS LED

MASTER LED

Figure 6-2: GLI2 Front Panel Operating Indicators
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BBX2 LED Status
Combinations

PWR/ALM LED

The BBX module has its own alarm (fault) detection circuitry that
controls the state of the PWR/ALM LED.

The following list describes the states of the bi-color LED:

� Solid GREEN – INS_ACT no alarm

� Solid RED Red – initializing or power-up alarm

� Slowly Flashing GREEN – OOS_ROM no alarm

� Long RED/Short GREEN – OOS_ROM alarm

� Rapidly Flashing GREEN – OOS_RAM no alarm

� Short RED/Short GREEN – OOS_RAM alarm

� Long GREEN/Short RED – INS_ACT  alarm

MCC24/MCC8E LED Status
Combinations

The MCC24/MCC8E module has LED indicators and connectors as
described below. See Figure 6-3. Note that the figure does not show the
connectors as they are concealed by the removable lens.

The LED indicators and their states are as follows:

PWR/ALM LED

� RED – fault on module

ACTIVE LED

� Off – module is inactive, off-line, or not processing traffic.

� Slowly Flashing GREEN – OOS_ROM no alarm.

� Rapidly Flashing Green – OOS_RAM no alarm.

� Solid GREEN – module is INS_ACT, on-line, processing traffic.

PWR/ALM and ACTIVE LEDs

� Solid RED – module is powered but is in reset or the BCP is inactive.

MMI Connectors

� The RS–232 MMI port connector (four-pin) is intended to be used
primarily in the development or factory environment but may be used
in the field for debugging purposes.

� The RJ–11 ethernet port connector (eight-pin) is intended to be used
primarily in the development environment but may be used in the field
for high data rate debugging purposes.

 . . . continued on next page
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PWR/ALM LED

LENS
(REMOVABLE)

ACTIVE LED

P
W

R
/A

LM
A
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E

Figure 6-3: MCC24/8E Front Panel LEDs and LED Indicators
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LPA Shelf LED Status
Combinations

LPA Module LED

Each LPA module contains a bi–color LED just above the MMI
connector on the ETIB module. Interpret this LED as follows:

� GREEN — LPA module is active and is reporting no alarms (Normal
condition).

� Flashing GREEN/RED — LPA module is active but is reporting an
low input power condition. If no BBX is keyed, this is normal and
does not constitute a failure.

� Flashing RED — LPA is in alarm.
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Span Problems
(No Control Link)

Table 6-28: Troubleshooting Control Link Failure

� Step Action

1 Verify the span settings using the span_view  command
on the active master GLI2 MMI port. If these are set
correctly, verify the edlc parameters using the show
command. Any alarms conditions indicate that the span is
not operating correctly.

– Try looping back the span line from the DSX panel
back to the Mobility Manager (MM) and verify that
the looped signal is good.

– Listen for control tone on appropriate timeslot from
Base Site and MM.
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Verification of Test Equipment
Used

Table A-1: Verification of Test Equipment Used

Manufacturer Model Serial Number

Comments:________________________________________________________

__________________________________________________________________
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Site Checklist

Table A-2: Site Checklist

OK Parameter Specification Comments

� Deliveries Per established procedures

� Floor Plan Verified

�

�

�

Inter Frame Cables:

Ethernet

Frame Ground

Power

Per procedure

Per procedure

Per procedure

�

�

�

Factory Data:

BBX2

Test Panel

RFDS

Per procedure

Per procedure

Per procedure

� Site Temperature

� Dress Covers/Brackets

Preliminary Operations

Table A-3: Preliminary Operations

OK Parameter Specification Comments

� Shelf ID Dip Switches Per site equipage

� Ethernet LAN verification Verified per procedure

Comments:_________________________________________________________
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Pre–Power and Initial Power
Tests

Table A3a: Pre–power Checklist

OK Parameter Specification Comments

� Pre–power–up tests Verify power supply
output voltage at the top
of each BTS frame is
within specifications

�

�

�

�

�

�

�

�

Internal Cables:

ISB (all cages)

CSM (all cages)

Power (all cages)

Ethernet Connectors

LAN A ohms

LAN B ohms

LAN A shield

LAN B shield

Ethernet Boots

verified

verified

verified

verified

verified

isolated

isolated

installed

� Air Impedance Cage (single cage) installed

� Initial power–up tests Verify power supply
output voltage at the top
of each BTS frame is
within specifications:

Comments:_________________________________________________________
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General Optimization
Checklist

Table A3b: Pre–power Checklist

OK Parameter Specification Comments

�

�

LEDs

Frame fans

illuminated

operational

�

�

�

�

LMF to BTS Connection

Preparing the LMF

Log into the LMF PC

Create site specific BTS directory

Download device loads

per procedure

per procedure

per procedure

per procedure

�

�

Ping LAN A

Ping LAN B

per procedure

per procedure

�

�

�

�

�

�

�

�

�

Download/Enable MGLI2s

Download/Enable GLI2s

Set Site Span Configuration

Download CSMs

Enable CSMs

Enable CSMs

Download/Enable MCCs*

Download BBXs*

Download TSU  (in RFDS)

Program TSU NAM

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

� Test Set Calibration per procedure

*MCCs may be MCC8Es, MCC24s or MCC–1Xs. BBXs may be BBX2s or BBX1Xs

Comments:_________________________________________________________

A



Appendix A: Optimization (Pre–ATP) Data Sheets – continued

Apr 2001 A-5SC�4812ET BTS Optimization/ATP — CDMA LMF
DRAFT

GPS Receiver Operation

Table A-4: GPS Receiver Operation

OK Parameter Specification Comments

� GPS Receiver Control Task State:

tracking satellites

Verify parameter

� Initial Position Accuracy: Verify Estimated
or Surveyed

� Current Position:
lat
lon
height

RECORD in
msec and cm also
convert to deg
min sec

� Current Position: satellites tracked

Estimated:

(>4) satellites tracked,(>4) satellites visible

Surveyed:

(>1) satellite tracked,(>4) satellites visible

Verify parameter
as appropriate:

� GPS Receiver Status:Current Dilution of
Precision 
(PDOP or HDOP): (<30)

Verify parameter

� Current reference source:
Number: 0; Status: Good; Valid: Yes

Verify parameter

Comments:_________________________________________________________
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LFR Receiver Operation

Table A-5: LFR Receiver Operation

OK Parameter Specification Comments

� Station call letters M X Y Z
assignment.

as specified in site
documentation

� SN ratio is > 8 dB

� LFR Task State: 1fr

locked to station xxxx

Verify parameter

� Current reference source:

Number: 1; Status: Good; Valid: Yes

Verify parameter

Comments:_________________________________________________________
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LPA IM Reduction 

Table A-6: LPA IM Reduction

Parameter Comments

CARRIER
OK LPA

# 4:1 & 2:1
3–Sector

2:1
6–Sector

Dual BP
3–Sector

Dual BP
6–Sector

Specification

� 1A C1 C1 C1 C1 No Alarms

� 1B C1 C1 C1 C1 No Alarms

� 1C C1 C1 C1 C1 No Alarms

� 1D C1 C1 C1 C1 No Alarms

� 2A C2 C2 C2 No Alarms

� 2B C2 C2 C2 No Alarms

� 2C C2 C2 C2 No Alarms

� 2D C2 C2 C2 No Alarms

� 3A C3 C1 C1 No Alarms

� 3B C3 C1 C1 No Alarms

� 3C C3 C1 C1 No Alarms

� 3D C3 C1 C1 No Alarms

� 4A C4 C2 No Alarms

� 4B C4 C2 No Alarms

� 4C C4 C2 No Alarms

� 4D C4 C2 No Alarms

Comments:_________________________________________________________
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TX Bay Level Offset / Power
Output Verification for
3–Sector Configurations 

1–Carrier
2–Carrier Non–adjacent Channels
4–Carrier Non–adjacent Channels

Table A-7: TX BLO Calibration (3–Sector: 1–Carrier,  2–Carrier and 4–Carrier Non–adjacent Channels)

OK Parameter Specification Comments

�
BBX2–1, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
Calibrate
carrier 1

TX Bay Level Offset = 37 dB (+4 dB)
prior to calibration

BBX2–2, ANT–2 = dB

BBX2–r, ANT–2 = dB

�
BBX2–3, ANT–3 = dB

BBX2–r, ANT–3 = dB

�
BBX2–7, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
Calibrate
carrier 2

TX Bay Level Offset = 37 dB (+4 dB)
prior to calibration

BBX2–8, ANT–2 = dB

BBX2–r, ANT–2 = dB

�
BBX2–9, ANT–3 = dB

BBX2–r, ANT–3 = dB

�
BBX2–4, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
Calibrate
carrier 3

TX Bay Level Offset = 37 dB (+4 dB)
prior to calibration

BBX2–5, ANT–2 = dB

BBX2–r, ANT–2 = dB

�
BBX2–6, ANT–3 = dB

BBX2–r, ANT–3 = dB

�
BBX2–10, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
Calibrate
carrier 4

TX Bay Level Offset = 37 dB (+4 dB)
prior to calibration

BBX2–11, ANT–2 = dB

BBX2–r, ANT–2 = dB

�
BBX2–12, ANT–3 = dB

BBX2–r, ANT–3 = dB

. . . continued on next page
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Table A-7: TX BLO Calibration (3–Sector: 1–Carrier,  2–Carrier and 4–Carrier Non–adjacent Channels)

OK CommentsSpecificationParameter

�
BBX2–1, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX2–2, ANT–2 = dB

BBX2–r, ANT–2 = dB

�

carrier 1
BBX2–3, ANT–3 = dB

BBX2–r, ANT–3 = dB

�
BBX2–7, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX2–8, ANT–2 = dB

BBX2–r, ANT–2 = dB

�

carrier 2
BBX2–9, ANT–3 = dB

BBX2–r, ANT–3 = dB

�
BBX2–4, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
Calibration

Audit
carrier 3

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX2–5, ANT–2 = dB

BBX2–r, ANT–2 = dB

�

carrier 3
BBX2–6, ANT–3 = dB

BBX2–r, ANT–3 = dB

�
BBX2–10, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
Calibration

Audit
carrier 4

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX2–11, ANT–2 = dB

BBX2–r, ANT–2 = dB

�

carrier 4
BBX2–12, ANT–3 = dB

BBX2–r, ANT–3 = dB

 

Comments:________________________________________________________

__________________________________________________________________
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2–Carrier Adjacent Channel

Table A-8: TX Bay Level Offset Calibration (3–Sector: 2–Carrier Adjacent Channels)

OK Parameter Specification Comments

�
BBX2–1, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
Calibrate
carrier 1

TX Bay Level Offset = 42 dB (typical),
38 dB (minimum) prior to calibration

BBX2–2, ANT–2 = dB

BBX2–r, ANT–2 = dB

�
BBX2–3, ANT–3 = dB

BBX2–r, ANT–3 = dB

�
BBX2–7, ANT–4 = dB

BBX2–r, ANT–4 = dB

�
Calibrate
carrier 2

TX Bay Level Offset = 42 dB (typical),
38 dB (minimum) prior to calibration

BBX2–8, ANT–5 = dB

BBX2–r, ANT–5 = dB

�
BBX2–9, ANT–6 = dB

BBX2–r, ANT–6 = dB

�
BBX2–1, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX2–2, ANT–2 = dB

BBX2–r, ANT–2 = dB

�

carrier 1
BBX2–3, ANT–3 = dB

BBX2–r, ANT–3 = dB

�
BBX2–7, ANT–4 = dB

BBX2–r, ANT–4 = dB

�
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX2–8, ANT–5 = dB

BBX2–r, ANT–5 = dB

�

carrier 2
BBX2–9, ANT–6 = dB

BBX2–r, ANT–6 = dB

 

Comments:________________________________________________________

__________________________________________________________________
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3–Carrier Adjacent Channels
4–Carrier Adjacent Channels

Table A-9: TX Bay Level Offset Calibration (3–Sector: 3 or 4–Carrier Adjacent Channels)

OK Parameter Specification Comments

�
BBX2–1, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
Calibrate
carrier 1

TX Bay Level Offset = 37 dB before
calibration

BBX2–2, ANT–2 = dB

BBX2–r, ANT–2 = dB

�
BBX2–3, ANT–3 = dB

BBX2–r, ANT–3 = dB

�
BBX2–7, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
Calibrate
carrier 2

TX Bay Level Offset =37 dB before
calibration

BBX2–8, ANT–2 = dB

BBX2–r, ANT–2 = dB

�
BBX2–9, ANT–3 = dB

BBX2–r, ANT–3 = dB

�
BBX2–4, ANT–4 = dB

BBX2–r, ANT–4 = dB

�
Calibrate
carrier 3

TX Bay Level Offset = 37 dB before
calibration

BBX2–5, ANT–5 = dB

BBX2–r, ANT–5 = dB

�
BBX2–6, ANT–6 = dB

BBX2–r, ANT–6 = dB

�
BBX2–10, ANT–4 = dB

BBX2–3, ANT–4 = dB

�
Calibrate
carrier 4

TX Bay Level Offset = 37 dB before
calibration

BBX2–11, ANT–5 = dB

BBX2–r, ANT–5 = dB

�
BBX2–12, ANT–6 = dB

BBX2–r, ANT–6 = dB

�
BBX2–1, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX2–2, ANT–2 = dB

BBX2–r, ANT–2 = dB

�

carrier 1
BBX2–3, ANT–3 = dB

BBX2–r, ANT–3 = dB

. . . continued on next page
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Table A-9: TX Bay Level Offset Calibration (3–Sector: 3 or 4–Carrier Adjacent Channels)

OK CommentsSpecificationParameter

�
BBX2–7, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX2–8, ANT–2 = dB

BBX2–r, ANT–2 = dB

�

carrier 2
BBX2–9, ANT–3 = dB

BBX2–r, ANT–3 = dB

�
BBX2–4, ANT–4 = dB

BBX2–r, ANT–4 = dB

�
Calibration

Audit
carrier 3

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX2–5, ANT–5 = dB

BBX2–r, ANT–5 = dB

�

carrier 3
BBX2–6, ANT–6 = dB

BBX2–r, ANT–6 = dB

�
BBX2–10, ANT–4 = dB

BBX2–r, ANT–4 = dB

�
Calibration

Audit
carrier 4

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX2–11, ANT–5 = dB

BBX2–r, ANT–5 = dB

�

carrier 4
BBX2–12, ANT–6 = dB

BBX2–r, ANT–6 = dB

 

Comments:________________________________________________________

__________________________________________________________________
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TX Bay Level Offset / Power
Output Verification for
6–Sector Configurations 

1–Carrier
2–Carrier Non–adjacent Channels

Table A-10: TX BLO Calibration (6–Sector: 1–Carrier, 2–Carrier Non–adjacent Channels)

OK Parameter Specification Comments

�
BBX2–1, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
BBX2–2, ANT–2 = dB

BBX2–r, ANT–2 = dB

�
Calibrate TX Bay Level Offset = 42 dB (typical),

BBX2–3, ANT–3 = dB

BBX2–r, ANT–3 = dB

�

carrier 1 38 dB (minimum) prior to calibration BBX2–4, ANT–4 = dB

BBX2–r, ANT–4 = dB

�
BBX2–5, ANT–5 = dB

BBX2–r, ANT–5 = dB

�
BBX2–6, ANT–6 = dB

BBX2–r, ANT–6 = dB

�
BBX2–7, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
BBX2–8, ANT–2 = dB

BBX2–r, ANT–2 = dB

�
Calibrate TX Bay Level Offset = 42 dB (typical),

BBX2–9, ANT–3 = dB

BBX2–r, ANT–3 = dB

�

carrier 2 38 dB (minimum) prior to calibration BBX2–10, ANT–4 = dB

BBX2–3, ANT–4 = dB

�
BBX2–11, ANT–5 = dB

BBX2–r, ANT–5 = dB

�
BBX2–12, ANT–6 = dB

BBX2–r, ANT–5 = dB

. . . continued on next page
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Table A-10: TX BLO Calibration (6–Sector: 1–Carrier, 2–Carrier Non–adjacent Channels)

OK CommentsSpecificationParameter

�
BBX2–1, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
BBX2–2, ANT–2 = dB

BBX2–r, ANT–2 = dB

� Calibration 0 dB (+0.5 dB) for gain set resolution

BBX2–3, ANT–3 = dB

BBX2–r, ANT–3 = dB

�

Audit
carrier 1

post calibration BBX2–4, ANT–4 = dB

BBX2–r, ANT–4 = dB

�
BBX2–5, ANT–5 = dB

BBX2–r, ANT–5 = dB

�
BBX2–6, ANT–6 = dB

BBX2–r, ANT–6 = dB

�
BBX2–7, ANT–1 = dB

BBX2–r, ANT–1 = dB

�
BBX2–8, ANT–2 = dB

BBX2–r, ANT–2 = dB

� Calibration 0 dB (+0.5 dB) for gain set resolution

BBX2–9, ANT–3 = dB

BBX2–r, ANT–3 = dB

�

Audit
carrier 2

post calibration BBX2–10, ANT–4 = dB

BBX2–r, ANT–4 = dB

�
BBX2–11, ANT–5 = dB

BBX2–r, ANT–5 = dB

�
BBX2–12, ANT–6 = dB

BBX2–r, ANT–6 = dB

 

Comments:________________________________________________________

__________________________________________________________________
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TX Antenna VSWR

Table A-11: TX Antenna VSWR

OK Parameter Specification Data

�
VSWR – 
Antenna 1

   < (1.5 : 1)

�
VSWR –
Antenna 2

   < (1.5 : 1)

�
VSWR –
Antenna 3

   < (1.5 : 1)

�
VSWR –
Antenna 4

   < (1.5 : 1)

�
VSWR –
Antenna 5

   < (1.5 : 1)

�
VSWR –
Antenna 6

   < (1.5 : 1)

Comments:________________________________________________________

__________________________________________________________________

A



Appendix A: Optimization (Pre–ATP) Data Sheets – continued

DRAFT
SC�4812ET BTS Optimization/ATP — CDMA LMF Apr 2001A-16

RX Antenna VSWR

Table A-12: RX Antenna VSWR

OK Parameter Specification Data

�
VSWR – 
Antenna 1

   < (1.5 : 1)

�
VSWR –
Antenna 2

   < (1.5 : 1)

�
VSWR –
Antenna 3

   < (1.5 : 1)

�
VSWR –
Antenna 4

   < (1.5 : 1)

�
VSWR –
Antenna 5

   < (1.5 : 1)

�
VSWR –
Antenna 6

   < (1.5 : 1)

Comments:_________________________________________________________

Alarm Verification

Table A-13: CDI Alarm Input Verification

OK Parameter Specification Data

�

Verify CDI alarm input
operation per Table 3-1.

BTS Relay #XX –
Contact Alarm
Sets/Clears

Comments:_________________________________________________________
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Date Site

C–CCP Shelf

Site I/O A & B
C–CCP Shelf
CSM–1

CSM–2
HSO

CCD–1

CCD–2

AMR–1

AMR–2

MPC–1

MPC–2

Fans 1–3 

GLI2–1

GLI2–2

BBX2–1

BBX2–2

BBX2–3

BBX2–4
BBX2–5

BBX2–6

BBX2–7

BBX2–8

BBX2–9

BBX2–10

BBX2–11

BBX2–12

BBX2–r

MCC24/MCC8E–1

MCC24/MCC8E–2

MCC24/MCC8E–3

MCC24/MCC8E–4

MCC24/MCC8E–5
MCC24/MCC8E–6

MCC24/MCC8E–7

MCC24/MCC8E–8

MCC24/MCC8E–9

MCC24/MCC8E–10

MCC24/MCC8E–11

A
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MCC24/MCC8E–12

CIO

SWITCH

PS–1
PS–2

PS–3

LPAs

LPA 1A

LPA 1B

LPA 1C

LPA 1D

LPA 2A

LPA 2B

LPA 2C

LPA 2D

LPA 3A

LPA 3B

LPA 3C

LPA 3D

LPA 4A

LPA 4B

LPA 4C

LPA 4D

A



Apr 2001 SC�4812ET BTS Optimization/ATP — CDMA LMF
DRAFT

Appendix B: FRU Optimization/ATP Test Matrix

 Appendix Content

Appendix B: FRU Optimization/ATP Test Matrix B-1. . . . . . . . . . . . . . . . . . . . . . . 

Usage & Background B-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Detailed Optimization/ATP Test Matrix B-2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

B



Table of Contents  – continued

DRAFT
SC�4812ET BTS Optimization/ATP — CDMA LMF Apr 2001

Notes

B



Appendix B: FRU Optimization/ATP Test Matrix

Apr 2001 B-1SC�4812ET BTS Optimization/ATP — CDMA LMF
DRAFT

Usage & Background

Periodic maintenance of a site may also may mandate re–optimization of
specific portions of the site. An outline of some basic guidelines is
included in the following tables.

Re–optimization steps listed for any assembly detailed in
the tables below must be performed anytime a RF cable
associated with it is replaced.

IMPORTANT

*

BTS Frame

Table B-1: When RF Optimization Is required on the BTS

Item Replaced Optimize:

C–CCP Shelf All sector TX and RX paths to all
Combined CDMA Channel Processor
(C–CCP) shelves.

Multicoupler/
Preselector Card

The three or six affected sector RX paths for
the C–CCP shelf in the BTS frames.

Preselector I/O All sector RX paths.

BBX2 board RX and TX paths of the affected C–CCP
shelf / BBX2 board.

CIO Card All RX and TX paths of the affected
CDMA carrier.

Any LPA Module The affected sector TX path.

LPA Backplane The affected sector TX path.

LPA Filter The affected sector TX path.

Ancillary Frame 

Item Replaced Optimize:

Directional Coupler All affected sector RX and TX paths to all
BTS frame shelves.

Site filter All affected RX sector paths in all shelves
in all BTS frames.

Any RFDS component
or TSU.

The RFDS calibration RX & TX paths
(MONFWD/GENFWD).

 . . . continued on next page
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Inter-frame Cabling

Optimization must be performed after the replacement of any RF cabling
between BTS frames.

Table B-2: When to Optimize Inter–frame Cabling

Item Replaced Optimize:

Ancillary frame to BTS
frame (RX) cables

The affected sector/antenna RX
paths.

BTS frame to ancillary frame
(TX) cables

The affected sector/antenna TX paths.

Detailed Optimization/ATP
Test Matrix

Table B-3 outlines in more detail the tests that would need to be
performed if one of the BTS components were to fail and be replaced. It
is also assumed that all modules are placed OOS–ROM via the LMF
until full redundancy of all applicable modules is implemented.

The following guidelines should also be noted when using this table.

Not every procedure required to bring the site back on line
is indicated in Table B-3. It is meant to be used as a
guideline ONLY. The table assumes that the user is familiar
enough with the BTS Optimization/ATP procedure to
understand which test equipment set ups, calibrations, and
BTS site preparation will be required before performing the
Table # procedures referenced.

IMPORTANT

*

Various passive BTS components (such as the TX and RX directional
couplers, Preselector IO, CIO; etc.) only call for a TX or RX calibration
audit to be performed in lieu of a full path calibration. If the RX or TX
path calibration audit fails, the entire RF path calibration will need to be
repeated. If the RF path calibration fails, further troubleshooting is
warranted.

Whenever any C–CCP BACKPLANE is replaced, it is assumed that
only power to the C–CCP shelf being replaced is turned off via the
breaker supplying that shelf.

Whenever any DISTRIBUTION BACKPLANE is replaced it is assumed
that the power to the entire RFM frame is removed and the Preselector
I/O is replaced. The modem frame should be brought up as if it were a
new installation.

B
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If any significant change in signal level results from any
component being replaced in the RX or TX signal flow
paths, it would be identified by re–running the RX and TX
calibration audit command.

NOTE

When the CIO is replaced, the C–CCP shelf remains powered up. The
BBX2 boards may need to be removed, then re–installed into their
original slots, and re–downloaded (code and BLO data). RX and TX
calibration audits should then be performed.
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Table B-3: SC 4812ET BTS Optimization and ATP Test Matrix
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Table 2-1

Initial Boards/Modules
Install, Preliminary
Operations, CDF Site
Equipage; etc.

� � � � � � � � � � � � � � � � � � � � �

Table 2-5 Initial Power-up � �

Table 3-6/

Table 3-8
Start LMF � � � � � �

Table 3-13/
Table 3-14

Download Code � �

Table 3-16 Enable  CSMs � �

Table 3-19 GPS Initialization /
Verification

� � �

Table 3-20 LFR  Initialization /
Verification

� �

Table 3-33 TX Path Calibration � � �

Table 3-34 Download Offsets to BBX2 � � �

Table 3-35 TX Path Calibration Audit � � � � � � � � � � �

Table 4–1 Spectral Purity TX Mask � � � � � � � �

Table 4–1 Waveform Quality (rho) � � � � � � � � � �

Table 4–1 Pilot Time Offset � � � � � � � � � �

Table 4–1 Code Domain Power /
Noise Floor

� � �

Table 4–1 FER Test � � � � �

NOTE
Replace power converters one card at a time so that power to the C–CCP shelf is not lost. If power to the shelf
is lost, all cards in the shelf must be downloaded again.
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Usage & Background

Table C-1 outlines the relationship between the total of all code domain
channel element gain settings (digital root sum of the squares) and the
BBX2 Gain Set Point  between 33.0 dBm and 44.0 dBm. The resultant
RF output (as measured at the top of the BTS in dBm) is shown in the
table.  The table assumes that the BBX2 Bay Level Offset (BLO) values
have been calculated.

As an illustration, consider a  BBX2 keyed up to produce a CDMA
carrier with only the Pilot channel (no MCCs forward link enabled).
Pilot gain is set to 262. In this case, the BBX2 Gain Set Point is shown
to correlate exactly to the actual RF output anywhere in the 33 to 44
dBm output range.  (This is the level used to calibrate the BTS).

Table C-1: BBX2 Gain Set Point vs. Actual BTS Output (in dBm)

dBm�

Gain	
44 43 42 41 40 39 38 37 36 35 34 33

541 – – – – – – – 43.3 42.3 41.3 40.3 39.3

533 – – – – – – – 43.2 42.2 41.2 40.2 39.2

525 – – – – – – – 43 42 41 40 39

517 – – – – – – – 42.9 41.9 40.9 39.9 38.9

509 – – – – – – – 42.8 41.8 40.8 39.8 38.8

501 – – – – – – – 42.6 41.6 40.6 39.6 38.6

493 – – – – – – 43.5 42.5 41.5 40.5 39.5 38.5

485 – – – – – – 43.4 42.4 41.4 40.4 39.4 38.4

477 – – – – – – 43.2 42.2 41.2 40.2 39.2 38.2

469 – – – – – – 43.1 42.1 41.1 40.1 39.1 38.1

461 – – – – – – 42.9 41.9 40.9 39.9 38.9 37.9

453 – – – – – – 42.8 41.8 40.8 39.8 38.8 37.8

445 – – – – – 43.6 42.6 41.6 40.6 39.6 38.6 37.6

437 – – – – – 43.4 42.4 41.4 40.4 39.4 38.4 37.4

429 – – – – – 43.3 42.3 41.3 40.3 39.3 38.3 37.3

421 – – – – – 43.1 42.1 41.1 40.1 39.1 38.1 37.1

413 – – – – – 43 42 41 40 39 38 37

405 – – – – – 42.8 41.8 40.8 39.8 38.8 37.8 36.8

397 – – – – 43.6 42.6 41.6 40.6 39.6 38.6 37.6 36.6

389 – – – – 43.4 42.4 41.4 40.4 39.4 38.4 37.4 36.4

 . . . continued on next page
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Table C-1: BBX2 Gain Set Point vs. Actual BTS Output (in dBm)

dBm�

Gain	
333435363738394041424344

381 – – – – 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3

374 – – – – 43.1 42.1 41.1 40.1 39.1 38.1 37.1 36.1

366 – – – – 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9

358 – – – – 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7

350 – – – 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5

342 – – – 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3 35.3

334 – – – 43.1 42.1 41.1 40.1 39.1 38.1 37.1 36.1 35.1

326 – – – 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9 34.9

318 – – – 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7 34.7

310 – – 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5 34.5

302 – – 43.2 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2

294 – – 43 42 41 40 39 38 37 36 35 34

286 – – 42.8 41.8 40.8 39.8 38.8 37.8 36.8 35.8 34.8 33.8

278 – 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5 34.5 33.5

270 – 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3 35.3 34.3 33.3

262 – 43 42 41 40 39 38 37 36 35 34 33

254 – 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7 34.7 33.7 32.7

246 43.4 42.4 41.4 40.4 39.4 38.4 37.4 36.4 35.4 34.4 33.4 32.4

238 43.2 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2 33.2 32.2

230 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9 34.9 33.9 32.9 31.9

222 42.6 41.6 40.6 39.6 38.6 37.6 36.6 35.6 34.6 33.6 32.6 31.6

214 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2 33.2 32.2 31.2
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CDMA Operating Frequency Programming Information – North American
PCS Bands

Apr 2001 D-1SC�4812ET BTS Optimization/ATP — CDMA LMFDRAFT

Introduction

Programming of each of the BTS BBX2 synthesizers is performed by the
BTS GLIs via the CHI bus. This programming data determines the
transmit and receive transceiver operating frequencies (channels) for
each BBX2.

1900 MHz PCS Channels

Figure D-1 shows the valid channels for the North American PCS
1900 MHz frequency spectrum. There are 10 CDMA wireline or
non–wireline band channels used in a CDMA system (unique per
customer operating system).
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Figure D-1: North America PCS Frequency Spectrum (CDMA Allocation) D
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Calculating 1900 MHz Center
Frequencies

Table D-1 shows selected 1900 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

� TX = 1930 + 0.05 * Channel#
Example: Channel 262
TX = 1930 + 0.05*262 = 1943.10 MHz

� RX = TX – 80
Example: Channel 262
RX = 1943.10 – 50 = 1863.10 MHz

Actual frequencies used depend on customer CDMA system frequency
plan.

Each CDMA channel requires a 1.77 MHz frequency segment. The
actual CDMA carrier is 1.23 MHz wide, with a 0.27 MHz guard band on
both sides of the carrier.

Minimum frequency separation required between any CDMA carrier and
the nearest NAMPS/AMPS carrier is 900 kHz (center-to-center).

Table D-1: 1900 MHz TX and RX Frequency vs. Channel
Channel Number
Decimal       Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

25 0019 1931.25 1851.25
50 0032 1932.50 1852.50
75 004B 1933.75 1853.75
100 0064 1935.00 1855.00
125 007D 1936.25 1856.25
150 0096 1937.50 1857.50
175 00AF 1938.75 1858.75
200 00C8 1940.00 1860.00
225 00E1 1941.25 1861.25
250 00FA 1942.50 1862.50
275 0113 1943.75 1863.75
300 012C 1945.00 1865.00
325 0145 1946.25 1866.25
350 015E 1947.50 1867.50
375 0177 1948.75 1868.75
400 0190 1950.00 1870.00
425 01A9 1951.25 1871.25
450 01C2 1952.50 1872.50
475 01DB 1953.75 1873.75
500 01F4 1955.00 1875.00
525 020D 1956.25 1876.25
550 0226 1957.50 1877.50
575 023F 1958.75 1878.75

. . . continued on next page
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Table D-1: 1900 MHz TX and RX Frequency vs. Channel
Channel Number
Decimal       Hex

Receive Frequency (MHz)
Center Frequency

Transmit Frequency (MHz)
Center Frequency

600 0258 1960.00 1880.00
625 0271 1961.25 1881.25
650 028A 1962.50 1882.50
675 02A3 1963.75 1883.75
700 02BC 1965.00 1885.00
725 02D5 1966.25 1886.25
750 02EE 1967.50 1887.50
775 0307 1968.75 1888.75
800 0320 1970.00 1890.00
825 0339 1971.25 1891.25
850 0352 1972.50 1892.50
875 036B 1973.75 1893.75
900 0384 1975.00 1895.00
925 039D 1976.25 1896.25
950 03B6 1977.50 1897.50
975 03CF 1978.75 1898.75

1000 03E8 1980.00 1900.00
1025 0401 1981.25 1901.25
1050 041A 1982.50 1902.50
1075 0433 1983.75 1903.75
1100 044C 1985.00 1905.00
1125 0465 1986.25 1906.25
1150 047E 1987.50 1807.50
1175 0497 1988.75 1908.75
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800 MHz CDMA Channels

Figure D-2 shows the valid channels for the North American cellular
telephone frequency spectrum. There are 10 CDMA wireline or
non–wireline band channels used in a CDMA system (unique per
customer operating system).

Figure D-2: North American Cellular Telephone System Frequency Spectrum (CDMA Allocation).
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Calculating 800 MHz Center
Frequencies

Table D-2 shows selected 800 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

� Channels 1–777
TX = 870 + 0.03 * Channel#
Example: Channel 262
TX = 870 + 0.03*262 = 877.86 MHz

� Channels 1013–1023
TX = 870 + 0.03 * (Channel# – 1023)
Example: Channel 1015
TX = 870 +0.03 *(1015 – 1023) = 869.76 MHz

� RX = TX – 45 MHz
Example: Channel 262
RX = 877.86 –45 = 832.86 MHz

Table D-2: 800 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal   Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

1 0001 870.0300 825.0300

25 0019 870.7500 825.7500
. . . continued on next page
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Table D-2: 800 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal   Hex

Receive Frequency (MHz)
Center Frequency

Transmit Frequency (MHz)
Center Frequency

50 0032 871.5000 826.5000

75 004B 872.2500 827.2500

100 0064 873.0000 828.0000

125 007D 873.7500 828.7500

150 0096 874.5000 829.5000

175 00AF 875.2500 830.2500

200 00C8 876.0000 831.0000

225 00E1 876.7500 831.7500

250 00FA 877.5000 832.5000

275 0113 878.2500 833.2500

300 012C 879.0000 834.0000

325 0145 879.7500 834.7500

350 015E 880.5000 835.5000

375 0177 881.2500 836.2500

400 0190 882.0000 837.0000

425 01A9 882.7500 837.7500

450 01C2 883.5000 838.5000

475 01DB 884.2500 839.2500

500 01F4 885.0000 840.0000

525 020D 885.7500 840.7500

550 0226 886.5000 841.5000

575 023F 887.2500 842.2500

600 0258 888.0000 843.0000

625 0271 888.7500 843.7500

650 028A 889.5000 844.5000

675 02A3 890.2500 845.2500

700 02BC 891.0000 846.0000

725 02D5 891.7500 846.7500

750 02EE 892.5000 847.5000

775 0307 893.2500 848.2500

NOTE
Channel numbers 778 through 1012 are not used.

1013 03F5 869.7000 824.7000

1023 03FF 870.0000 825.0000
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PN Offset Background

All channel elements transmitted from a BTS in a particular 1.25 MHz
CDMA channel are orthonogonally spread by 1 of 64 possible Walsh
code functions; additionally, they are also spread by a quadrature pair of
PN sequences unique to each sector.

Overall, the mobile uses this to differentiate multiple signals transmitted
from the same BTS (and surrounding BTS) sectors, and to synchronize
to the next strongest sector.

The PN offset per sector is stored on the BBX2s, where the
corresponding I & Q registers reside.

The PN offset values are determined on a per BTS/per sector(antenna)
basis as determined by the appropriate cdf file content. A breakdown of
this information is found in Table E-1.

PN Offset Usage 

There are three basic RF chip delays currently in use. It is important to
determine what RF chip delay is valid to be able to test the BTS
functionality.  This can be done by ascertaining  if the CDF file 
FineTxAdj  value was set to “on” when the MCC was downloaded with
“image data”. The FineTxAdj value is used to compensate for the
processing delay (approximately 20 �S) in the BTS using any type of
mobile meeting IS–97 specifications.

Observe the following guidelines:

� If the FineTxAdj value in the cdf file is 101 (65 HEX), the
FineTxAdj has not been set. The I and Q values from the 0 table
MUST be used.

If the FineTxAdj value in the cdf file is 213 (D5 HEX), FineTxAdj has
been set for the 14 chip table.

� If the FineTxAdj value in the cdf file is 197 (C5 HEX), FineTxAdj
has been set for the 13 chip table.

CDF file I and Q values can be represented in DECIMAL
or HEX. If using HEX, add 0x before the HEX value. If
necessary, convert HEX values in Table E-1 to decimal
before comparing them to cdf file I & Q value assignments.

IMPORTANT

*

 . . . continued on next page
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– If you are using a Qualcomm mobile, use the I and Q values from
the 13 chip delay table.

– If you are using a mobile that does not have the 1 chip offset
problem, (any mobile meeting the IS–97 specification), use the 14
chip delay table.

If the wrong  I and Q values are used with the wrong
FineTxAdj parameter, system timing problems will occur.
This will cause the energy transmitted to be “smeared”
over several Walsh codes (instead of the single Walsh code
that it was assigned to), causing erratic operation. Evidence
of smearing is usually identified by Walsh channels not at
correct levels or present when not selected in the Code
Domain Power Test.

IMPORTANT

*

 . . . continued on next page
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

0 17523 23459 4473 5BA3 29673 25581 73E9 63ED 4096 4096 1000 1000

1 32292 32589 7E24 7F4D 16146 29082 3F12 719A 9167 1571 23CF 0623
2 4700 17398 125C 43F6 2350 8699 092E 21FB 22417 7484 5791 1D3C

3 14406 26333 3846 66DD 7203 32082 1C23 7D52 966 6319 03C6 18AF
4 14899 4011 3A33 0FAB 19657 18921 4CC9 49E9 14189 2447 376D 098F

5 17025 2256 4281 08D0 28816 1128 7090 0468 29150 24441 71DE 5F79
6 14745 18651 3999 48DB 19740 27217 4D1C 6A51 18245 27351 4745 6AD7

7 2783 1094 0ADF 0446 21695 547 54BF 0223 1716 23613 06B4 5C3D
8 5832 21202 16C8 52D2 2916 10601 0B64 2969 11915 29008 2E8B 7150

9 12407 13841 3077 3611 18923 21812 49EB 5534 20981 5643 51F5 160B
10 31295 31767 7A3F 7C17 27855 28727 6CCF 7037 24694 28085 6076 6DB5

11 7581 18890 1D9D 49CA 24350 9445 5F1E 24E5 11865 18200 2E59 4718
12 18523 30999 485B 7917 30205 29367 75FD 72B7 6385 21138 18F1 5292

13 29920 22420 74E0 5794 14960 11210 3A70 2BCA 27896 21937 6CF8 55B1
14 25184 20168 6260 4EC8 12592 10084 3130 2764 25240 25222 6298 6286

15 26282 12354 66AA 3042 13141 6177 3355 1821 30877 109 789D 006D
16 30623 11187 779F 2BB3 27167 23525 6A1F 5BE5 30618 6028 779A 178C

17 15540 11834 3CB4 2E3A 7770 5917 1E5A 171D 26373 22034 6705 5612
18 23026 10395 59F2 289B 11513 23153 2CF9 5A71 314 15069 013A 3ADD

19 20019 28035 4E33 6D83 30409 30973 76C9 78FD 17518 4671 446E 123F
20 4050 27399 0FD2 6B07 2025 31679 07E9 7BBF 21927 30434 55A7 76E2

21 1557 22087 0615 5647 21210 25887 52DA 651F 2245 11615 08C5 2D5F
22 30262 2077 7636 081D 15131 18994 3B1B 4A32 18105 19838 46B9 4D7E

23 18000 13758 4650 35BE 9000 6879 2328 1ADF 8792 14713 2258 3979
24 20056 11778 4E58 2E02 10028 5889 272C 1701 21440 241 53C0 00F1

25 12143 3543 2F6F 0DD7 18023 18647 4667 48D7 15493 24083 3C85 5E13
26 17437 7184 441D 1C10 29662 3592 73DE 0E08 26677 7621 6835 1DC5

27 17438 2362 441E 093A 8719 1181 220F 049D 11299 19144 2C23 4AC8
28 5102 25840 13EE 64F0 2551 12920 09F7 3278 12081 1047 2F31 0417

29 9302 12177 2456 2F91 4651 23028 122B 59F4 23833 26152 5D19 6628
30 17154 10402 4302 28A2 8577 5201 2181 1451 20281 22402 4F39 5782

31 5198 1917 144E 077D 2599 19842 0A27 4D82 10676 21255 29B4 5307
32 4606 17708 11FE 452C 2303 8854 08FF 2296 16981 30179 4255 75E3

33 24804 10630 60E4 2986 12402 5315 3072 14C3 31964 7408 7CDC 1CF0
34 17180 6812 431C 1A9C 8590 3406 218E 0D4E 26913 115 6921 0073

35 10507 14350 290B 380E 17749 7175 4555 1C07 14080 1591 3700 0637
36 10157 10999 27AD 2AF7 16902 23367 4206 5B47 23842 1006 5D22 03EE

37 23850 25003 5D2A 61AB 11925 32489 2E95 7EE9 27197 32263 6A3D 7E07
38 31425 2652 7AC1 0A5C 27824 1326 6CB0 052E 22933 1332 5995 0534

39 4075 19898 0FEB 4DBA 22053 9949 5625 26DD 30220 12636 760C 315C
40 10030 2010 272E 07DA 5015 1005 1397 03ED 12443 4099 309B 1003

41 16984 25936 4258 6550 8492 12968 212C 32A8 19854 386 4D8E 0182
42 14225 28531 3791 6F73 18968 31109 4A18 7985 14842 29231 39FA 722F

43 26519 11952 6797 2EB0 25115 5976 621B 1758 15006 25711 3A9E 646F
44 27775 31947 6C7F 7CCB 26607 28761 67EF 7059 702 10913 02BE 2AA1

45 30100 25589 7594 63F5 15050 32710 3ACA 7FC6 21373 8132 537D 1FC4
46 7922 11345 1EF2 2C51 3961 22548 0F79 5814 23874 20844 5D42 516C

47 14199 28198 3777 6E26 19051 14099 4A6B 3713 3468 13150 0D8C 335E
48 17637 13947 44E5 367B 29602 21761 73A2 5501 31323 18184 7A5B 4708

49 23081 8462 5A29 210E 31940 4231 7CC4 1087 29266 19066 7252 4A7A
50 5099 9595 13EB 257B 22565 23681 5825 5C81 16554 29963 40AA 750B

. . . continued on next page
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Appendix E: PN Offset Programming Information – continued

DRAFT
SC�4812ET BTS Optimization/ATP — CDMA LMF Apr 2001E-4

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

51 32743 4670 7FE7 123E 28195 2335 6E23 091F 22575 6605 582F 19CD

52 7114 14672 1BCA 3950 3557 7336 0DE5 1CA8 31456 29417 7AE0 72E9
53 7699 29415 1E13 72E7 24281 30543 5ED9 774F 8148 22993 1FD4 59D1

54 19339 20610 4B8B 5082 29717 10305 7415 2841 19043 27657 4A63 6C09
55 28212 6479 6E34 194F 14106 17051 371A 429B 25438 5468 635E 155C

56 29587 10957 7393 2ACD 26649 23386 6819 5B5A 10938 8821 2ABA 2275
57 19715 18426 4D03 47FA 30545 9213 7751 23FD 2311 20773 0907 5125

58 14901 22726 3A35 58C6 19658 11363 4CCA 2C63 7392 4920 1CE0 1338
59 20160 5247 4EC0 147F 10080 17411 2760 4403 30714 5756 77FA 167C

60 22249 29953 56E9 7501 31396 29884 7AA4 74BC 180 28088 00B4 6DB8
61 26582 5796 67D6 16A4 13291 2898 33EB 0B52 8948 740 22F4 02E4

62 7153 16829 1BF1 41BD 23592 28386 5C28 6EE2 16432 23397 4030 5B65
63 15127 4528 3B17 11B0 19547 2264 4C5B 08D8 9622 19492 2596 4C24

64 15274 5415 3BAA 1527 7637 17583 1DD5 44AF 7524 26451 1D64 6753
65 23149 10294 5A6D 2836 31974 5147 7CE6 141B 1443 30666 05A3 77CA

66 16340 17046 3FD4 4296 8170 8523 1FEA 214B 1810 15088 0712 3AF0
67 27052 7846 69AC 1EA6 13526 3923 34D6 0F53 6941 26131 1B1D 6613

68 13519 10762 34CF 2A0A 19383 5381 4BB7 1505 3238 15969 0CA6 3E61
69 10620 13814 297C 35F6 5310 6907 14BE 1AFB 8141 24101 1FCD 5E25

70 15978 16854 3E6A 41D6 7989 8427 1F35 20EB 10408 12762 28A8 31DA
71 27966 795 6D3E 031B 13983 20401 369F 4FB1 18826 19997 498A 4E1D

72 12479 9774 30BF 262E 18831 4887 498F 1317 22705 22971 58B1 59BB
73 1536 24291 0600 5EE3 768 24909 0300 614D 3879 12560 0F27 3110

74 3199 3172 0C7F 0C64 22511 1586 57EF 0632 21359 31213 536F 79ED
75 4549 2229 11C5 08B5 22834 19046 5932 4A66 30853 18780 7885 495C

76 17888 21283 45E0 5323 8944 26541 22F0 67AD 18078 16353 469E 3FE1
77 13117 16905 333D 4209 18510 28472 484E 6F38 15910 12055 3E26 2F17

78 7506 7062 1D52 1B96 3753 3531 0EA9 0DCB 20989 30396 51FD 76BC
79 27626 7532 6BEA 1D6C 13813 3766 35F5 0EB6 28810 24388 708A 5F44

80 31109 25575 7985 63E7 27922 32719 6D12 7FCF 30759 1555 7827 0613
81 29755 14244 743B 37A4 27597 7122 6BCD 1BD2 18899 13316 49D3 3404

82 26711 28053 6857 6D95 26107 30966 65FB 78F6 7739 31073 1E3B 7961
83 20397 30408 4FAD 76C8 30214 15204 7606 3B64 6279 6187 1887 182B

84 18608 5094 48B0 13E6 9304 2547 2458 09F3 9968 21644 26F0 548C
85 7391 16222 1CDF 3F5E 24511 8111 5FBF 1FAF 8571 9289 217B 2449

86 23168 7159 5A80 1BF7 11584 17351 2D40 43C7 4143 4624 102F 1210
87 23466 174 5BAA 00AE 11733 87 2DD5 0057 19637 467 4CB5 01D3

88 15932 25530 3E3C 63BA 7966 12765 1F1E 31DD 11867 18133 2E5B 46D5
89 25798 2320 64C6 0910 12899 1160 3263 0488 7374 1532 1CCE 05FC

90 28134 23113 6DE6 5A49 14067 25368 36F3 6318 10423 1457 28B7 05B1
91 28024 23985 6D78 5DB1 14012 24804 36BC 60E4 9984 9197 2700 23ED

92 6335 2604 18BF 0A2C 23951 1302 5D8F 0516 7445 13451 1D15 348B
93 21508 1826 5404 0722 10754 913 2A02 0391 4133 25785 1025 64B9

94 26338 30853 66E2 7885 13169 29310 3371 727E 22646 4087 5876 0FF7
95 17186 15699 4322 3D53 8593 20629 2191 5095 15466 31190 3C6A 79D6

96 22462 2589 57BE 0A1D 11231 19250 2BDF 4B32 2164 8383 0874 20BF
97 3908 25000 0F44 61A8 1954 12500 07A2 30D4 16380 12995 3FFC 32C3

98 25390 18163 632E 46F3 12695 27973 3197 6D45 15008 27438 3AA0 6B2E
99 27891 12555 6CF3 310B 26537 22201 67A9 56B9 31755 9297 7C0B 2451

100 9620 8670 2594 21DE 4810 4335 12CA 10EF 31636 1676 7B94 068C
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Appendix E: PN Offset Programming Information – continued

Apr 2001 E-5SC�4812ET BTS Optimization/ATP — CDMA LMF
DRAFT

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

101 6491 1290 195B 050A 23933 645 5D7D 0285 25414 12596 6346 3134

102 16876 4407 41EC 1137 8438 18087 20F6 46A7 7102 19975 1BBE 4E07
103 17034 1163 428A 048B 8517 19577 2145 4C79 20516 20026 5024 4E3A

104 32405 12215 7E95 2FB7 28314 23015 6E9A 59E7 19495 8958 4C27 22FE
105 27417 7253 6B19 1C55 25692 16406 645C 4016 17182 19143 431E 4AC7

106 8382 8978 20BE 2312 4191 4489 105F 1189 11572 17142 2D34 42F6
107 5624 25547 15F8 63CB 2812 32729 0AFC 7FD9 25570 19670 63E2 4CD6

108 1424 3130 0590 0C3A 712 1565 02C8 061D 6322 30191 18B2 75EF
109 13034 31406 32EA 7AAE 6517 15703 1975 3D57 8009 5822 1F49 16BE

110 15682 6222 3D42 184E 7841 3111 1EA1 0C27 26708 22076 6854 563C
111 27101 20340 69DD 4F74 25918 10170 653E 27BA 6237 606 185D 025E

112 8521 25094 2149 6206 16756 12547 4174 3103 32520 9741 7F08 260D
113 30232 23380 7618 5B54 15116 11690 3B0C 2DAA 31627 9116 7B8B 239C

114 6429 10926 191D 2AAE 23902 5463 5D5E 1557 3532 12705 0DCC 31A1
115 27116 22821 69EC 5925 13558 25262 34F6 62AE 24090 17502 5E1A 445E

116 4238 31634 108E 7B92 2119 15817 0847 3DC9 20262 18952 4F26 4A08
117 5128 4403 1408 1133 2564 18085 0A04 46A5 18238 15502 473E 3C8E

118 14846 689 39FE 02B1 7423 20324 1CFF 4F64 2033 17819 07F1 459B
119 13024 27045 32E0 69A5 6512 31470 1970 7AEE 25566 4370 63DE 1112

120 10625 27557 2981 6BA5 17680 31726 4510 7BEE 25144 31955 6238 7CD3
121 31724 16307 7BEC 3FB3 15862 20965 3DF6 51E5 29679 30569 73EF 7769

122 13811 22338 35F3 5742 19241 11169 4B29 2BA1 5064 7350 13C8 1CB6
123 24915 27550 6153 6B9E 24953 13775 6179 35CF 27623 26356 6BE7 66F4

124 1213 22096 04BD 5650 21390 11048 538E 2B28 13000 32189 32C8 7DBD
125 2290 23136 08F2 5A60 1145 11568 0479 2D30 31373 1601 7A8D 0641

126 31551 12199 7B3F 2FA7 27727 23023 6C4F 59EF 13096 19537 3328 4C51
127 12088 1213 2F38 04BD 6044 19554 179C 4C62 26395 25667 671B 6443

128 7722 936 1E2A 03A8 3861 468 0F15 01D4 15487 4415 3C7F 113F
129 27312 6272 6AB0 1880 13656 3136 3558 0C40 29245 2303 723D 08FF

130 23130 32446 5A5A 7EBE 11565 16223 2D2D 3F5F 26729 16362 6869 3FEA
131 594 13555 0252 34F3 297 21573 0129 5445 12568 28620 3118 6FCC

132 25804 8789 64CC 2255 12902 24342 3266 5F16 24665 6736 6059 1A50
133 31013 24821 7925 60F5 27970 32326 6D42 7E46 8923 2777 22DB 0AD9

134 32585 21068 7F49 524C 28276 10534 6E74 2926 19634 24331 4CB2 5F0B
135 3077 31891 0C05 7C93 22482 28789 57D2 7075 29141 9042 71D5 2352

136 17231 5321 434F 14C9 28791 17496 7077 4458 73 107 0049 006B
137 31554 551 7B42 0227 15777 20271 3DA1 4F2F 26482 4779 6772 12AB

138 8764 12115 223C 2F53 4382 22933 111E 5995 6397 13065 18FD 3309
139 15375 4902 3C0F 1326 20439 2451 4FD7 0993 29818 30421 747A 76D5

140 13428 1991 3474 07C7 6714 19935 1A3A 4DDF 8153 20210 1FD9 4EF2
141 17658 14404 44FA 3844 8829 7202 227D 1C22 302 5651 012E 1613

142 13475 17982 34A3 463E 19329 8991 4B81 231F 28136 31017 6DE8 7929
143 22095 19566 564F 4C6E 31479 9783 7AF7 2637 29125 30719 71C5 77FF

144 24805 2970 60E5 0B9A 24994 1485 61A2 05CD 8625 23104 21B1 5A40
145 4307 23055 10D3 5A0F 22969 25403 59B9 633B 26671 7799 682F 1E77

146 23292 15158 5AFC 3B36 11646 7579 2D7E 1D9B 6424 17865 1918 45C9
147 1377 29094 0561 71A6 21344 14547 5360 38D3 12893 26951 325D 6947

148 28654 653 6FEE 028D 14327 20346 37F7 4F7A 18502 25073 4846 61F1
149 6350 19155 18CE 4AD3 3175 27477 0C67 6B55 7765 32381 1E55 7E7D

150 16770 23588 4182 5C24 8385 11794 20C1 2E12 25483 16581 638B 40C5

. . . continued on next page
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Appendix E: PN Offset Programming Information – continued

DRAFT
SC�4812ET BTS Optimization/ATP — CDMA LMF Apr 2001E-6

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

151 14726 10878 3986 2A7E 7363 5439 1CC3 153F 15408 32087 3C30 7D57

152 25685 31060 6455 7954 25594 15530 63FA 3CAA 6414 97 190E 0061
153 21356 30875 536C 789B 10678 29297 29B6 7271 8164 7618 1FE4 1DC2

154 12149 11496 2F75 2CE8 18026 5748 466A 1674 10347 93 286B 005D
155 28966 24545 7126 5FE1 14483 25036 3893 61CC 29369 16052 72B9 3EB4

156 22898 9586 5972 2572 11449 4793 2CB9 12B9 10389 14300 2895 37DC
157 1713 20984 06B1 51F8 21128 10492 5288 28FC 24783 11129 60CF 2B79

158 30010 30389 753A 76B5 15005 30054 3A9D 7566 18400 6602 47E0 19CA
159 2365 7298 093D 1C82 21838 3649 554E 0E41 22135 14460 5677 387C

160 27179 18934 6A2B 49F6 25797 9467 64C5 24FB 4625 25458 1211 6372
161 29740 23137 742C 5A61 14870 25356 3A16 630C 22346 15869 574A 3DFD

162 5665 24597 1621 6015 23232 32310 5AC0 7E36 2545 27047 09F1 69A7
163 23671 23301 5C77 5B05 32747 25534 7FEB 63BE 7786 26808 1E6A 68B8

164 1680 7764 0690 1E54 840 3882 0348 0F2A 20209 7354 4EF1 1CBA
165 25861 14518 6505 38B6 25426 7259 6352 1C5B 26414 27834 672E 6CBA

166 25712 21634 6470 5482 12856 10817 3238 2A41 1478 11250 05C6 2BF2
167 19245 11546 4B2D 2D1A 29766 5773 7446 168D 15122 552 3B12 0228

168 26887 26454 6907 6756 25939 13227 6553 33AB 24603 27058 601B 69B2
169 30897 15938 78B1 3E42 28040 7969 6D88 1F21 677 14808 02A5 39D8

170 11496 9050 2CE8 235A 5748 4525 1674 11AD 13705 9642 3589 25AA
171 1278 3103 04FE 0C1F 639 18483 027F 4833 13273 32253 33D9 7DFD

172 31555 758 7B43 02F6 27761 379 6C71 017B 14879 26081 3A1F 65E1
173 29171 16528 71F3 4090 26921 8264 6929 2048 6643 21184 19F3 52C0

174 20472 20375 4FF8 4F97 10236 27127 27FC 69F7 23138 11748 5A62 2DE4
175 5816 10208 16B8 27E0 2908 5104 0B5C 13F0 28838 32676 70A6 7FA4

176 30270 17698 763E 4522 15135 8849 3B1F 2291 9045 2425 2355 0979
177 22188 8405 56AC 20D5 11094 24150 2B56 5E56 10792 19455 2A28 4BFF

178 6182 28634 1826 6FDA 3091 14317 0C13 37ED 25666 19889 6442 4DB1
179 32333 1951 7E4D 079F 28406 19955 6EF6 4DF3 11546 18177 2D1A 4701

180 14046 20344 36DE 4F78 7023 10172 1B6F 27BC 15535 2492 3CAF 09BC
181 15873 26696 3E01 6848 20176 13348 4ED0 3424 16134 15086 3F06 3AEE

182 19843 3355 4D83 0D1B 30481 18609 7711 48B1 8360 30632 20A8 77A8
183 29367 11975 72B7 2EC7 26763 22879 688B 595F 14401 27549 3841 6B9D

184 13352 31942 3428 7CC6 6676 15971 1A14 3E63 26045 6911 65BD 1AFF
185 22977 9737 59C1 2609 32048 23864 7D30 5D38 24070 9937 5E06 26D1

186 31691 9638 7BCB 25A6 27701 4819 6C35 12D3 30300 2467 765C 09A3
187 10637 30643 298D 77B3 17686 30181 4516 75E5 13602 25831 3522 64E7

188 25454 13230 636E 33AE 12727 6615 31B7 19D7 32679 32236 7FA7 7DEC
189 18610 22185 48B2 56A9 9305 25960 2459 6568 16267 12987 3F8B 32BB

190 6368 2055 18E0 0807 3184 19007 0C70 4A3F 9063 11714 2367 2DC2
191 7887 8767 1ECF 223F 24247 24355 5EB7 5F23 19487 19283 4C1F 4B53

192 7730 15852 1E32 3DEC 3865 7926 0F19 1EF6 12778 11542 31EA 2D16
193 23476 16125 5BB4 3EFD 11738 20802 2DDA 5142 27309 27928 6AAD 6D18

194 889 6074 0379 17BA 20588 3037 506C 0BDD 12527 26637 30EF 680D
195 21141 31245 5295 7A0D 30874 29498 789A 733A 953 10035 03B9 2733

196 20520 15880 5028 3E08 10260 7940 2814 1F04 15958 10748 3E56 29FC
197 21669 20371 54A5 4F93 31618 27125 7B82 69F5 6068 24429 17B4 5F6D

198 15967 8666 3E5F 21DA 20223 4333 4EFF 10ED 23577 29701 5C19 7405
199 21639 816 5487 0330 31635 408 7B93 0198 32156 14997 7D9C 3A95

200 31120 22309 7990 5725 15560 26030 3CC8 65AE 32709 32235 7FC5 7DEB
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Appendix E: PN Offset Programming Information – continued

Apr 2001 E-7SC�4812ET BTS Optimization/ATP — CDMA LMF
DRAFT

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

201 3698 29563 0E72 737B 1849 30593 0739 7781 23557 30766 5C05 782E

202 16322 13078 3FC2 3316 8161 6539 1FE1 198B 17638 5985 44E6 1761
203 17429 10460 4415 28DC 29658 5230 73DA 146E 3545 6823 0DD9 1AA7

204 21730 17590 54E2 44B6 10865 8795 2A71 225B 9299 20973 2453 51ED
205 17808 20277 4590 4F35 8904 27046 22C8 69A6 6323 10197 18B3 27D5

206 30068 19988 7574 4E14 15034 9994 3ABA 270A 19590 9618 4C86 2592
207 12737 6781 31C1 1A7D 18736 17154 4930 4302 7075 22705 1BA3 58B1

208 28241 32501 6E51 7EF5 26360 28998 66F8 7146 14993 5234 3A91 1472
209 20371 6024 4F93 1788 30233 3012 7619 0BC4 19916 12541 4DCC 30FD

210 13829 20520 3605 5028 19154 10260 4AD2 2814 6532 8019 1984 1F53
211 13366 31951 3436 7CCF 6683 28763 1A1B 705B 17317 22568 43A5 5828

212 25732 26063 6484 65CF 12866 31963 3242 7CDB 16562 5221 40B2 1465
213 19864 27203 4D98 6A43 9932 31517 26CC 7B1D 26923 25216 692B 6280

214 5187 6614 1443 19D6 23537 3307 5BF1 0CEB 9155 1354 23C3 054A
215 23219 10970 5AB3 2ADA 31881 5485 7C89 156D 20243 29335 4F13 7297

216 28242 5511 6E52 1587 14121 17663 3729 44FF 32391 6682 7E87 1A1A
217 6243 17119 1863 42DF 24033 28499 5DE1 6F53 20190 26128 4EDE 6610

218 445 16064 01BD 3EC0 20750 8032 510E 1F60 27564 29390 6BAC 72CE
219 21346 31614 5362 7B7E 10673 15807 29B1 3DBF 20869 8852 5185 2294

220 13256 4660 33C8 1234 6628 2330 19E4 091A 9791 6110 263F 17DE
221 18472 13881 4828 3639 9236 21792 2414 5520 714 11847 02CA 2E47

222 25945 16819 6559 41B3 25468 28389 637C 6EE5 7498 10239 1D4A 27FF
223 31051 6371 794B 18E3 28021 16973 6D75 424D 23278 6955 5AEE 1B2B

224 1093 24673 0445 6061 21490 32268 53F2 7E0C 8358 10897 20A6 2A91
225 5829 6055 16C5 17A7 23218 17903 5AB2 45EF 9468 14076 24FC 36FC

226 31546 10009 7B3A 2719 15773 23984 3D9D 5DB0 23731 12450 5CB3 30A2
227 29833 5957 7489 1745 27540 17822 6B94 459E 25133 8954 622D 22FA

228 18146 11597 46E2 2D4D 9073 22682 2371 589A 2470 19709 09A6 4CFD
229 24813 22155 60ED 568B 24998 25977 61A6 6579 17501 1252 445D 04E4

230 47 15050 002F 3ACA 20935 7525 51C7 1D65 24671 15142 605F 3B26
231 3202 16450 0C82 4042 1601 8225 0641 2021 11930 26958 2E9A 694E

232 21571 27899 5443 6CFB 31729 30785 7BF1 7841 9154 8759 23C2 2237
233 7469 2016 1D2D 07E0 24390 1008 5F46 03F0 7388 12696 1CDC 3198

234 25297 17153 62D1 4301 24760 28604 60B8 6FBC 3440 11936 0D70 2EA0
235 8175 15849 1FEF 3DE9 24103 20680 5E27 50C8 27666 25635 6C12 6423

236 28519 30581 6F67 7775 26211 30086 6663 7586 22888 17231 5968 434F
237 4991 3600 137F 0E10 22639 1800 586F 0708 13194 22298 338A 571A

238 7907 4097 1EE3 1001 24225 17980 5EA1 463C 26710 7330 6856 1CA2
239 17728 671 4540 029F 8864 20339 22A0 4F73 7266 30758 1C62 7826

240 14415 20774 384F 5126 19959 10387 4DF7 2893 15175 6933 3B47 1B15
241 30976 24471 7900 5F97 15488 25079 3C80 61F7 15891 2810 3E13 0AFA

242 26376 27341 6708 6ACD 13188 31578 3384 7B5A 26692 8820 6844 2274
243 19063 19388 4A77 4BBC 29931 9694 74EB 25DE 14757 7831 39A5 1E97

244 19160 25278 4AD8 62BE 9580 12639 256C 315F 28757 19584 7055 4C80
245 3800 9505 0ED8 2521 1900 23724 076C 5CAC 31342 2944 7A6E 0B80

246 8307 26143 2073 661F 16873 32051 41E9 7D33 19435 19854 4BEB 4D8E
247 12918 13359 3276 342F 6459 21547 193B 542B 2437 10456 0985 28D8

248 19642 2154 4CBA 086A 9821 1077 265D 0435 20573 17036 505D 428C
249 24873 13747 6129 35B3 24900 21733 6144 54E5 18781 2343 495D 0927

250 22071 27646 5637 6BFE 31435 13823 7ACB 35FF 18948 14820 4A04 39E4

. . . continued on next page
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Appendix E: PN Offset Programming Information – continued

DRAFT
SC�4812ET BTS Optimization/ATP — CDMA LMF Apr 2001E-8

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

251 13904 1056 3650 0420 6952 528 1B28 0210 23393 1756 5B61 06DC

252 27198 1413 6A3E 0585 13599 19710 351F 4CFE 5619 19068 15F3 4A7C
253 3685 3311 0E65 0CEF 22242 18507 56E2 484B 17052 28716 429C 702C

254 16820 4951 41B4 1357 8410 18327 20DA 4797 21292 31958 532C 7CD6
255 22479 749 57CF 02ED 31287 20298 7A37 4F4A 2868 16097 0B34 3EE1

256 6850 6307 1AC2 18A3 3425 17005 0D61 426D 19538 1308 4C52 051C
257 15434 961 3C4A 03C1 7717 20444 1E25 4FDC 24294 3320 5EE6 0CF8

258 19332 2358 4B84 0936 9666 1179 25C2 049B 22895 16682 596F 412A
259 8518 28350 2146 6EBE 4259 14175 10A3 375F 27652 6388 6C04 18F4

260 14698 31198 396A 79DE 7349 15599 1CB5 3CEF 29905 12828 74D1 321C
261 21476 11467 53E4 2CCB 10738 22617 29F2 5859 21415 3518 53A7 0DBE

262 30475 8862 770B 229E 27221 4431 6A55 114F 1210 3494 04BA 0DA6
263 23984 6327 5DB0 18B7 11992 16999 2ED8 4267 22396 6458 577C 193A

264 1912 7443 0778 1D13 956 16565 03BC 40B5 26552 10717 67B8 29DD
265 26735 28574 686F 6F9E 26087 14287 65E7 37CF 24829 8463 60FD 210F

266 15705 25093 3D59 6205 20348 32574 4F7C 7F3E 8663 27337 21D7 6AC9
267 3881 6139 0F29 17FB 22084 17857 5644 45C1 991 19846 03DF 4D86

268 20434 22047 4FD2 561F 10217 25907 27E9 6533 21926 9388 55A6 24AC
269 16779 32545 418B 7F21 28949 29100 7115 71AC 23306 21201 5B0A 52D1

270 31413 7112 7AB5 1BC8 27786 3556 6C8A 0DE4 13646 31422 354E 7ABE
271 16860 28535 41DC 6F77 8430 31111 20EE 7987 148 166 0094 00A6

272 8322 10378 2082 288A 4161 5189 1041 1445 24836 28622 6104 6FCE
273 28530 15065 6F72 3AD9 14265 21328 37B9 5350 24202 6477 5E8A 194D

274 26934 5125 6936 1405 13467 17470 349B 443E 9820 10704 265C 29D0
275 18806 12528 4976 30F0 9403 6264 24BB 1878 12939 25843 328B 64F3

276 20216 23215 4EF8 5AAF 10108 25451 277C 636B 2364 25406 093C 633E
277 9245 20959 241D 51DF 17374 26323 43DE 66D3 14820 21523 39E4 5413

278 8271 3568 204F 0DF0 16887 1784 41F7 06F8 2011 8569 07DB 2179
279 18684 26453 48FC 6755 9342 32150 247E 7D96 13549 9590 34ED 2576

280 8220 29421 201C 72ED 4110 30538 100E 774A 28339 22466 6EB3 57C2
281 6837 24555 1AB5 5FEB 23690 25033 5C8A 61C9 25759 12455 649F 30A7

282 9613 10779 258D 2A1B 17174 23345 4316 5B31 11116 27506 2B6C 6B72
283 31632 25260 7B90 62AC 15816 12630 3DC8 3156 31448 21847 7AD8 5557

284 27448 16084 6B38 3ED4 13724 8042 359C 1F6A 27936 28392 6D20 6EE8
285 12417 26028 3081 65AC 18832 13014 4990 32D6 3578 1969 0DFA 07B1

286 30901 29852 78B5 749C 28042 14926 6D8A 3A4E 12371 30715 3053 77FB
287 9366 14978 2496 3A82 4683 7489 124B 1D41 12721 23674 31B1 5C7A

288 12225 12182 2FC1 2F96 17968 6091 4630 17CB 10264 22629 2818 5865
289 21458 25143 53D2 6237 10729 32551 29E9 7F27 25344 12857 6300 3239

290 6466 15838 1942 3DDE 3233 7919 0CA1 1EEF 13246 30182 33BE 75E6
291 8999 5336 2327 14D8 16451 2668 4043 0A6C 544 21880 0220 5578

292 26718 21885 685E 557D 13359 25730 342F 6482 9914 6617 26BA 19D9
293 3230 20561 0C9E 5051 1615 26132 064F 6614 4601 27707 11F9 6C3B

294 27961 30097 6D39 7591 26444 29940 674C 74F4 16234 16249 3F6A 3F79
295 28465 21877 6F31 5575 26184 25734 6648 6486 24475 24754 5F9B 60B2

296 6791 23589 1A87 5C25 23699 24622 5C93 602E 26318 31609 66CE 7B79
297 17338 26060 43BA 65CC 8669 13030 21DD 32E6 6224 22689 1850 58A1

298 11832 9964 2E38 26EC 5916 4982 171C 1376 13381 3226 3445 0C9A
299 11407 25959 2C8F 6567 18327 31887 4797 7C8F 30013 4167 753D 1047

300 15553 3294 3CC1 0CDE 20400 1647 4FB0 066F 22195 25624 56B3 6418

. . . continued on next page
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Appendix E: PN Offset Programming Information – continued

Apr 2001 E-9SC�4812ET BTS Optimization/ATP — CDMA LMF
DRAFT

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

301 17418 30173 440A 75DD 8709 29906 2205 74D2 30380 10924 76AC 2AAC

302 14952 15515 3A68 3C9B 7476 20593 1D34 5071 15337 23096 3BE9 5A38
303 52 5371 0034 14FB 26 17473 001A 4441 10716 22683 29DC 589B

304 27254 10242 6A76 2802 13627 5121 353B 1401 13592 10955 3518 2ACB
305 15064 28052 3AD8 6D94 7532 14026 1D6C 36CA 2412 17117 096C 42DD

306 10942 14714 2ABE 397A 5471 7357 155F 1CBD 15453 15837 3C5D 3DDD
307 377 19550 0179 4C5E 20844 9775 516C 262F 13810 22647 35F2 5877

308 14303 8866 37DF 22A2 19007 4433 4A3F 1151 12956 10700 329C 29CC
309 24427 15297 5F6B 3BC1 32357 21468 7E65 53DC 30538 30293 774A 7655

310 26629 10898 6805 2A92 26066 5449 65D2 1549 10814 5579 2A3E 15CB
311 20011 31315 4E2B 7A53 30405 29461 76C5 7315 18939 11057 49FB 2B31

312 16086 19475 3ED6 4C13 8043 26677 1F6B 6835 19767 30238 4D37 761E
313 24374 1278 5F36 04FE 12187 639 2F9B 027F 20547 14000 5043 36B0

314 9969 11431 26F1 2CA7 17064 22639 42A8 586F 29720 22860 7418 594C
315 29364 31392 72B4 7AA0 14682 15696 395A 3D50 31831 27172 7C57 6A24

316 25560 4381 63D8 111D 12780 18098 31EC 46B2 26287 307 66AF 0133
317 28281 14898 6E79 3A32 26348 7449 66EC 1D19 11310 20380 2C2E 4F9C

318 7327 23959 1C9F 5D97 24479 24823 5F9F 60F7 25724 26427 647C 673B
319 32449 16091 7EC1 3EDB 28336 20817 6EB0 5151 21423 10702 53AF 29CE

320 26334 9037 66DE 234D 13167 24474 336F 5F9A 5190 30024 1446 7548
321 14760 24162 39A8 5E62 7380 12081 1CD4 2F31 258 14018 0102 36C2

322 15128 6383 3B18 18EF 7564 16971 1D8C 424B 13978 4297 369A 10C9
323 29912 27183 74D8 6A2F 14956 31531 3A6C 7B2B 4670 13938 123E 3672

324 4244 16872 1094 41E8 2122 8436 084A 20F4 23496 25288 5BC8 62C8
325 8499 9072 2133 2370 16713 4536 4149 11B8 23986 27294 5DB2 6A9E

326 9362 12966 2492 32A6 4681 6483 1249 1953 839 31835 0347 7C5B
327 10175 28886 27BF 70D6 16911 14443 420F 386B 11296 8228 2C20 2024

328 30957 25118 78ED 621E 28070 12559 6DA6 310F 30913 12745 78C1 31C9
329 12755 20424 31D3 4FC8 18745 10212 4939 27E4 27297 6746 6AA1 1A5A

330 19350 6729 4B96 1A49 9675 17176 25CB 4318 10349 1456 286D 05B0
331 1153 20983 0481 51F7 21392 26311 5390 66C7 32504 27743 7EF8 6C5F

332 29304 12372 7278 3054 14652 6186 393C 182A 18405 27443 47E5 6B33
333 6041 13948 1799 367C 23068 6974 5A1C 1B3E 3526 31045 0DC6 7945

334 21668 27547 54A4 6B9B 10834 31729 2A52 7BF1 19161 12225 4AD9 2FC1
335 28048 8152 6D90 1FD8 14024 4076 36C8 0FEC 23831 21482 5D17 53EA

336 10096 17354 2770 43CA 5048 8677 13B8 21E5 21380 14678 5384 3956
337 23388 17835 5B5C 45AB 11694 27881 2DAE 6CE9 4282 30656 10BA 77C0

338 15542 14378 3CB6 382A 7771 7189 1E5B 1C15 32382 13721 7E7E 3599
339 24013 7453 5DCD 1D1D 32566 16562 7F36 40B2 806 21831 0326 5547

340 2684 26317 0A7C 66CD 1342 32090 053E 7D5A 6238 30208 185E 7600
341 19018 5955 4A4A 1743 9509 17821 2525 459D 10488 9995 28F8 270B

342 25501 10346 639D 286A 24606 5173 601E 1435 19507 3248 4C33 0CB0
343 4489 13200 1189 3390 22804 6600 5914 19C8 27288 12030 6A98 2EFE

344 31011 30402 7923 76C2 27969 15201 6D41 3B61 2390 5688 0956 1638
345 29448 7311 7308 1C8F 14724 16507 3984 407B 19094 2082 4A96 0822

346 25461 3082 6375 0C0A 24682 1541 606A 0605 13860 23143 3624 5A67
347 11846 21398 2E46 5396 5923 10699 1723 29CB 9225 25906 2409 6532

348 30331 31104 767B 7980 27373 15552 6AED 3CC0 2505 15902 09C9 3E1E
349 10588 24272 295C 5ED0 5294 12136 14AE 2F68 27806 21084 6C9E 525C

350 32154 27123 7D9A 69F3 16077 31429 3ECD 7AC5 2408 25723 0968 647B

. . . continued on next page
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Appendix E: PN Offset Programming Information – continued

DRAFT
SC�4812ET BTS Optimization/ATP — CDMA LMF Apr 2001E-10

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

351 29572 5578 7384 15CA 14786 2789 39C2 0AE5 13347 13427 3423 3473

352 13173 25731 3375 6483 18538 31869 486A 7C7D 7885 31084 1ECD 796C
353 10735 10662 29EF 29A6 17703 5331 4527 14D3 6669 24023 1A0D 5DD7

354 224 11084 00E0 2B4C 112 5542 0070 15A6 8187 23931 1FFB 5D7B
355 12083 31098 2F33 797A 17993 15549 4649 3CBD 18145 15836 46E1 3DDC

356 22822 16408 5926 4018 11411 8204 2C93 200C 14109 6085 371D 17C5
357 2934 6362 0B76 18DA 1467 3181 05BB 0C6D 14231 30324 3797 7674

358 27692 2719 6C2C 0A9F 13846 19315 3616 4B73 27606 27561 6BD6 6BA9
359 10205 14732 27DD 398C 16958 7366 423E 1CC6 783 13821 030F 35FD

360 7011 22744 1B63 58D8 23649 11372 5C61 2C6C 6301 269 189D 010D
361 22098 1476 5652 05C4 11049 738 2B29 02E2 5067 28663 13CB 6FF7

362 2640 8445 0A50 20FD 1320 24130 0528 5E42 15383 29619 3C17 73B3
363 4408 21118 1138 527E 2204 10559 089C 293F 1392 2043 0570 07FB

364 102 22198 0066 56B6 51 11099 0033 2B5B 7641 6962 1DD9 1B32
365 27632 22030 6BF0 560E 13816 11015 35F8 2B07 25700 29119 6464 71BF

366 19646 10363 4CBE 287B 9823 23041 265F 5A01 25259 22947 62AB 59A3
367 26967 25802 6957 64CA 25979 12901 657B 3265 19813 9612 4D65 258C

368 32008 2496 7D08 09C0 16004 1248 3E84 04E0 20933 18698 51C5 490A
369 7873 31288 1EC1 7A38 24240 15644 5EB0 3D1C 638 16782 027E 418E

370 655 24248 028F 5EB8 20631 12124 5097 2F5C 16318 29735 3FBE 7427
371 25274 14327 62BA 37F7 12637 21959 315D 55C7 6878 2136 1ADE 0858

372 16210 23154 3F52 5A72 8105 11577 1FA9 2D39 1328 8086 0530 1F96
373 11631 13394 2D6F 3452 18279 6697 4767 1A29 14744 10553 3998 2939

374 8535 1806 2157 070E 16763 903 417B 0387 22800 11900 5910 2E7C
375 19293 17179 4B5D 431B 29822 28593 747E 6FB1 25919 19996 653F 4E1C

376 12110 10856 2F4E 2A68 6055 5428 17A7 1534 4795 5641 12BB 1609
377 21538 25755 5422 649B 10769 31857 2A11 7C71 18683 28328 48FB 6EA8

378 10579 15674 2953 3D3A 17785 7837 4579 1E9D 32658 25617 7F92 6411
379 13032 7083 32E8 1BAB 6516 17385 1974 43E9 1586 26986 0632 696A

380 14717 29096 397D 71A8 19822 14548 4D6E 38D4 27208 5597 6A48 15DD
381 11666 3038 2D92 0BDE 5833 1519 16C9 05EF 17517 14078 446D 36FE

382 25809 16277 64D1 3F95 25528 20982 63B8 51F6 599 13247 0257 33BF
383 5008 25525 1390 63B5 2504 32742 09C8 7FE6 16253 499 3F7D 01F3

384 32418 20465 7EA2 4FF1 16209 27076 3F51 69C4 8685 30469 21ED 7705
385 22175 28855 569F 70B7 31391 30311 7A9F 7667 29972 17544 7514 4488

386 11742 32732 2DDE 7FDC 5871 16366 16EF 3FEE 22128 28510 5670 6F5E
387 22546 20373 5812 4F95 11273 27126 2C09 69F6 19871 23196 4D9F 5A9C

388 21413 9469 53A5 24FD 30722 23618 7802 5C42 19405 13384 4BCD 3448
389 133 26155 0085 662B 20882 32041 5192 7D29 17972 4239 4634 108F

390 4915 6957 1333 1B2D 22601 17322 5849 43AA 8599 20725 2197 50F5
391 8736 12214 2220 2FB6 4368 6107 1110 17DB 10142 6466 279E 1942

392 1397 21479 0575 53E7 21354 26575 536A 67CF 26834 28465 68D2 6F31
393 18024 31914 4668 7CAA 9012 15957 2334 3E55 23710 19981 5C9E 4E0D

394 15532 32311 3CAC 7E37 7766 28967 1E56 7127 27280 16723 6A90 4153
395 26870 11276 68F6 2C0C 13435 5638 347B 1606 6570 4522 19AA 11AA

396 5904 20626 1710 5092 2952 10313 0B88 2849 7400 678 1CE8 02A6
397 24341 423 5F15 01A7 32346 20207 7E5A 4EEF 26374 15320 6706 3BD8

398 13041 2679 32F1 0A77 18600 19207 48A8 4B07 22218 29116 56CA 71BC
399 23478 15537 5BB6 3CB1 11739 20580 2DDB 5064 29654 5388 73D6 150C

400 1862 10818 0746 2A42 931 5409 03A3 1521 13043 22845 32F3 593D

. . . continued on next page
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Appendix E: PN Offset Programming Information – continued

Apr 2001 E-11SC�4812ET BTS Optimization/ATP — CDMA LMF
DRAFT

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

401 5850 23074 16DA 5A22 2925 11537 0B6D 2D11 24457 28430 5F89 6F0E

402 5552 20250 15B0 4F1A 2776 10125 0AD8 278D 17161 8660 4309 21D4
403 12589 14629 312D 3925 18758 21166 4946 52AE 21314 2659 5342 0A63

404 23008 29175 59E0 71F7 11504 30407 2CF0 76C7 28728 8803 7038 2263
405 27636 13943 6BF4 3677 13818 21767 35FA 5507 22162 19690 5692 4CEA

406 17600 11072 44C0 2B40 8800 5536 2260 15A0 26259 22169 6693 5699
407 17000 29492 4268 7334 8500 14746 2134 399A 22180 8511 56A4 213F

408 21913 5719 5599 1657 31516 17687 7B1C 4517 2266 17393 08DA 43F1
409 30320 7347 7670 1CB3 15160 16485 3B38 4065 10291 11336 2833 2C48

410 28240 12156 6E50 2F7C 14120 6078 3728 17BE 26620 13576 67FC 3508
411 7260 25623 1C5C 6417 3630 31799 0E2E 7C37 19650 22820 4CC2 5924

412 17906 27725 45F2 6C4D 8953 30746 22F9 781A 14236 13344 379C 3420
413 5882 28870 16FA 70C6 2941 14435 0B7D 3863 11482 20107 2CDA 4E8B

414 22080 31478 5640 7AF6 11040 15739 2B20 3D7B 25289 8013 62C9 1F4D
415 12183 28530 2F97 6F72 17947 14265 461B 37B9 12011 18835 2EEB 4993

416 23082 24834 5A2A 6102 11541 12417 2D15 3081 13892 16793 3644 4199
417 17435 9075 441B 2373 29661 24453 73DD 5F85 17336 9818 43B8 265A

418 18527 32265 485F 7E09 30207 28984 75FF 7138 10759 4673 2A07 1241
419 31902 3175 7C9E 0C67 15951 18447 3E4F 480F 26816 13609 68C0 3529

420 18783 17434 495F 441A 30079 8717 757F 220D 31065 10054 7959 2746
421 20027 12178 4E3B 2F92 30413 6089 76CD 17C9 8578 10988 2182 2AEC

422 7982 25613 1F2E 640D 3991 31802 0F97 7C3A 24023 14744 5DD7 3998
423 20587 31692 506B 7BCC 31205 15846 79E5 3DE6 16199 17930 3F47 460A

424 10004 25384 2714 6328 5002 12692 138A 3194 22310 25452 5726 636C
425 13459 18908 3493 49DC 19353 9454 4B99 24EE 30402 11334 76C2 2C46

426 13383 25816 3447 64D8 19443 12908 4BF3 326C 16613 15451 40E5 3C5B
427 28930 4661 7102 1235 14465 18214 3881 4726 13084 11362 331C 2C62

428 4860 31115 12FC 798B 2430 29433 097E 72F9 3437 2993 0D6D 0BB1
429 13108 7691 3334 1E0B 6554 16697 199A 4139 1703 11012 06A7 2B04

430 24161 1311 5E61 051F 32480 19635 7EE0 4CB3 22659 5806 5883 16AE
431 20067 16471 4E63 4057 30433 28183 76E1 6E17 26896 20180 6910 4ED4

432 2667 15771 0A6B 3D9B 21733 20721 54E5 50F1 1735 8932 06C7 22E4
433 13372 16112 343C 3EF0 6686 8056 1A1E 1F78 16178 23878 3F32 5D46

434 28743 21062 7047 5246 27123 10531 69F3 2923 19166 20760 4ADE 5118
435 24489 29690 5FA9 73FA 32260 14845 7E04 39FD 665 32764 0299 7FFC

436 249 10141 00F9 279D 20908 24050 51AC 5DF2 20227 32325 4F03 7E45
437 19960 19014 4DF8 4A46 9980 9507 26FC 2523 24447 25993 5F7F 6589

438 29682 22141 73F2 567D 14841 25858 39F9 6502 16771 3268 4183 0CC4
439 31101 11852 797D 2E4C 28014 5926 6D6E 1726 27209 25180 6A49 625C

440 27148 26404 6A0C 6724 13574 13202 3506 3392 6050 12149 17A2 2F75
441 26706 30663 6852 77C7 13353 30175 3429 75DF 29088 10193 71A0 27D1

442 5148 32524 141C 7F0C 2574 16262 0A0E 3F86 7601 9128 1DB1 23A8
443 4216 28644 1078 6FE4 2108 14322 083C 37F2 4905 7843 1329 1EA3

444 5762 10228 1682 27F4 2881 5114 0B41 13FA 5915 25474 171B 6382
445 245 23536 00F5 5BF0 20906 11768 51AA 2DF8 6169 11356 1819 2C5C

446 21882 18045 557A 467D 10941 27906 2ABD 6D02 21303 11226 5337 2BDA
447 3763 25441 0EB3 6361 22153 32652 5689 7F8C 28096 16268 6DC0 3F8C

448 206 27066 00CE 69BA 103 13533 0067 34DD 8905 14491 22C9 389B
449 28798 13740 707E 35AC 14399 6870 383F 1AD6 26997 8366 6975 20AE

450 32402 13815 7E92 35F7 16201 21703 3F49 54C7 15047 26009 3AC7 6599

. . . continued on next page
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Appendix E: PN Offset Programming Information – continued

DRAFT
SC�4812ET BTS Optimization/ATP — CDMA LMF Apr 2001E-12

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

451 13463 3684 3497 0E64 19355 1842 4B9B 0732 17460 5164 4434 142C

452 15417 23715 3C39 5CA3 20428 24685 4FCC 606D 17629 17126 44DD 42E6
453 23101 15314 5A3D 3BD2 31950 7657 7CCE 1DE9 10461 21566 28DD 543E

454 14957 32469 3A6D 7ED5 19686 29014 4CE6 7156 21618 21845 5472 5555
455 23429 9816 5B85 2658 31762 4908 7C12 132C 11498 28149 2CEA 6DF5

456 12990 4444 32BE 115C 6495 2222 195F 08AE 193 9400 00C1 24B8
457 12421 5664 3085 1620 18834 2832 4992 0B10 16140 19459 3F0C 4C03

458 28875 7358 70CB 1CBE 27061 3679 69B5 0E5F 13419 7190 346B 1C16
459 4009 27264 0FA9 6A80 22020 13632 5604 3540 10864 3101 2A70 0C1D

460 1872 28128 0750 6DE0 936 14064 03A8 36F0 28935 491 7107 01EB
461 15203 30168 3B63 75D8 19553 15084 4C61 3AEC 18765 25497 494D 6399

462 30109 29971 759D 7513 27422 29877 6B1E 74B5 27644 29807 6BFC 746F
463 24001 3409 5DC1 0D51 32560 18580 7F30 4894 21564 26508 543C 678C

464 4862 16910 12FE 420E 2431 8455 097F 2107 5142 4442 1416 115A
465 14091 20739 370B 5103 19029 26301 4A55 66BD 1211 4871 04BB 1307

466 6702 10191 1A2E 27CF 3351 24027 0D17 5DDB 1203 31141 04B3 79A5
467 3067 12819 0BFB 3213 21549 22325 542D 5735 5199 9864 144F 2688

468 28643 19295 6FE3 4B5F 26145 27539 6621 6B93 16945 12589 4231 312D
469 21379 10072 5383 2758 30737 5036 7811 13AC 4883 5417 1313 1529

470 20276 15191 4F34 3B57 10138 21399 279A 5397 25040 8549 61D0 2165
471 25337 27748 62F9 6C64 24748 13874 60AC 3632 7119 14288 1BCF 37D0

472 19683 720 4CE3 02D0 30625 360 77A1 0168 17826 8503 45A2 2137
473 10147 29799 27A3 7467 16897 29711 4201 740F 4931 20357 1343 4F85

474 16791 27640 4197 6BF8 28955 13820 711B 35FC 25705 15381 6469 3C15
475 17359 263 43CF 0107 28727 20159 7037 4EBF 10726 18065 29E6 4691

476 13248 24734 33C0 609E 6624 12367 19E0 304F 17363 24678 43D3 6066
477 22740 16615 58D4 40E7 11370 28239 2C6A 6E4F 2746 23858 0ABA 5D32

478 13095 20378 3327 4F9A 18499 10189 4843 27CD 10952 7610 2AC8 1DBA
479 10345 25116 2869 621C 17892 12558 45E4 310E 19313 18097 4B71 46B1

480 30342 19669 7686 4CD5 15171 26710 3B43 6856 29756 20918 743C 51B6
481 27866 14656 6CDA 3940 13933 7328 366D 1CA0 14297 7238 37D9 1C46

482 9559 27151 2557 6A0F 17275 31547 437B 7B3B 21290 30549 532A 7755
483 8808 28728 2268 7038 4404 14364 1134 381C 1909 16320 0775 3FC0

484 12744 25092 31C8 6204 6372 12546 18E4 3102 8994 20853 2322 5175
485 11618 22601 2D62 5849 5809 25112 16B1 6218 13295 26736 33EF 6870

486 27162 2471 6A1A 09A7 13581 19183 350D 4AEF 21590 10327 5456 2857
487 17899 25309 45EB 62DD 29477 32594 7325 7F52 26468 24404 6764 5F54

488 29745 15358 7431 3BFE 27592 7679 6BC8 1DFF 13636 7931 3544 1EFB
489 31892 17739 7C94 454B 15946 27801 3E4A 6C99 5207 5310 1457 14BE

490 23964 12643 5D9C 3163 11982 22157 2ECE 568D 29493 554 7335 022A
491 23562 32730 5C0A 7FDA 11781 16365 2E05 3FED 18992 27311 4A30 6AAF

492 2964 19122 0B94 4AB2 1482 9561 05CA 2559 12567 6865 3117 1AD1
493 18208 16870 4720 41E6 9104 8435 2390 20F3 12075 7762 2F2B 1E52

494 15028 10787 3AB4 2A23 7514 23341 1D5A 5B2D 26658 15761 6822 3D91
495 21901 18400 558D 47E0 31510 9200 7B16 23F0 21077 12697 5255 3199

496 24566 20295 5FF6 4F47 12283 27039 2FFB 699F 15595 24850 3CEB 6112
497 18994 1937 4A32 0791 9497 19956 2519 4DF4 4921 15259 1339 3B9B

498 13608 17963 3528 462B 6804 27945 1A94 6D29 14051 24243 36E3 5EB3
499 27492 7438 6B64 1D0E 13746 3719 35B2 0E87 5956 30508 1744 772C

500 11706 12938 2DBA 328A 5853 6469 16DD 1945 21202 13982 52D2 369E

. . . continued on next page
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Appendix E: PN Offset Programming Information – continued

Apr 2001 E-13SC�4812ET BTS Optimization/ATP — CDMA LMF
DRAFT

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

501 14301 19272 37DD 4B48 19006 9636 4A3E 25A4 11239 25039 2BE7 61CF

502 23380 29989 5B54 7525 11690 29870 2DAA 74AE 30038 24086 7556 5E16
503 11338 8526 2C4A 214E 5669 4263 1625 10A7 30222 21581 760E 544D

504 2995 18139 0BB3 46DB 21513 27985 5409 6D51 13476 21346 34A4 5362
505 23390 3247 5B5E 0CAF 11695 18539 2DAF 486B 2497 28187 09C1 6E1B

506 14473 28919 3889 70F7 19860 30279 4D94 7647 31842 23231 7C62 5ABF
507 6530 7292 1982 1C7C 3265 3646 0CC1 0E3E 24342 18743 5F16 4937

508 20452 20740 4FE4 5104 10226 10370 27F2 2882 25857 11594 6501 2D4A
509 12226 27994 2FC2 6D5A 6113 13997 17E1 36AD 27662 7198 6C0E 1C1E

510 1058 2224 0422 08B0 529 1112 0211 0458 24594 105 6012 0069
511 12026 6827 2EFA 1AAB 6013 17257 177D 4369 16790 4534 4196 11B6
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Purpose

This appendix provides information on setting up the HP8921 with PCS
interface, the HP8935 and the Advantest R3465. The Cybertest test set
doesn’t require any setup.

HP8921A Test Equipment
Connections

The following diagram depicts the rear panels of the HP 8921A test
equipment as configured to perform automatic tests. All test equipment
is  controlled by the LMF via an IEEE–488/GPIB bus. The LMF expects
each piece of test equipment to have a factory-set GPIB address (refer to
Table F-4). If there is  a communications problem between the LMF and
any piece of test equipment, you should verify that the GPIB addresses
have been set correctly and that the GPIB cables are firmly connected to
the test equipment.

Figure F-1 shows the connections when not using an external 10 MHz
Rubidium reference.

Table F-1: HP8921A/600 Communications Test Set Rear Panel Connections Without Rubidium

From Test Set: To Interface:

8921A 83203B CDMA 83236A PCS
Connector Type

CW RF OUT CW RF IN SMC–female – SMC–female

114.3 MHZ IF OUT 114.3 MHZ IF IN SMC–female – SMC–female

IQ RF IN IQ RF OUT SMC–female – SMC–female

DET OUT AUX DSP IN SMC–female – SMC–female

CONTROL I/O CONTROL I/O 45–pin custom BUS

10 MHZ OUT SYNTH REF IN BNC–male – BNC–male

HPIB INTERFACE HPIB INTERFACE HPIB cable

10 MHZ OUT REF IN BNC–male – BNC–male
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REAR PANEL
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Figure F-1: HP8921A/600 Cables Connection for 10 MHz Signal and GPIB without Rubidium
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Figure F-2  shows the connections when using an external 10 MHz
Rubidium reference.

Table F-2: HP8921A/600 Communications Test Set Rear Panel Connections With Rubidium

From Test Set: To Interface:

8921A 83203B CDMA 83236A PCS
Connector Type

CW RF OUT CW RF IN SMC–female – SMC–female

114.3 MHZ IF OUT 114.3 MHZ IF IN SMC–female – SMC–female

IQ RF IN IQ RF OUT SMC–female – SMC–female

DET OUT AUX DSP IN SMC–female – SMC–female

CONTROL I/O CONTROL I/O 45–pin custom BUS

10 MHZ OUT REF IN BNC–male – BNC–male

HPIB INTERFACE HPIB INTERFACE HPIB cable

10 MHZ INPUT 10 MHZ OUT BNC–male – BNC–male
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Figure F-2: HP8921A Cables Connection for 10 MHz Signal and GPIB with Rubidium
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HP8921A System Connectivity
Test

Follow the steps outlined in Table F-3 to verify that the connections
between the PCS Interface and the HP8921A are correct and cables are
intact.  The software also performs basic functionality checks of each
instrument.

Disconnect other GPIB devices, especially system
controllers, from the system before running the
connectivity software.

IMPORTANT

*

Table F-3: System Connectivity

Step Action

* IMPORTANT
– Perform this procedure after test equipment has been allowed to warm–up and stabilize for a

minimum of 60 minutes.

1 Insert HP 83236A Manual Control/System card into memory card slot.

2 Press the [PRESET] pushbutton.

3 Press the Screen Control [TESTS] pushbutton to display the “Tests” Main Menu screen.

4 Position the cursor at Select Procedure Location and select it by pressing the cursor control knob. In
the Choices selection box, select Card.

5 Position the cursor at Select Procedure Filename and select it by pressing the cursor control knob. In
the Choices selection box, select SYS_CONN.

6 Position the cursor at RUN TEST and select it.  The software will prompt you through the
connectivity setup.

7 Do the following when the test is complete,

� position cursor on STOP TEST and select it

� OR press the [K5] pushbutton.

8 To return to the main menu, press the [K5] pushbutton.

9 Press the [PRESET] pushbutton.
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Setting HP8921A and
HP83236A/B GPIB Address

Table F-4: Setting HP8921A GPIB Address

Step Action

1 If you have not already done so, turn the HP8921A power on.

2 Verify that the GPIB addresses are set correctly.

� HP8921A HP–IB Adrs = 18, accessed by pushing LOCAL and selecting More and I/O Configure
on the HP8921A/600. (Consult test equipment OEM documentation for additional info as required).

� HP83236A (or B) PCS Interface GPIB address=19. Set dip switches as follows:

– A1=1, A2=1, A3=0, A4=0, A5=1, HP–IB/Ser = 1

Pretest Setup for HP8921A

Before the HP8921A CDMA analyzer is used for LMF controlled testing
it must be set up correctly for automatic testing.

Table F-5: Pretest Setup for HP8921A

Step Action

1 Unplug the memory card if it is plugged in.

2 Press the CURSOR CONTROL knob.

3 Position the cursor at IO CONFIG (under To Screen and More) and select it.

4 Select Mode and set for Talk&Lstn.

Pretest Setup for HP8935

Before the HP8935 CDMA analyzer is used for LMF controlled testing
it must be set up correctly for automatic testing.

Table F-6: Pretest Setup for HP8935

Step Action

1 Unplug the memory card if it is plugged in.

2 Press the Shift button and then press the I/O Config button.

3 Press the Push to Select knob.

4 Position the cursor at IO CONFIG and select it.

5 Select Mode and set for Talk&Lstn.
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Advantest R3465 Connection

The following diagram depicts the rear panels of the Advantest test
equipment as configured to perform automatic tests. All test equipment
is  controlled by the LMF via an IEEE–488/GPIB bus. The LMF expects
each piece of test equipment to have a factory-set GPIB address (refer to
Table F-7). If there is  a communications problem between the LMF and
any piece of test equipment, you should verify that the GPIB addresses
have been set correctly and that the GPIB cables are firmly connected to
the test equipment.

Figure F-3 shows the connections when not using an external 10 MHz
Rubidium reference.

Figure F-3: Cable Connections for Test Set without 10 MHz Rubidium Standard
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Figure F-4 shows the connections when using an external 10 MHz
Rubidium reference.
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Figure F-4: Cable Connections for Test Set with 10 MHz Rubidium Standard
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R3465 GPIB Address & Clock
setup

Table F-7 describes the steps to set the GPIB address and clock for the
Advantest R3465 equipment.

Table F-7: Advantest R3465 GPIB Address and Clock Setup

Step Action

1 Communications test set GPIB address=18 (perform the following to view/set as required)

Perform the following to set the standard parameters on the test set:

� Push the SHIFT then PRESET pushbutton (just below the CRT display).

� Push the LCL pushbutton (CW in Measurement just below the CRT display)
– Push the GPIB and Others CRT menu key to view the current address.

– If required, change GPIB address to 18 (rotate the vernier knob to set, push the vernier knob to
enter)

2 Verify the current Date and Time in upper/right of the CRT display (perform the following to set if
required)

Communications test set GPIB address=18 (perform the following to view/set as required)

� Push the Date/Time CRT menu key

� If required, change to correct Date/Time (rotate the vernier knob to select and set, push the vernier
knob to enter)

�  Push the SHIFT then PRESET pushbutton (just below the CRT display).

 

Pretest Setup for Advantest
R3465

Before the Advantest R3465 analyzer is used for LMF controlled testing
it must be set up correctly for automatic testing.

Table F-8: Pretest Setup for Advantest R346

Step Action

1 Press the SHIFT button so the LED next to it is illuminated.

2 Press the RESET button.
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Calibrating Test Cable Setup
using HP PCS Interface (HP83236)

Table F-9 covers the procedure to calibrate the test equipment using 
the HP8921 Cellular Communications Analyzer equipped with the
HP83236 PCS Interface.

This calibration method must be executed with great care.
Some losses are measured close to the minimum limit of
the power meter sensor (–30 dBm).

NOTE

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� Test equipment to be calibrated has been connected correctly for cable
calibration.

� Test equipment has been selected and calibrated.

Table F-9: Calibrating Test Cable Setup (using the HP PCS Interface)

Step Action

NOTE
Verify that GPIB controller is turned off.

1 Insert HP83236 Manual Control System card into memory card slot.

2 Press the Preset pushbutton.

3 Under Screen Controls, press the TESTS pushbutton to display the TESTS (Main Menu) screen.

4 Position the cursor at Select Procedure Location and select it. In the Choices selection box, select
CARD.

5 Position the cursor at Select Procedure Filename and select it. In the Choices selection box, select
MANUAL.

6 Position the cursor at RUN TEST and select it. HP must be in Control Mode Select YES.

7 If using HP 83236A:
Set channel number=<chan#>:

– Position cursor at Channel
Number and select it.

– Enter the chan# using the numeric
keypad; press [Enter] and the
screen will go blank.

– When the screen reappears, the
chan# will be displayed on the
channel number line.

If using HP 83236B:
Set channel frequency:

– Position cursor at Frequency Band and press Enter.

– Select User Defined Frequency.

– Go Back to Previous Menu.

– Position the cursor to 83236 generator frequency and
enter actual RX frequency.

– Position the cursor to 83236 analyzer frequency and
enter actual TX frequency.

. . . continued on next page
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Table F-9: Calibrating Test Cable Setup (using the HP PCS Interface)

Step Action

8 Set RF Generator level:

– Position the cursor at RF Generator Level and select it.

– Enter –10 using the numeric keypad; press [Enter] and the screen will go blank.

– When the screen reappears, the value –10 dBm will be displayed on the RF Generator Level line.

9 Set the user fixed Attenuation Setting to 0 dBm:

– Position cursor at Analyzer Attenuation and select it
– Position cursor at User Fixed Atten Settings and select it.

– Enter 0 (zero) using the numeric keypad and press [Enter].

10 Select Back to Previous Menu.

11 Record the HP83236 Generator Frequency Level:

Record the HP83236B Generator Frequency Level:

– Position cursor at Show Frequency and Level Details and select it.
– Under HP83236 Frequencies and Levels, record the Generator Level.
– Under HP83236B Frequencies and Levels, record the Generator Frequency Level (1850 – 1910

MHz).

– Position cursor at Prev Menu and select it.

12 Click on Pause for Manual Measurement.

13 Connect the power sensor directly to the RF OUT ONLY port of the PCS Interface.

14 On the HP8921A, under To Screen, select CDMA GEN.

15 Move the cursor to the Amplitude field and click on the Amplitude value.

16 Increase the Amplitude value until the power meter reads 0 dBm ±0.2 dB.

NOTE
The Amplitude value can be increased coarsely until 0 dBM is reached; then fine tune the amplitude
by adjusting the Increment Set to 0.1 dBm and targeting in on 0 dBm.

17 Disconnect the power sensor from the RF OUT ONLY port of the PCS Interface.

* IMPORTANT
The Power Meter sensor’s lower limit is –30 dBm. Thus, only components having losses ≤30 dB
should be measured using this method. For further accuracy, always re-zero the power meter
before connecting the power sensor to the component being calibrated. After connecting the
power sensor to the component, record the calibrated loss immediately.

18 Disconnect all components in the test setup and calibrate each one separately by connecting each
component, one-at-a-time, between the RF OUT ONLY PORT and the power sensor. Record the
calibrated loss value displayed on the power meter.

� Example: (A) Test Cable(s) = –1.4 dB
(B) 20 dB Attenuator = –20.1 dB
(B) Directional Coupler = –29.8 dB

. . . continued on next page
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Table F-9: Calibrating Test Cable Setup (using the HP PCS Interface)

Step Action

19 After all components are calibrated, reassemble all components together and calculate the total test
setup loss by adding up all the individual losses:
� Example: Total test setup loss = –1.4 –29.8 –20.1 = –51.3 dB.

This calculated value will be used in the next series of tests.

20 Under Screen Controls press the TESTS button to display the TESTS (Main Menu) screen.

21 Select Continue (K2).

22 Select RF Generator Level and set to –119 dBm.

23 Click on Pause for Manual Measurement.

24 Verify the HP8921A Communication Analyzer/83203A CDMA interface setup is as follows (fields
not indicated remain at default):

� Verify the GPIB (HP–IB) address:

– under To Screen, select More

– select IO CONFIG

– Set HP–IB Adrs to 18

– set Mode to Talk&Lstn

� Verify the HP8921A is displaying frequency (instead of RF channel)

– Press the blue [SHIFT] button, then press the Screen Control [DUPLEX] button; this switches to
the CONFIG (CONFIGURE) screen.

– Use the cursor control to set RF Display to Freq

25 Refer toChapter 3 for assistance in setting the cable loss values into the LMF.
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Figure F-5: Cable CalibrationUsing HP8921 with PCS Interface
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Calibrating Test Cable Setup
using Advantest R3465

Be sure the GPIB Interface is OFF for this procedure.

NOTE

Advantest R3465 Manual Test setup and calibration must be performed
at both the TX and RX frequencies.

Table F-10: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

* IMPORTANT
– This procedure can only be performed after test equipment has been allowed to warm–up and

stabilize for a minimum of 60 minutes.

1 Press the SHIFT and the PRESET keys located below the display

2 Press the ADVANCE key in the MEASUREMENT area of the control panel.

3 Select the CDMA Sig CRT menu key

4 Select the Setup CRT menu key

5 Using the vernier knob and the cursor keys set the following parameters

NOTE
Fields not listed remain at default

Generator Mode: SIGNAL

Link: FORWARD

Level Unit: dBm

CalCorrection: ON

Level Offset: OFF

6 Select the return CRT menu key

7 Press FREQ key in the ENTRY area

8 Set the frequency to the desired value using the keypad entry keys

9 Verify that the Mod CRT menu key is highlighting OFF; if not, press the Mod key to toggle it OFF.

10 Verify that the Output CRT menu key is highlighting OFF; if not, press the Output key to toggle it
OFF.

11 Press the LEVEL key in the ENTRY area.

12 Set the LEVEL to 0 dBm using the key pad entry keys.

13 Zero power meter. Next connect the power sensor directly to the “RF OUT” port on the R3561L
CDMA Test Source Unit.

14 Press the Output CRT menu key to toggle Output to ON.

15 Record the power meter reading  ________________________

. . . continued on next page
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Table F-10: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

16 Disconnect the power meter sensor from the R3561L RF OUT jack.

* IMPORTANT
The Power Meter sensor’s lower limit is –30 dBm.  Thus, only components having losses < 30 dB
should be measured using this method. For best accuracy, always re–zero the power meter before
connecting the power sensor to the component being calibrated.  Then, after connecting the
power sensor to the component, record the calibrated loss immediately.

17 Disconnect all components in the the test setup and calibrate each one separately.  Connect each
component one–at–a–time between the “RF OUT” port and the power sensor (see Figure F-6, “Setups
A, B, and C”).  Record the calibrated loss value displayed on the power meter for each connection.

Example: (A) 1st Test Cable =  –0.5 dB
(B) 2nd Test Cable =  –1.4 dB
(C) 20 dB Attenuator =  –20.1 dB
(D) 30 dB Directional Coupler =  –29.8 dB

18 Press the Output CRT menu key to toggle Output OFF.

19 Calculate the total test setup loss by adding up all the individual losses:

Example: Total test setup loss  =  0.5 + 1.4 + 20.1 + 29.8  =  51.8 dB

This calculated value will be used in the next series of tests.

20 Press the FREQ key in the ENTRY area

21 Using the keypad entry keys, set the test frequency to the RX frequency

22 Repeat steps 9 through 19 for the RX frequency.

23 Refer to Chapter 3 for assistance in setting the cable loss values into the LMF.
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Figure F-6: Cable Calibration using Advantest R3465
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Calibrating HP 437 Power
Meter

Precise transmit output power calibration measurements are made using
a bolometer–type broadband power meter with a sensitive power sensor.
Follow the steps outlined in Table F-11 to enter information unique to
the power sensor before calibrating the test setup. Refer to Figure F-7 as
required.

This procedure must be done in conjunction with the
automated calibration to enter power sensor specific
calibration values.

IMPORTANT

*

CONNECT POWER
SENSOR WITH POWER
METER TURNED OFF

CONNECT POWER SENSOR
TO POWER REFERENCE
WHEN CALIBRATING UNIT.
POWER REFERENCE IS
ENABLED USING THE SHIFT �
KEYS

SHIFT (BLUE) PUSHBUTTON –
ACCESSES FUNCTION AND

DATA ENTRY KEYS IDENTIFIED
WITH LIGHT BLUE TEXT ON
THE FRONT PANEL ABOVE

THE BUTTONS

FW00308

Figure F-7: Power Meter Detail

Table F-11: Power Meter Calibration Procedure

Step Action

! CAUTION
Do not connect/disconnect the power meter sensor cable with ac power applied to the meter.
Disconnection could result in destruction of the sensing element or mis–calibration.

1 – Make sure the power meter AC LINE pushbutton is OFF.

– Connect the power sensor cable to the SENSOR input.

2 Set the AC LINE pushbutton to ON.

NOTE
The calibration should be performed only after the power meter and sensor have been allowed to
warm–up and stabilize for a minimum of 60 minutes.

3 Perform the following to set or verify the GPIB address:

– To enter the SPECIAL data entry function, press [SHIFT] then [PRESET].

– Use the [
] or [	] button to select HP–IB ADRS; then press [ENTER].

– Use the [
] or [	] button to select HP–IB ADRS 13; then press [ENTER].

– To EXIT the SPECIAL data entry function press [SHIFT] then [ENTER].

. . . continued on next page
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Table F-11: Power Meter Calibration Procedure

Step Action

4 Perform the following to set or verify the correct power sensor model:

– Press [SHIFT]  then [�] to select SENSOR.

– Identify the power sensor model number from the sensor label.  Use the [
] or [	] button to
select the appropriate model; then press [ENTER].

NOTE
Be sure the PWR REF (power reference) output is OFF (observe that the triangular indicator is NOT
displayed as shown in Step 7). If on, press [SHIFT] then [�] to turn it off.

5 Press [ZERO].  Display will show “Zeroing ******.”  Wait for process to complete.

6 Connect the power sensor to the POWER REF output.

7 To turn on the PWR REF, perform the following:

– Press [SHIFT] then [�].

– Verify that the triangular indicator (below) appears in the display above “PWR REF”.

8 Perform the following to set the REF CF %:

– Press ([SHIFT] then [ZERO]) for CAL.

– Enter the sensor’s REF CF % from the sensor’s decal using the arrow keys and press [ENTER].
(The power meter will display ”CAL *****” for a few seconds.)

NOTE
If the REF CAL FACTOR (REF CF) is not shown on the power sensor, assume it to be 100%.

9 Perform the following to set the CAL FAC %:

– Press [SHIFT] then [FREQ] for CAL FAC.

– ������������	
�����
������
���
��
��	����
����
���	
�������	����
����
���	�������
����������Enter
the sensor’s calibration % (CF%) using the arrow keys and press [ENTER].

When complete, the power meter will typically display 0.05 dBm. (Any reading between 0.00 and
0.10 is normal.)

10 To turn off the PWR REF, perform the following:

– Press [SHIFT] then [�].

– Disconnect the power sensor from the POWER REF output.
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Calibrating Gigatronics 8542
power meter

Precise transmit output power calibration measurements are made using
a bolometer–type broadband power meter with a sensitive power sensor.
Follow the steps in Table F-12 to enter information unique to the power
sensor.

Table F-12: Calibrate Gigatronics 8542 Power Meter

Step Action

! CAUTION
Do not connect/disconnect the power meter sensor cable with AC power applied to the meter.
Disconnection could result in destruction of the sensing element or miscalibration.

NOTE
Allow the power meter and sensor to warm up and stabilize for a minimum of 60 minutes before
performing the calibration procedure.

1 � Make sure the power meter POWER pushbutton is OFF.

� Connect the power sensor cable to the SENSOR input.

� Set the POWER pushbutton to ON.

2 Verify the Power GPIB mode and address:

� Press MENU. Use the 	 arrow key to select CONFIG MENU, and press ENTER.

� Use the 	 arrow key to select GPIB, and press ENTER.

� Use the 	
 arrow keys as required to set MODE to 8541C or 8542C (as appropriate).

� Press � and use the 	
 arrow keys as required to set ADDRESS to 13.

� Press ENTER.

3 � Connect the power sensor to the CALIBRATOR output connector.

� Press ZERO.

� Wait for the process to complete. Sensor factory calibration data is read to power meter during this
process.

� Disconnect the power sensor from the CALIBRATOR output.
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Figure F-8: Gigatronics 8542C Power Meter Detail
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Purpose

This procedure is a guide to expanding your system with multiple
carriers while the system remains in service. This procedure also allows
you to perform on site maintenance (replace defective boards and
recalibrate) while the remainder of the site stays in service.

Motorola recommends that you perform this procedure during a
maintenance window.

This procedure cannot be performed on BTSs with 4–to–1 combiners.
The procedure can only be performed on one side of the BTS at one
time. That is, LPAs 1, 2 ,3, 7, 8, 9 (feed antennas 1, 2, 3) can be
calibrated while LPAs 6, 7, 8, 10, 11, 12 (feed antennas 4, 5, 6) remain
in service and vice versa.

Equipment Warm up

Calibration of the communications test set (or equivalent
test equipment) must be performed at the site before
calibrating the overall test set. Calibrate the test equipment
after it has been allowed to warm-up and stabilize for a
minimum of 60 minutes.

IMPORTANT

*

If any piece of test equipment (i.e., test cable, RF adapter)
has been replaced, re-calibration must be performed.
Failure to do so could introduce measurement errors,
causing incorrect measurements and degradation to system
performance.

CAUTION
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Power Delta Calibration
Introduction

The In–service calibration procedure has several differences from a
normal calibration procedure. One of these is the use of a spectrum
analyzer instead of a power meter to measure power. Power meters are
broadband measurement devices and cannot be used to measure power
during In–service Calibration since other carriers are operating. A
spectrum analyzer can be used because it measures power at a given
frequency. However, measuring power using a spectrum analyzer is less
accurate than using a power meter. Therefore, you must compensate for
the difference (delta) between the power meter and the spectrum
analyzer.

HP8921A Power Delta
Calibration

Use the HP8921A Spectrum Analyzer to measure power during
In–Service Calibration for 800 MHz systems. After the offset value has
been calculated, add it to the TX cable loss value.

Follow the procedure in Table G-1 to perform the HP8921A Power Delta
Calibration procedure.

This procedure requires two HP8921As.

NOTE

Table G-1: HP8921A Power Delta Calibration Procedure

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes.

1 Connect a short RF cable between the HP8921A Duplex Out port and the HP437B power sensor (see
Figure G-1).

2 Set the HP8921A signal source as follows:

– Measure mode to CDMA Generator
– Frequency to the CDMA Calibration target frequency

– CW RF Path to IQ

– Output Port to Dupl

– Data Source to Random

– Amplitude to 0 dBm

3 Measure and record the power value reading on the HP437B Power Meter.

4 Record the Power Meter reading as result A ________________________.

. . . continued on next page
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Table G-1: HP8921A Power Delta Calibration Procedure

Step Action

5 Turn off the source HP8921A signal output, and disconnect the HP437B.

NOTE
Leave the settings on the source HP8921A for convenience in the following steps.

6 Connect the short RF cable between the source HP8921A Duplex Out port and the measuring
HP8921A RF–IN port (see Figure G-2).

7 Ensure that the source HP8921A settings are the same as in Step 2.

8 Set the measuring HP8921A as follows:

– Measure mode to CDMA Anl
– Frequency to the CDMA calibration target frequency

– Input Attenuation to 0 dB

– Input port to RF–IN

– Gain to Auto

– Analyzer Direction to Fwd

9 Turn on the source HP8921A signal output.

10 Measure and record the channel power reading on the measuring HP8921A as result
B ________________________.

11 Turn off the source HP8921A signal output and disconnect the equipment.

12 Compute the delta between HP437B and HP8921A using the following formula:

Delta = A – B
Example: Delta = –0.70 dBm – (–1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm – 0.55 dBm = –0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In–Service Calibration (see Step 4 in
Table G-4).
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Figure G-1: Delta Calibration Setup – HP8921A to HP437B
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Figure G-2: Delta Calibration Setup – HP8921A to
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Advantest R3465 Power Delta
Calibration

Follow the procedure in Table G-2 to perform the Advantest 3465 Power
Delta Calibration procedure.

Table G-2: Advantest Power Delta Calibration Procedure

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes.

On the Advantest R3465:

1 Press the SHIFT and the PRESET keys located below the CRT display.

2 Press the ADVANCE key in the Measurement area of the control panel.

3 Press the CDMA Sig CRT menu key.

4 Press the FREQ key in the Entry area of the control panel.

. . . continued on next page
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Table G-2: Advantest Power Delta Calibration Procedure

Step Action

5 Set the frequency to the desired value using the keypad entry keys.

6 Press the LEVEL key in the Entry area of the control panel.

7 Set the LEVEL to 0 dBm using the keypad entry keys.

8 Verify the Mod CRT menu key is highlighting OFF, if not press the Mod key to toggle it OFF.

9 Verify the Output CRT menu key is highlighting OFF, if not press the Output key to toggle it OFF.

On the HP 437 Power Meter:

10 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

* IMPORTANT
For best accuracy, always re–zero the power meter before connecting the power sensor to the
component being calibrated.

11 Connect the RF cable from the R3561L CDMA Test Source Unit RF OUT port to the power sensor,
refer to Figure G-3.

12 Press the Output CRT menu key to toggle the Output to ON.

13 Record the Power Meter reading as result A ________________________.

14 Press the Output CRT menu key to toggle the Output to OFF.

15 Connect the RF cable from the R3561L CDMA Test Source Unit RF OUT port to the Spectrum
Analyzer INPUT Port, refer to Figure G-4.

16 Press the Output CRT menu key to change the Output to ON.

17 Press the CW key in the Measurement area of the control panel.

18 Press the LEVEL key in the Entry area of the control panel.

19 Set the REF LEVEL to 10 dBm using the keypad entry keys.

20 Press the dB/div CRT menu key.

21 Press the 10 dB/div CRT menu key.

22 Press the FREQ key in Entry area of the control panel.

23 Set the frequency to the desired value using the keypad entry keys.

24 Press the more 1/2 CRT menu key.

25 Press the Preselector CRT menu key to highlight 3.0G.

26 Press the FORMAT key in the Display Control area of the control panel.

27 Press the TRACE CRT menu key.

28 Press the AVG A CRT menu key.

29 Set AVG to 20 using keypad entry keys.

. . . continued on next page
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Table G-2: Advantest Power Delta Calibration Procedure

Step Action

30 Press the return CRT menu key.

31 Press the SPAN key in the Entry area of the control panel.

32 Press the Zero Span CRT menu key.

33 Press the BW key in the Entry area of the control panel.

34 Press the RBW CRT menu key to highlight MNL. using keypad entry keys enter 30 kHz.

35 Set RBW to 30 kHz using keypad entry keys.

36 Press the VBW CRT menu key to highlight MNL.

37 Set VBW to 1 MHz using keypad entry keys.

38 Press the Marker ON key in the Display Control area of the control panel.

39 Record the Marker Level reading as result B ________________________.

40 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta = A – B

Example: Delta = –0.70 dBm – (–1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm – 0.55 dBm = –0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In–Service Calibration (see Step 4 in
Table G-4).

 

Figure G-3: Delta Calibration Setup – R3561L to HP437B
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Figure G-4: Delta Calibration Setup – R3561L to R3465
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HP8935 Power Delta
Calibration

Follow the procedure in Table G-3 to perform the HP8935 Power Delta
Calibration procedure.

Table G-3: HP8935 Power Delta Calibration Procedure

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes.

1 Connect a short RF cable between the HP8935 Duplex Out port and the HP437B power sensor (see
Figure G-5).

2 Set the HP8935 signal source as follows:

– Measure mode to CDMA Gen
– Frequency to the CDMA Calibration target frequency

– CW RF Path to IQ

– Output Port to Dupl

– Data Source to Random

– Amplitude to 0 dBm

3 Measure and record the power value reading on the HP437B Power Meter.

4 Record the Power Meter reading as result A ________________________.

5 Turn off the source HP8935 signal output, and disconnect the HP437B.

NOTE
Leave the settings on the source HP8935 for convenience in the following steps.

6 Connect the short RF cable between the source HP8935 Duplex Out port and the RF–IN/OUT port
(see Figure G-6).

7 Ensure that the source HP8935 settings are the same as in Step 2.

. . . continued on next page

G



Power Delta Calibration – continued

DRAFT
SC�4812ET BTS Optimization/ATP — CDMA LMF Apr 2001G-8

Table G-3: HP8935 Power Delta Calibration Procedure

Step Action

8 Set the measuring HP8935 as follows:

– Measure mode to CDMA Anl
– Frequency to the CDMA calibration target frequency

– Input Attenuation to 0 dB

– Input port to RF–IN

– Gain to Auto

– Anl Dir to Fwd

9 Turn on the source HP8935 signal output.

10 Set the Chn Pwr Cal to Calibrate and select to calibrate.

11 Measure and record the channel power reading on the measuring HP8935 as result
B ________________________.

12 Turn off the source HP8935 signal output and disconnect the equipment.

13 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta = A – B

Example: Delta = –0.70 dBm – (–1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm – 0.55 dBm = –0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In–Service Calibration (see Step 4 in
Table G-4).

 

Figure G-5: Delta Calibration Setup – HP8935 to HP437B
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Figure G-6: Delta Calibration Setup – HP8935 to HP8935
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In–Service Calibration

This feature does NOT have fault tolerance at this time.
The system has no safe–guards to stop you from doing
something that will take the BTS out of service. If
possible, perform this procedure during a maintenance
window.

Follow the procedures in this section precisely, otherwise
the entire BTS will most likely go OUT OF SERVICE. 

At the CBSC, only perform operations on expansion
hardware when it is in the OOS_MANUAL state.

The operator must be trained in the LMF operation prior to
performing this procedure.

IMPORTANT

*

Prerequisites
� Expansion hardware has been added in the CBSC database, and the

CDF file has been generated.

� The expansion devices have been inserted into the C–CCP cage and
are in the OOS_MANUAL state at the CBSC.

� The site specific cdf (with the expansion hardware) and cal files have
been loaded onto the LMF.

� The LMF has the same code and dds files as the CBSC to download.

Do not download code or data to any cards other than those
you are working on. Downloading code or data to other
cards will take the site OUT OF SERVICE.

The code file version numbers must match the version
numbers on the other cards in the frame. If the numbers do
not match, the site may go OUT OF SERVICE.

The BTS–#.cdf, CBSC–#.cdf, and CAL files for this BTS
must have come from the CBSC.

IMPORTANT

*

� Test equipment has been configured per Figure G-7 or Figure G-8.

� An RFDS (or at a minimum a directional coupler), whose loss is
already known, must be in line to perform the in–service calibration.

� Test equipment has been calibrated after 1 hour warm up.

� A short RF cable and two BNC–N adapters are available to perform
Cable Calibration.

 . . . continued on next page
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� The Power Delta Calibration has been performed (see Table G-1,
Table G-2, or Table G-3).
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Follow the procedure in Table G-4 to perform the In–Service
Calibration.

Table G-4: In–Service Calibration

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes.

1 Set up the LMF for In–Service Calibration:

– Start the LMF by double–clicking the LMF icon on the Windows desktop.

– Click Options>LMF Options from the menu bar at the login screen.

– Check only the applicable spectrum analyzer check box on the Test Equipment tab.
Ensure that the GPIB address is 18.

– Uncheck any other other equipment that is selected.

– Click the Apply button.

– Select the BTS Options tab in the LMF Option window.

– Check the In–Service Calibration check box.

– Click the Apply button.

– Click the Dismiss button to close the LMF Option window.

2 Login to the target BTS:

– Select the target BTS icon.

– Click the Login button at the login screen.

3 Measure the Cable Loss using the Cable Calibration function:

– Click Util>Cable Calibration from the menu bar at the main window.

– Set the desired channel(s) and select TX and RX CABLE CAL at the cable calibration pop up
window.

– Click the OK button to perform cable calibration.

– Follow the on–screen instructions to complete the cable loss measurement.

NOTE
– The measured value is input automatically to the cable loss file.

– To view the cable loss file, click Util>Examine>Cable Loss.

. . . continued on next page
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Table G-4: In–Service Calibration

Step Action

4 Add the spectrum analyzer power delta to the Cable Loss.

– To view the cable loss file, click Util>Examine>Cable Loss.

– Add the value computed in Table G-1, Table G-2, or Table G-3 to the TX Cable Loss.

NOTE
Be sure to include the sign of the value. The following examples are included to show the mathematics
and do not represent actual readings:

– Example: 5.65 dBm + 0.55 dBm = 6.20 dBm

– Example: 5.65 dBm + (–0.29 dBm) = 5.36 dBm

– Example: –5.65 dBm + 0.55 dBm = –5.10 dBm

– Example: –5.65 dBm + (–0.29 dBm) = –5.94 dBm

5 Input the Coupler Loss for the TX tests:

– Click Util>Edit>TX Coupler Loss from the menu bar at the main window.

– Input the appropriate coupler loss for the target carrier(s) by referring to the information taken at
the time of BTS installation.

– Click the Save button.

– Click the Dismiss button to close the window.

– To view the coupler loss file, click Util>Examine>TX Coupler Loss.

6 Input the Coupler Loss for the RX tests:

– Click Util>Edit>Cable Loss from the menu bar at the main window.

– Add the appropriate coupler loss to the cable loss for the target carrier(s) by referring to the
information taken at the time of BTS installation and input this value in the Cable Loss field.

– Click the Save button.

– Click the Dismiss button to close the window.

– To view the cable loss file, click Util>Examine>Cable Loss.

7 Have the CBSC operator put the redundant BBX2 OOS_MANUAL.

! CAUTION
Be sure to download OOS devices only. Loading in–service devices takes them OUT OF SERVICE
and can result in dropped calls.

The code file version numbers must match the version numbers on the other cards in the frame. If the
numbers do not match, the site may go OUT OF SERVICE.

NOTE
Be sure to include the redundant BBX2 in steps 8, 9, and 10.

. . . continued on next page
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Table G-4: In–Service Calibration

Step Action

8 Download code and data to the target devices:

– Click Util>Tools>Update NextLoad to set the code version that will be downloaded.

– Check the appropriate code version in the pop up window and click the Save button to close.

– Select the target BBX2(s) on the C–CCP cage picture.

– Click Device>Download Code to start downloading code.

– Select the target BBX2(s) on the C–CCP cage picture.

– Click Device>Download Data to start downloading data.

! CAUTION
Perform the All Cal/Audit procedure on OOS devices only.

9 Run the All Cal/Audit procedure:

– Select the target BBX2(s) on the C–CCP cage picture.

– Click Tests>All Cal/Audit from the menu bar at the main window.

– Select the target carrier and confirm the channel number in the pop up window.

– Leave the Verify BLO check box checked and click the OK button to start calibration.

– Follow the on–screen instructions, except, do not connect to the BTS antenna port, connect to the
directional coupler (fwd) port associated with the on screen prompt antenna port.

10 Save the result and download the BLO data to the target BBX2(s):

– Click the Save Result button on the result screen.
The window closes automatically.

11 Logout from the BTS and close the LMF session:

– Click Select>Logout to close the BTS connection.

– Close the LMF window.

12 Restore the new “bts–*.cal” file to the CBSC.

13 Enable the target device(s) from the CBSC.
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ATP – Waveform Quality (rho), 4-7

ATP Report, 4-12

ATP Test Procedure, 4-4

B
Basic Troubleshooting Overview, 6-1

Battery Charge Test (Connected Batteries), 2-10

Battery Discharge Test, 2-10

Bay Level offset calibration failure, 6-6

BBX, gain set point vs SIF output considerations, C-1

BBX2, 1-18

BBX2 Connector, 6-14

BBX2 LED Status Combinations, 6-26

BTS
Ethernet LAN interconnect diagram, 3-19
LMF connection, 3-9, 3-17
system software download, 3-3
when to optimize, B-1

BTS Cabinet, 1-26

BTS Site Setup for Acceptance Test Procedures, 3-69

Create CAL File, 3-70

C
C–CCP Backplane Troubleshooting, Procedure, 6-14

C–CCP shelf, 1-18

Cables Connection for 10 MHz Signal and GPIB ,
F-2, F-4

Calibrate BLO, 3-59

Calibrating Cables, 3-53

Calibrating Test Cable Setup, PCS Interface
HP83236B, F-10

Calibrating Test Equipment, 3-53
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Calibration
data file calibration, BLO, 3-61
In–Service, G-5
power meter, Gigatronics 8542B, F-19

Calibration Audit failure, 6-7

calibration data file, description of, BLO, 3-61

Cannot communicate to Communications Analyzer,
6-3

Cannot communicate to Power Meter, 6-2

Cannot Download DATA to any device card, 6-4

Cannot ENABLE device, 6-5

Cannot Log into cell–site, 6-2

Cannot perform carrier measurement, 6-9

Cannot perform Code Domain Noise Power
measurement, 6-9

Cannot perform Rho or pilot time offset
measurement, 6-8

Cannot perform Txmask measurement, 6-8

CCD, 1-18

CCP, shelf 1 – all inclusive TX ATP test outline,
primary, 4-12

CDF
site configuration, 3-2
site equipage verification, 3-3
site type and equipage data information, 2-1

CDMA
allocation diagram for the North American, cellular

telephone frequency spectrum, D-4
optimization/ATP test matrix, B-1

cdpower test, 4-9

Cell Site
equipage verification, 2-1
types configuration, 3-2

Cell Site Data File. See CDF

Cell Site Field Engineer CFE, 1-1

Channel Service Unit, 3-4

CIO, 1-18

CIO Connectors, 6-14

CLI, 1-2

Code Domain Power and Noise Floor Levels, 4-10

Code Domain Power/Noise, 4-9

Communication test set, rear panel, F-2, F-4

Communications System Analyzer, 1-8

Communications system analyzer , 1-8

Connecting test equipment to the BTS, 3-42

Connector Functionality
Backplane, Troubleshooting, 6-13
Troubleshooting, Backplane, 6-13

Copy CAL Files From Diskette to the CBSC, 5-2

Copy CDF Files from CBSC, 3-12

Copy Files from LMF to Diskette, 5-1

Copying CAL files from CDMA LMF to the CBSC,
5-1

Copying CAL files to the CBSC, 5-2

CSM, 1-18
and LFR primary functions, 3-32

CSM frequency verification, 3-34

CSM LED Status Combinations, 6-22

Customer I/O, 1-19

CyberTest Communication Analyzer, 1-8

D
DC Power Pre–test (BTS Frame), 2-7

DC Power Problems, C–CCP Backplane
Troubleshooting, 6-17

DC/DC Converter LED Status Combinations, 6-21

Detailed, optimization/ATP test matrix, B-2

Digital Control Problems, 6-15
C–CCP Backplane Troubleshooting, 6-15

Digital Multimeter, 1-9

Directional Coupler, 1-9

Download
BTS system software, 3-3
MGLI, 3-27
Non–MGLI2 Devices, 3-28

Download BLO Procedure, 3-65

Download/Enable MCCs, 3-31

Duplexer/Directional Coupler DDC, 1-17, 1-18, 1-19,
1-20, 1-28

E
E1, isolate BTS from the E1 spans, 3-4
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Enable CSMs & BDCs, 3-30

Equipment Overview, 1-13

Equipment warm-up, 3-44

Ethernet LAN
interconnect diagram, 3-19
transceiver, 1-7

Every test fails, Troubleshooting, RFDS, 6-19

F
fer test, 4-11

Files, calibration data file, BLO, 3-61

Folder Structure Overview, 3-13, 3-15

Frame, equipage preliminary operations, 2-1

FREQ Monitor Connector, CSM, 6-23

Frequency counter, optional test equipment, 1-10

G
Gain set point, C-1

General optimization checklist, test data sheets, A-4

Gigatronics 8542B power meter, illustration, F-20

GLI Connector, 6-13

GLI Ethernet A and B Connections, 6-14

GLI LED Status Combinations, 6-24

GLI Pushbuttons and Connectors, 6-25

GLI2, 1-18

GLI2 Front Panel Operating Indicators, 6-25

GPIB, F-1, F-5, F-7

GPIB Cables, 1-8

GPS, receiver operation, test data sheets, A-5

GPS Initialization/Verification
estimated position accuracy, 3-35
surveyed position accuracy, 3-35

GPS satellite system, 3-30

Graphical User Interface Overview , 3-21

H
Hardware Requirements, 1-5

High Stability 10 MHz Rubidium Standard, 1-10

High–impedance Conductive Wrist Strap, 1-9

HP 83236A, F-5

HP8921A, F-5

HP8935 Analyzer, 1-8

HSO, 1-18

HSO Initialization/Verification, 3-32

I
I and Q values, E-1

In–Service Calibration, G-5

Initial HP8921A setup, F-10

Initial Installation of Boards/Modules, preliminary
operations, 2-1

Initial power tests, test data sheets, A-3

Installation and Update Procedures, 3-10

Inter–frame cabling, when to optimize, B-2

Intercabinet I/O, 1-20

Internal FRU, 1-27

Internal FRUs, 1-17

IS–97 specification, E-1

ISB Inter Shelf Bus connectors, 6-13

L
LAN, BTS frame interconnect, illustration, 3-19

LED Status Combinations for all Modules except
GLI2 CSM BBX2 MCC24 MCC8E, 6-21

LFR, 1-18
receiver operation, test data sheets, A-6

LMF, 3-10, F-1, F-7
to BTS connection, 3-4, 3-9, 3-17
view CDF information, 3-3

LMF Removal, 5-3

Load Center Wiring, 2-5

Local Area Network (LAN) Tester, 1-10

Logging In to a BTS, 3-22

Logging Out, 3-24

LORAN–C Initialization/Verification, 3-40

LPA errors, 6-5

LPA Module LED, 6-27



Index  – continued

DRAFT
SC�4812ET BTS Optimization/ATP — CDMA LMF Apr 2001Index-4

LPA Shelf LED Status Combinations, 6-27

M
major components, 1-16

Manual, layout, 1-1

MASTER LED, GLI, 6-24

MCC LED Status Combinations, 6-26

MCC/CE, 4-9

MGLI2, Download, 3-27

MMI common connections, 3-26

MMI Connection, 3-26

MMI Connector
CSM, 6-23
GLI, 6-25

MMI Connectors, MCC, 6-26

MMI equipment setup, 3-26

Model SLN2006A MMI Interface Kit, 1-8

Module status indicators, 6-21

Motorola, SC9600 Base Transceiver Subsystem, 1-1

MPC, 1-18

Multi–FER test Failure, 6-10

N
New Installations, 1-3

No AMR control, 6-16

No BBX2 control in the shelf, 6-16

No DC input voltage to  Power Supply Module, 6-17

No DC voltage +5 +65 or +15 Volts to a specific
GLI2 BBX2 or Switch board, 6-18

No GLI2 Control through span line connection, 6-15

No GLI2 Control via LMF, 6-15

No or missing MCC24 channel elements, 6-16

No or missing span line traffic, 6-16

Non–MGLI2, Download, 3-28

North American, cellular telephone system frequency
spectrum, CDMA allocation, D-4

Null modem cable detail, 1-7

O
Online Help, 1-2

Optimization, 1-1

Optimization/ATP Test Matrix, 1-3

Optional Test Equipment, 1-10

Optional test equipment, frequency counter, 1-10

Oscilloscope, 1-10

P
PCMCIA, Ethernet adapter, LMF to BTS connection,

3-17

Pilot Time Offset. See PN

Ping, 3-19

PN
offset programming information, E-1
offset usage, E-1

PN offset per sector, E-1

PN Offset Usage , E-1

Power Input, 6-13

Power Meter, 1-8
illustration, F-17
Pre–calibration, F-17

Power meter
calibration, Gigatronics 8542B, F-19
illustration, Gigatronics 8542B, F-20

Power Supply Module Interface, 6-13

Pre–calibration, Power Meter, F-17

Pre–power tests, test data sheets, A-3

Preliminary operations
cell Site types, 2-1
test data sheets, A-2

Prepare to Leave the Site
External test equipment removal, 5-1
LMF Removal, 5-3
Reestablish OMC–R control, 5-3
Verify T1/E1, 5-3

Prepare to leave the site
re–connect BTS IFM connector, 5-3
re–connect BTS T1 spans, 5-3

Procedures to Copy CAL Files From Diskette to the
CBSC, 6-2, 6-3, 6-4

Product Description, 1-2
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Program, TSU NAM, 3-81

Pseudorandom Noise. See PN

ptoff test, 4-8

Punch Block, 3-6

PWR/ALM and ACTIVE LEDs, MCC, 6-26

PWR/ALM LED
BBX2, 6-26
CSM, 6-22
DC/DC Converter, 6-21
generic, 6-21
MCC, 6-26

R
Re–connect BTS IFM connector, 5-3

Re–connect BTS T1 Spans, 5-3

Receive Distribution Card RXDC, 1-28

Reestablish OMC–R control, 5-3

Required documents, 1-4, 1-27

Required Test Equipment
Ethernet LAN transceiver, 1-7
substitute equipment, 1-5

RESET Pushbutton, GLI, 6-25

Resetting BTS modules, 5-1

RF Adapters, 1-9

RF Attenuators, 1-9

RF Path Bay Level Offset Calibration, 3-59

RF Test Cable, 1-10

RFDS – Fault Isolation, 6-19

RFDS Calibration, 3-79

RFDS Location, SC 4812ET, 1-22

rho test, 4-7

RS–232 to GPIB Interface, 1-7

RX, antenna VSWR, test data sheets, A-16

RX and TX paths fail, Troubleshooting, RFDS, 6-19

RX Frame Error Rate (FER) ATP, 4-11

S
SC 4812 BTS Optimization/ATP Test Matrix, B-4

SCLPA, convergence test data sheets, A-7

Selecting Test Equipment, 3-51

Set Antenna Map Data, 3-77

Set RFDS Configuration Data, 3-78

Setting Cable Loss Values, 3-57

Setting Control Port, 3-5

Setting TX Coupler Loss Value, 3-58

SIF, output considerations vs BBX gain set point, C-1

Site, equipage verification, 3-3

Site checklist, verification data sheets, A-2

site equippage, CDF file, 3-2

Span Line (T1/E1) Verification Equipment, 1-10

Span Line connector , 6-13

Span Problems no control link, Troubleshooting, 6-28

SPANS LED, 6-24

Spectrum Analyzer, 1-10

STATUS LED, GLI, 6-24

Supported Test Sets, 3-42

SYNC Monitor Connector, CSM, 6-23

System Connectivity Test, F-5

T
T1, isolate BTS from the T1 spans, 3-4

Telco Interface Board TIB, 1-28

Test data sheets
Alarm verification, A-16
general optimization checklist, A-4
GPS receiver operation, A-5
initial power tests, A-3
LFR receiver operation, A-6
pre–power tests, A-3
preliminary operations, A-2
RX antenna VSWR, A-16
SCLPA convergence, A-7
site checklist, A-2
TX antenna VSWR, A-15
TX BLO, A-8, A-13
verification of test equipment used, A-1

Test equipment, verification data sheets, A-1

Test equipment connections , F-1

Test Equipment Policy, 1-4
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Test Equipment Setup, 3-42

Test Equipment Setup Calibration for TX Bay Level
Offset, 3-56, F-14

Test Equipment Setup Chart, 3-43

Test equipment setup RF path  calibration, 3-63

Test Set Calibration, 3-50

Timing Reference Cables, 1-8

Transmit TX path audit, 3-67

Transmit TX path calibration, 3-64

Transmit/Receive Module TRX, 1-27

Troubleshooting
DC Power Problems, 6-17
Span Problems no control link, 6-28
TX and RX Signal Routing, 6-18

Troubleshooting CSM Checklist, 6-11

TX
antenna VSWR, test data sheets, A-15, A-16
BLO test data sheets, A-8, A-13

TX & RX Path Calibration, 3-59

TX and RX Frequency vs Channel , D-2

TX and RX Signal Routing, C–CCP Backplane
Troubleshooting, 6-18

TX Audit Test, 3-68

TX Bay Level Offset and TX ATP test equipment
setup calibration, 3-55

TX Code Domain Power ATP, 4-9

tx fine adjust, E-1

TX Mask Verification, spectrum analyzer display,
illustration, 4-6

TX Output Acceptance Tests – Introduction
Code domain power, 4-4
Pilot time offset, 4-4
Spectral purity TX mask, 4-3
Waveform Quality (rho), 4-3

TX Path Calibration, 3-60

TX Pilot Time Offset ATP, 4-8

TX Spectral Purity Transmit Mask ATP, 4-5

TX Waveform Quality (rho) ATP, 4-7

TX/RX OUT Connections, 4-2

txmask test, 4-5

U
Updating CDMA LMF Files, 5-1

UTP, LMF to BTS connection, 3-17

V
Verify, test equipment used, test data sheets, A-1

Virtual BTS, 1-13

W
Walsh channels, 4-9

When to optimize
Ancillary – table, B-1
BTS, B-1
inter–frame cabling, B-2

X
XCVR Backplane Troubleshooting, 6-13

Xircom Model PE3–10B2, LMF to BTS connection,
3-17


